GTX pro

GARMENT PRINTER
Instruction Manual

Please be sure to read this manual before using this product.
Keep this manual in a safe place for future use.




. When you dispose of the machine

Required Tools
Phillips screwdriver: M3 to M5

Disassembling

(1) Remove the Cover PANEL SIDE.

Note based on California law (USA) on the use and handling of Perchlorate

This product contains a CR Coin Lithium Battery which contains Perchlorate Material — special handling may

apply.
See http://www.dtsc.ca/gov/hazardouswaste.perchlorate.



http://www.dtsc.ca/gov/hazardouswaste.perchlorate

B sareETY INSTRUCTIONS

Thank you very much for buying a BROTHER printer.
Before using your new printer, please read the "SAFETY INSTRUCTIONS" and handling instructions carefully.

1. Safety indications and their meanings

This instruction manual and the indications and symbols that are used on the printer itself are provided in order to ensure
safe operation of this printer and to prevent accidents and injury to yourself or other people.
The meanings of these indications and symbols are given below.

Indications

g D AN G ER The instructions which follow this term indicate situations where failure to follow the
instructions will result in death or serious injury.

g W ARNIN G The instructions which follow this term indicate situations where failure to follow the
instructions could result in death or serious injury.

g C AUTI ON The instructions which follow this term indicate situations where failure to follow the
instructions may result in minor or moderate injury.

The instructions which follow this term indicate situations where failure to follow the
(I1)IMPORTANT =" .
. instructions may result in damage to property.
(( ' ))NOTE The instructions which follow this term indicate precautions and restrictions for use.
Symbols

This symbol (/\) indicates something that you should be careful of.
é- = The picture inside the triangle indicates the nature of the caution that must be taken. (For
example, the symbol at left means "beware of injury".)

®- R This symbol (®) indicates something that you must not do.

This symbol (@) indicates something that you must do.
9 - e e The picture inside the circle indicates the nature of the thing that must be done. (For example,
the symbol at left means "you must make a ground connection".)

A\ DANGER

f Contact with high voltage sections may lead to a serious injury. Turn off the power, and remove the cover 5
minutes later.
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A WARNING

Basic precautions

To prevent accidents and problems, do not modify the machine yourself. Brother will not be held responsible
for any accidents or problems resulting from modifications made to the machine.

Do not handle the power cord with wet hands. Otherwise, it may cause electric shocks.

Installation

Do not set up the printer in a dusty environment. If dust collects inside the printer, it may cause fire or electric
shocks or problems with correct operation.

Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a
serious electric shock, and problems with correct operation may also occur.

Do not bend the cords excessively or fasten them too hard with staples or anything similar to secure cords.
Otherwise it may cause fire or electric shocks.

Printing
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If a foreign object gets inside the printer, immediately turn off the power, disconnect the power cord, and
contact the place of purchase or a qualified technician. If you continue to use the printer while there is a
foreign object inside, it may result in fire or electric shocks or problems with correct operation.

Do not allow the printer to come into contact with liquids. Otherwise it may cause fire or electric shocks or
problems with correct operation.

If any liquid gets inside the printer, immediately turn off the power, disconnect the power cord, and contact
the place of purchase or a qualified technician.

Do not use the printer when smoke or a bad odor is coming from the printer. Otherwise it may cause fire or
electric shocks or problems with correct operation. Immediately turn off the power, disconnect the power
cord, and contact the place of purchase or a qualified technician.

Keep your finger or any body part away from the rotating fan. Otherwise it will be caught up, which results in
injuries.
Turn off the power when you approach the fan.




A\CAUTION

Environmental requirements

Use the printer in a place which is adequately ventilated. A slight odor is generated when the printed articles
are being fixed by heat.

Installation
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Setting up and moving of the printer should only be carried out by a qualified technician.

The printer machine weighs 128 kg (282 Ib). Transporting and setting up of the printer should be held in the
proper way. Otherwise it may fall down and cause injury.

When the printer falls down, disconnect the power cord and contact the place of purchase or a qualified
technician. If you continue to use it, it may result in fire or electric shocks or poor printing quality.

Do not place the printer on a shaky table or high shelf or other unstable location. Otherwise it may tip over or
fall down and cause injury. Furthermore, the table that supports the machine should be at least 35.4 in. (90
cm) in width and 23.6 in. (60 cm) in depth, and should be able to bear a weight of 150 kg (330 Ib) or more.

Do not set up the printer in a place where it will be affected by vibration. Otherwise the printing quality may be
degraded or the printer may fall down, which causes injury or results in failure of the printer.

Do not connect the power cord until installation is complete. The printer may operate if the power is turned on
by mistake, which could result in injury.

Do not climb onto the printer or place heavy objects on top of it. Otherwise it may become unbalanced and tip
over or fall down and cause injury.

Be careful not to touch the claws of the mounting portion on the upper side of the rear cover. Otherwise you
may be injured.

Printing
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This printer should only be used by operators who are appropriately trained in its safe operation.

Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand
may get caught between the platen and an object, which may result in injury.

Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and
the covers, it may be injured.

Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may
touch against moving parts and this may result in injury.

When the pretreatment is applied to printed objects (like a T-shirt) with a spray or pretreatment applicator,
sprayed mist is generated. So wear a pair of plastic gloves, a mask and protective glasses (or goggles)
designed to shield against liquid splash, and fully take care of the air ventilation when you are working with it.

When a problem occurs with the operation of the printer, contact the place of purchase or a qualified
technician.
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A\CAUTION

Maintenance

O oP

Be careful not to get your fingers caught when closing the front cover, otherwise it may result in injury to your
fingers.

When you mount or replace the head, be careful not to get your hands or fingers caught. Otherwise you may
be injured.

Do not disassemble the ink pouch. If the ink gets into your eyes or onto your skin, it may cause inflammation.
In case of contact with eyes, do not rub but immediately rinse the eyes with water.

Do not drink liquids such as the ink, maintenance solution, cleaning solution, pretreatment, or waste. They
may cause diarrhea or vomiting.

Avoid causing your eyes or skin to make contact with the ink, maintenance solution, cleaning solution,
pretreatment or waste. It may cause inflammation. In case of contact with eyes, do not rub but immediately
rinse the eyes with water.

Keep the liquids out of the reach of children.

Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your
eyes or onto your skin.

It can cause inflammation. Do not drink or eat the grease. It may cause diarrhea or vomiting.

Keep the liquids out of the reach of children.

When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother
will not be held responsible for any accidents or problems resulting from the use of non-genuine parts.

When replacing parts or installing optional accessories, be sure to follow the procedures described in the
Instruction Manual. Incorrect procedures could cause injuries or problems.

(I)IMPORTANT

Printing

Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.

Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be
hit and damaged.
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(IDNOTE

Use the printer in an area which is free from sources of strong electrical noise such as electrical line noise or
static electric noise. Sources of strong electrical noise may cause problems with correct operation.

Any fluctuations in the power supply voltage should be within £10% of the rated voltage for the printer.
Voltage fluctuations which are greater than this may cause problems with correct operation.

The power supply capacity should be greater than the requirements for the printer's power consumption.
Insufficient power supply capacity may cause problems with correct operation.

In the event of an electrical storm, turn off the power and disconnect the power cord from the wall outlet.
Lightning may cause problems with correct operation.




3. Warning labels

Grease
\ .
e
Cleaning solution 2
5L

Cleaning soluton 9
1.8L

8 L~
Waste ink tank
/ 11 v

L

Pretreatment Pretreatment
5kg (11 Ib) 20 kg (44 Ib)

Ink pouch

Maintenance solution pouch
X0466



This printer has the following warning labels displayed on it.
Follow the precautions given on each warning label for your work.
When the label is peeled off or illegible, contact the place of purchase.
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A\ CAUTION

as they can cause vomiting and diari
Take care not to let the liquids come
with your eyes or onto your skin,
otherwise inflammation can result.

Do not drink the liquids under any circumstances,

thea.
into contact

A\ ACHTUNG

da die Gefahr von Erbrechen und
Durchfall besteht. Vermeiden Sie de

sonst kénnen diese gereizt werden.

Bitte trinken Sie nicht die Flussigkeiten,

der Flussigkeiten mit Augen und Haut,

n Kontakt

A\ ATTENTION

Ne pas avaler les liquides d'aucune

Veuillez a ne pas laisser ces liquides étre en contact
avec les yeux ou la peau,
car ceci pourrait entrainer une inflammation.

maniére,

/\ ATENCION

toquen los ojos ni en la piel,
de otro modo inflamacién puede res

No tome los liquidos en cualquier caso,
como pueden causar vomitar y diarrea.
Tome el cuidado para no permitir que los liquidos

ultar.

/\ ATTENZION

E

Non bere per nessun motivo i liquidi
possono causare vomito e diarrea.

Evitare il contatto di questi liquidi con gli occhi e con
la pelle poiché potrebbero creare infiammazioni.

poiché

/A WARNUNG

b

Teile in Bewegung.
Halten Sie Finger und andere
Koérperteile auf Abstand.

ANEE

/\ AVERTISSEMENT

@SR, Piéces mobiles dangereuses.
FPHEEADFRNIE, Eloignez les doigts et autres
parties du corps.
ANEES /\ADVERTENCIA
HEFEAPILIERS o Partes peligrosas en movimiento.
FHSRAERIA Por favor, mantengase alejado.

/A WARNING

/A\AVVERTENZA

Hazardous moving parts.
Keep fingers and other body
parts away.

Attenzione parti in movimento.
Tenere le dita e altre parti del
corpo lontane.

Watch your fingers, or you

iz
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may be injured.

SAFETY INSTRUCTIONS

/\ ATENCION

No se suba encima e la impresora.

A CAUTION /\ ATTENZIONE
Do not climb onto the printer. Non salire sulla stampante.
A ACHTUNG i
Niemals auf den Drucker steigen.
A\ ATTENTION

Ne montez pas sur limprimante.

10
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/\ CAUTION

WMoving platen, T-shirt tray and covers can cause bodily injury. Keep hands off platen while printing.

/A ACHTUNG

Druckplatte, T-Shirt-Ablage und Abdeckungen konnen korperliche Verletzungen verursachen.

Halten Sie die Hander von der Auflage wahrend des Druckvorganges fern.

A\ ATTENTION

Déplacement du plateau, chargeur T-shirt et couvercle peut blesser le corps.
Garder les mains éloignées lors de limpression.

/\ ATENCION

Moviendo la placa, Ia bandeja de camiseta y las cubiertas pueden causar una herida personal.

Retire las manos de Ia placa durante la impresion.

/\ ATTENZIONE

Tavoletta mobile, il ripiano per la T-shirt ed il carter potrebbero causare infortuni.

Tenere le mani lontane dalla tavoletta durante la stampa.
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Un voltage non adapte provoque| Un voltaje inadecuado puede

A PELIGRO

provocar las heridas. Apagar el
interruptor principal y esperar 5
minutos antes de abrir esta cubierta.
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warning display
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A CAUTION

Do not drink the liquids under any circumstances, as they can cause
vomiting and diarrhea. Take care not to let the liquids come into contact
with your eyes or onto your skin, otherwise inflammation can result.
Keep the liquids out of the reach of children.

A ACHTUNG

Durchfall bestent.

von Kindern fern.

Bitte trinken Sie nicht die Flussigkeiten, da die Gefahr von Erbrechen und
Vermeiden Sie den Kontakt der Fissigkeiten mit Augen
und Haut, sonst konnen diese gereizt werden. Halten Sie die Flissigkeiten

A ATTENTION

Ne pas avaler les liquides d'aucune maniére, car ceci pourrait entrainer
vomissements et diarrhée. Veuillez a ne pas laisser ces liquides étre en
contact avec les yeux ou la peau, car ceci pourrait entrainer une
inflammation. Maintenez les liquides hors de portée des enfants

A\ ATENCION

No tome Ios liquidos en cualquier caso, como pueden causar vomitar y
diarrea. Tome el cuidado para no permitir que los liquidos togquen los ojos
ni en la piel, de otro modo inflamacion puede resultar. Mantenga los
liquidos fuera del alcance de nifios.

A ATTENZIONE

dei bambini.

Non bere per nessun motivo i liquidi poiché possono causare vomito e
diarrea. Evitare il contatto di questi iquidi con gli occhi e con Ia pelle poiché
potrebbero creare infiammazioni. Conservare i iquidi lontano dalla portata

s
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' Deposite in compliance with your local regulations.
M Gebrauchte es gema ortlichen Richtlinien entsorgen.
m Jetez conformément a la reglementation locale en vigueur.
m Deseche siguiendo la normativa local

Smaltire in conformita lle normative locali.
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/A CAUTION

Teke care not to let the liquids come into contact vith your eyes or onto your skin,

/\ ACHTUNG

Bite tinken Sie nicht die Flussigkeien, da die Gefahr von Erbrechen und Durchfall
besteht. Vermeiden Sie den Kontakt der Flissigkeiten mit Augen und Hau, sonst

A\ ATTENTION

Ne pas avalr s iquides daucune manire, Ga cec pourat etraner

c les yeus ou la pes car ceci pourait e e e
Nintemoy o quides hors de portce dosenfants

/\ ATENCION

No tome los luidos en cualquie caso, Como pueden causar vomitar y diarea. Tome el
cuidado para no permitc que los liqudos toquen los ojos i en la piel,de otro modo

conformementa areglementst
eseche siuiendo la normativa local

epostein complance with yourlocal egulations.

don locae en vigueur:
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bere
Bvitare il contatto di questi liquidi con gl occhi e con la pelle poiché potrebbero
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A\ CAUTION

EiCASDEEEOCE, | W AEmas R £, | Lubricaling grease may cause Inflammation 1o eye and skin.
TU-2 ;ﬁfn SEps. ?;g;éﬁ’;g Wear protective glasses and gloves.
HEE BNBE. TREES 2. | MARMATISRE.E. Swallowmg grease can cause diarthoea and vomiting.
kG‘.F:EASE BRBUTE, BORA. Do not swallow.

A CAUTION

Do not drink the liquids under any circumstances,
as they can cause vomiting and diarrhea

Take care not to let the liquids come into contact with your eyes
or onto your skin, otherwise inflammation can resuit

Keep the liquids out of the reach of children.

A ACHTUNG

Bitte trinken Sie nicht die Flissigkeiten, da die Gefahr von
Erbrechen und Durchfall bestent.

Vermeiden Sle den Koraki der Filssgkeiten mit Augen und Halr,
sonst kdnnen diese gereizt wi

Halten Sie e Filssigkeiton von Kindern fern.

A ATTENTION

Ne pas avaler les liquides d'aucune maniere,
car ceci pourrait entrainer vomissements et diarrhée.

Veuillez 4 ne pas laisser ces liquides tre en contact avec les yeux ou la peau,
car ceci pourrait entrainer une inflammation.

Maintenez les liquides hors de portée des enfants

A\ ATENCION

No tome los liquidos en cualquier caso, como pueden causar vomitar y diarrea,
Tome el cuidado para no permitir que los liquidos toquen los ojos ni en la piel |
de otro modo inflamacion puede resultar.

Mantenga los liquidos fuera del alcance de nifios.

A\ ATTENZIONE

Non bere per nessun maiivo | liquidi poiché possono causare vomito e diarrea)
Evitare il contatto di questi liquidi con gli occhi e con la pelle poiché
potrebbero creare infiammazioni.

Conservare i liquidi lontano dalla portata dei bambini.
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n Before Using Your Printer for the First Time

1-1. Be sure to read the following notes before using the printer

Keep in mind the following points before using the printer:

Precautions for proper use

o Keep the printer powered on the printer for 24 hours a day.
Even when the printer is placed in standby mode, it performs such maintenance as white ink circulation inside
the main unit automatically to prevent sedimentation of the white ink.

e Use the printer within the scope covered by its warranty for the best print result (temperature: 18 to
30°C (64.4 to 86°F) and humidity: 35 to 85%).
Otherwise, the print heads may be clogged with ink and ink may splash.

o Adjust the height of the platen according to the print medium before using it.
Adjust the height so that it is lowered by one step from the limit height detected by the obstacle sensor, and
check that the platen is not detected by the obstacle sensor.

o Do not excessively lower the platen.
Otherwise, ink mist will be scattered inside the printer, which may result in staining of the printing surface,
blurring of the printed image, and malfunction of the sensor and the main unit.
=7"6-4-2. Platen height adjustment >>P.137"

e Never power off the printer or open the cover while the printer is in operation.
Otherwise, the printer may break down or a print job may end up in failure.

e Until the ink is firmly fixed on the surface of a T-shirt, do not touch the T-shirt.
If a T-shirt is soiled with such ink that has not been firmly fixed on its surface, such ink stain cannot be removed
even by washing.

About ink cartridge

¢ Insert each of the cartridges into the hole of the same color as the printer seal.

o Shake the white ink well once a day immediately before use. (Shake each cartridge approximately 100
times.)
Otherwise the white ink may precipitate.

e Never pull out any cartridges while the printer is operating.
Otherwise, the print quality may deteriorate or the printer may break down.

e  Store consumable goods in a place where they are not exposed to direct sunlight.

e Use up the ink pouch and solutions before their shelf life.
Also, use up each ink pouch within six months after opening their sealed packages.
Use of an expired ink pouch may make you liable for the cost of repairs even during the guarantee period.

e Do not refill into or disassemble the ink pouch.
In order to use the printer for a long period and to take full advantage of its capabilities, we recommend to use
the ink pouches and solutions specified by Brother.
In cases where the printer malfunctions due to the use of a non-genuine ink pouch, you may be liable for the
cost of repairs even during the guarantee period.

16



Before Using Your Printer for the First Time >

Do not remove the ink cartridge.
If the ink cartridge insertion slot is left empty, the inner needle may clog because ink dries up, or the printer may
be damaged.

Take care to prevent the ink pouch from being bent, snagged by sharp objects, or dropped.
Otherwise, it could be damaged.

About pretreatment

Avoid application of the pretreatment when no white ink is used.
If a T-shirt to which the pretreatment is applied is coated with only color inks, its stains may be wiped off by
washing.

After a T-shirt is coated with the pretreatment, store pretreatment in a place where it is not exposed to
direct sunlight, and wash it with clean water at an early stage after ink is applied to it.

When a white or light-colored T-shirt is coated with the pretreatment, the coated surface color may change, and
cannot be restored to the original color even if the T-shirt is washed.

When performing printing for the first time, try pretreatment in an unnoticeable area.
Some T-shirts may be discolored by the pretreatment and cannot be restored to the original color even if they
are washed.

Wash away any imprint of the pretreatment with water.

When a color transfer occurs, wipe the color-transferred area clean of dirt with a soft and clean cloth or
a toothbrush that is moistened with a small amount of mild detergent for home use or alcohol.

If a printed material is rubbed with vinyl-chloride-based white or light-colored synthetic leather, color transfer
may occur. Also, when a color-printed surface is rubbed strongly against a printed surface with only white ink,
color transfer may occur in the same fashion.

About maintenance

In order to keep good printing quality, perform maintenance on a regular basis.
="7. Precautions to keep good printing quality/use printer over the long term >>P.168"

We recommend to use the genuine cleaning solution that is specified by us when cleaning the head
section, cap or wiper.

This allows you to take full advantage of the printer's intrinsic capabilities and use it for a long period.

Using commercially available alcohol or cleaning solution could cause damage to the print heads.

Never remove the print heads except when they are replaced with new ones.
Because they are precision components, the print head may fail.

What to do when not using printer

When the printer will not be used for a prolonged period of time, take appropriate procedures before
storing the printer depending on storage period or condition.
="7-5. When Not Using for a Long Period of Time >>P.225"
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About waste handling

o Dispose of the residual wastes and waste ink properly as water-based waste fluid in accordance with
applicable laws and ordinances.

Others

¢ Inthe event that the printer is relocated elsewhere for layout change, etc., place a level gauge on the
top surface of the cover and the top surface of the platen to make such an adjustment that the printer
will be placed horizontally level.

. @ : Standby symbol

e  You cannot connect this product directly to the communications lines, including the public wireless LANs, of
telecommunication carriers like mobile communications companies, fixed communications companies, or
internet providers. Ensure that the product is connected through a router, if it is to be used over the internet.

<NOTE> Only for the use in the United States

o This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

About trademarks

The names of operating systems described in the main context of this manual are abbreviated. Product names used in
this manual are, in general, trademarks or registered trademarks of their respective developer or manufacture. However,
in this manual, the ® marks or TM marks are not used.

Brother logo is registered trademark of Brother Industries, Ltd.

Apple, Macintosh, Mac OS, iOS, OS X, macOS, Safari, iPad, iPhone, iPod and iPod touch are the trademarks or
registered trademarks of Apple Inc. in the United States and other countries.

The official name of Windows® 8.1 is Microsoft® Windows® 8.1 operating system. (represented as Windows 8.1 in this
manual) Also, the official name of Windows® 10 is Microsoft® Windows® 10 operating system. (represented as Windows
10 in this manual)

Microsoft®, Windows® 8.1, and Windows® 10 are trademarks and registered trademarks of Microsoft Corporation in the
United States of America and other countries.

Corel, Corel's logo and CorelDRAW are trademarks and registered trademarks of Corel Corporation.

Adobe, Adobe's logo, Acrobat, Photoshop, and lllustrator are trademarks of Adobe Systems Incorporated (Adobe
Systems).

Other product and company names mentioned herein may be the trademarks or registered trademarks of their
respective owners.

Information in this document and the specifications of this product are subject to change without notice.

About the CE declarations

Downloadable from: http://www.brother.com
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About software

This printer uses its own software.

To use this printer, you are required to agree with the End-User License Agreement for Brother Software as mentioned
below.
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End-User License Agreement for Brother Software
IMPORTANT-PLEASE READ CAREFULLY
This End-User License Agreement ("EULA") is a legal agreement between you and Brother Industries, Ltd. ("Brother"),
which governs your use of the Brother software that will be installed if you press the "Yes" button on this Dialog Box
("SOFTWARE"). By pressing "Yes", you agree to be legally bound by the terms of this EULA. If you do not agree to the
terms of this EULA, you obtain no license to the SOFTWARE. In such case, you may not use the SOFTWARE.
Terms and Conditions.
1. Ownership.
All rights, titles and interest in and to the SOFTWARE and the files associated therewith are owned by Brother or its
suppliers. The foregoing rights to the SOFTWARE are licensed to you on a limited basis as prescribed in the following
Article 2. In any event, this provision should not be construed in any way, as an expression to assign or sell any
copyrights of, or any other intellectual property rights to, the SOFTWARE from Brother to you.
2. Grant of License.
2.1 Brother grants you a non-exclusive, non-transferable license to install and use the SOFTWARE on your one or
more computer hardware(s).
2.2 Brother further grants you a license to make a copy of the SOFTWARE at all times, solely for archival purposes,
which such copy shall attach and stipulate all copyright and intellectual property rights notices.
2.3  Except for expressly stipulated in Sections 2.1 and 2.2 above, Brother does not grant you any license relating to
the SOFTWARE. Except to the extent expressly permitted by applicable law, you may not, (i) make any copies of the
SOFTWARE except as expressly permitted in accordance with Sections 2.1 and 2.2 of this EULA, (i) modify the
SOFTWARE, (iii) reverse engineer, disassemble, decompile or use the SOFTWARE to create any derivative software,
(iv) rent or lease the SOFTWARE, (v) make available to download the SOFTWARE to the public, or (vi) transfer the
SOFTWARE to any third person or parties by wire or any other means.
3. WARRANTIES DISCLAIMER
TO THE EXTENT ALLOWED BY LAW, THIS SOFTWARE IS PROVIDED TO YOU "AS IS" WITHOUT WARRANTIES
OR CONDITIONS OF ANY KIND, WHETHER ORAL OR WRITTEN, EXPRESS OR IMPLIED. BROTHER
SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY,
SATISFACTORY QUALITY, NON-INFRINGEMENT AND/OR FITNESS FOR A PARTICULAR PURPOSE.
4. LIMITATION OF LIABILITY
IN NO EVENT SHALL BROTHER BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS
OPPORTUNITIES, LOSS OF USE OF DATA, INTERRUPTION OF BUSINESS, OR FOR INDIRECT, SPECIAL,
INCIDENTAL, PUNITIVE, EXEMPLARY OR CONSEQUENTIAL DAMAGES OF ANY KIND, ARISING OUT OF THE
USE, INABILITY TO USE, OR THE RESULTS OF USE OF THE SOFTWARE, WHETHER BASED IN CONTRACT,
TORT, OR OTHERWISE. YOUR USE OF THE SOFTWARE IS ENTIRELY AT YOUR OWN RISK. SHOULD THE
SOFTWARE PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL SERVICE, REPAIR OR
CORRECTION AND, TO THE EXTENT PERMITTED BY THE APPLICABLE LAW, YOU AGREE TO
UNCONDITIONALLY WAIVE ALL STATUTORY OR OTHER RIGHTS THAT MAY BE HELD BY YOU AGAINST
BROTHER IN RESPECT OF SUCH DEFECT. Notwithstanding the above, these terms do not purport to limit the
statutory rights of a consumer that cannot be waived under the applicable law.
5. Term.
This EULA will become effective upon your acceptance and continue in effect unless you cease to use the SOFTWARE.
However, Brother may terminate this EULA without notice.
6. Governing Laws.
This English language translation of the original Japanese language EULA is governed and controlled under the
jurisdiction of the laws of Japan. If any of the provisions of this EULA shall be declared void, such provisions shall be
severable and independent from the other provisions of this EULA, and the validity of the other provisions and of the
entire EULA shall not be affected.
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1-2. Components included with printer

The components included with the printer are shown below. However, in the event that there is any missing
component(s), please contact your dealer.

®

g Y

s

X0305

No. Name Quantity No. Name Quantity
1 AC power cord 1 10 Flushing receiver 2
Cable clamp 1 Flushing foam 2
Grease 1 11 Waste ink tank 1
4 Clean stick R 6 12 Print head (for color printing) 1
Clean stick T 6 13 | Print head (for white) 1
5 Cleaning cup 1 14 | Rear cover installation screws ' 2
6 Filter cover and Fan filter 2 15 Rear cover 1
Gloves (for changing the wiper 16 Wiper cleaner 2
7 cleaner / for cleaning the 4 17 Adult platen 1
maintenance unit) 18 Setup Manual 1
8 Carriage fixing pin 1 19 Driver 1
9 Tweezers 1 20 Waste ink tube 1

" Screws are already fixed with the machine.
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1-3. Other items you must make available for use

What you buy from our distributors

e Ink pouch

e Maintenance solution pouch *Only if white ink is not used
e  Cleaning solution

e  Pretreatment

Others

e  USB 2.0-compliant device cable (A/B)
<NOTE>
. Using other cables than the specified one may cause the printer to be rendered inoperative. Do not use any extension
cable.

e  LAN cable (10BASE-T/100BASE-TX)

e  USB flash memory
Please use a FAT32-formatted USB flash memory of which storage capacity is 2 GB to 32 GB in total. You
cannot use a USB memory with security functions such as password lock function or beyond 32 GB.

e  Pure water
It refers to such water as distilled water and purified water, which is used to dilute the pretreatment with it.
<NOTE>
. Avoid using such water as tap water in which impurities are contained.

Heat press
It must deliver the performance through which the print range of the size of a platen to be used can be
covered and 180°C (356°F) can be kept for 35 seconds or more. At a fixing stage of the pretreatment, be
sure to use the heat press, but not an oven, to smoothen the surface.

Peel-off sheet
Always use this sheet to flatten the fixed surface and enhance the peel property when fixating the
pretreatment and ink by means of the heat press. ="6-3-1. Provisions for pretreatment >>P.121".

Silicone foam (of open-cell structure)
It is the foamed mattress which resists heat. Use this at a fixing stage through the use of the heat press.

Adhesive roller
Use these to remove lint from a T-shirt or debris from its surface.
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e  T-shirt (printing medium)
¢ 100% cotton
o Polyester blended yarn fabric

<TIPS>
. Although it is advisable to use a 100% cotton T-shirt, some textiles cannot necessarily guarantee good printing quality even
if they are made of 100% cotton or blended yarn. In particular, for a T-shirt made of new material, perform a printing test on
it beforehand.
. Some textiles may leave noticeable imprints of the pretreatment after it is fixated. In that case, wash them away with water.
3 Perform a printing test beforehand. Then, the following phenomena may occur:
- The textiles may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.
- A deep-colored polyester blended yarn fabric dissolves dye, which may cause the white ink to change to a slightly different
color.
- Fabric material may turn yellow after the pretreatment is fixed.
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n Name and function of each component

2-1. Front part

X0306
No. Name Function

1 | Front cover Open this cover when cleaning the internal area of the printer.

2 | Carriage Holds the print head.

Obstacle sensor

Checks the presence of any obstacles by their height (such as wrinkled T-shirt)
that are within range to collide with the print head.

Platen too low sensor

Make sure that the clearance between the head and platen is not too large.

4 | Platen sheet

It helps to keep the T-shirt from moving/shifting during printing so that an image
can be clearly printed.

5 | Platen

Set the T-shirt to be printed.

6 | Shoulder bar

Align the position of a T-shirt with this bar.

7 | T-shirt tray

This T-shirt tray holds such portions of T-shirt that droop down on it and feeds
the entire T-shirt into the printer.

8 | USB flash insertion slot

Insert a USB flash memory into this slot.

9 | LAN port

Into this port, insert the LAN cable which is to be connected with a PC.

10 | USB port

Into this port, insert the USB cable which is to be connected with a PC.
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No. Name Function
Use this button to turn the power on/off to the printer.
11 | Power button The pc?wer-off operation should be performed after completing any required
operation.
The standby power cannot be turned off.
With this clamp, the LAN and USB cables can be securely fixed to the lower
12 | Cable clamp . . .
part of the main unit of printer.
13 | Operation panel Operate the printer using this panel.

2-2. Right side view

1 2 3
&
X0307
No. Name Function
Ink cartridges placed here are, from the left in the top row, black (K) and yellow
i (), from the left in the middle row, cyan (C) and magenta (M), and from the left
1 | Ink cartridge slot ) . . .
in the bottom row, white (W12) and white (W34). Be sure to put each of the ink
cartridges in their correct places.
2 | Model plate On this plate, a product serial number is inscribed.
3 | Power cord insertion port Insert the power cord into this port.
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Name and function of each component

2-3. Left side view/Rear side view

E4

X0308

No. Name Function

This is the exhaust outlet for fan exhaust air. For proper use, keep this opening
apart from the nearest wall by 7.9 in. (20 cm) or more.

—_

Exhaust opening

2 | Fanfilter It absorbs ink mist which is generated inside the printer on its surface.

3 | Waste ink tube This tube is used to direct the flow of waste ink down into the waste ink tank.
4 | Waste ink tank This tank collects waste ink.

5 | Cleaning liquid tank It is the tank that reserves the cleaning solution used for maintenance.

6 | Rear cover It protects the platen's working range.
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Name and function of each component

2-4.

Inner-side view of front cover

Before opening the front cover, be sure to stop all operations, then house the platen in place, and finally turn off the

power.

To open the front cover, raise it while holding the center grip and open it until it is oriented almost vertically.
<IMPORTANT>
. Be sure to press the power button to turn off the power before opening the front cover.

If you open the front cover while the power is on, no cleaning will be performed at the end of the print job, which is intended to

keep the print heads in good condition.

11
\\§
X030¢
No. Name Function
1 | Print head (front: on the color side) It ejects the color ink.
2 | Print head (rear: on the white side) It ejects the white ink.
3 | Carriage guide shaft This shaft supports the carriage.
In order to keep good printing quality, this unit performs maintenance
4 | Maintenance unit functions to the print heads on a regular basis. (Example: Auto-Cleaning
Function)
It protects the surface of heads on the white side, and sucks ink durin
5 | Cap (rear: on the white side) P ) . white st ! ! anng
head cleaning.
6 | Wiper cleaner (rear: on the white side) | It removes waste ink attached to the wiper surface.
7 | Wiper (for CMYK and white) It wipes away ink from the head surface.
To k inti lity the f the ink-jet lets eject
8 | Flushing foam o keep ggod printing quality the foam absorbs the ink-jet droplets ejected
from the print head.
9 | Flushing receiver Set the flushing foam.
10 | Wiper cleaner (front: on the color side) | It removes waste ink attached to the wiper surface.
It protects the surface of heads on the color side, and sucks ink durin
11 | Cap (front: on the color side) P , g
head cleaning.
12 | Carriage fixing pin To prevent dr.ying of print heads |n an emerger.lcy such as a. blackout, it
fixes the carriage to the cap position of the maintenance unit.
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X0255
No. Name Function
Use this lever to secure the platen in place.
1 | Platen fixing lever Tighten or loosen it to adjust the height of the platen when attaching/removing
the platen. Keep it tightened when printing.
2 | Platen positioning plate This is used to secure the platen at the fixed direction and hold it in place.
3 | Platen height adjustment lever | This lever should be used to adjust the platen's height.
4 | Knob Use this knob to secure the platen bearing in place. This lever should be used
to change the platen's height. Keep it tightened when printing.
5 | Platen bearing This is used to secure and hold the platen in place.
6 | Collars Used to change the platen's height by changing the number.
Platen height of each machine is finely adjusted by the number of the spacer.
7 | Spacer Never tamper with or remove these spacers even if adjusting the collars or it
will affect print output.
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Name and function of each component

2-6. Operation panel

12

11

10

\\ /

\
!

B

s

O

©

X0036

No.

Name

@ 8
Function

Liquid crystal panel

It indicates the job name or file name of print data, the active status of the
printer, and the menu for various settings.

Error LED

When it remains off. No error has occurred.
When it remains on: One or more errors have been detected.

Up-arrow button

While the menu screen is being displayed, use this button to select your
desired menu item.
In the numeric value setting menu, use this button to increase the target value.

Right-arrow button

While the menu screen is being displayed, use this button to select your
desired lower-level (right) menu item.

While the standby mode screen is being displayed, use this button to display a
warning when any warning message appears.

MENU/OK button

If this button is pressed when the printer is placed in the standby state, the
menu screen will appear.

While the menu screen or the error screen is being displayed, use this button to
finalize and accept the currently displayed content.

Down-arrow button

While the menu screen is being displayed, use this button to select your
desired menu item.
In the numeric value setting menu, use this button to decrease the target value.

Back button /
Left-arrow button

While the menu screen is being displayed, use this button to return to only one
upper-level (left) menu screen.

Print button

There is no print data when this button remains off. This button blinks during
reception of print data, and it illuminates when such reception is completed.
Printing will begin if you press this button when it is illuminated.




Name and function of each component

>

No.

Name

Function

Stop button

\V)

With this button, such actions as printing and platen movement can be
canceled.

Printer will come to a stop after necessary actions for keeping the printer's good
quality, such as retracting operation of print heads and capping operation, are
completed.

While the menu screen is being displayed, the screen will exit and return to the
standby mode screen.

10

Platen button

It is used to move the platen toward the rear or front of the printer. Use this
button to ascertain whether the platen is set to a proper height after the platen's
height is adjusted.

1

Shortcut button

Performs the action assigned to the shortcut function.

12

Power LED

When it remains off. The power of the printer is turned off.
When it remains on:  The printer remains turned on (powered on).
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Name and function of each component

2-6-1. Liquid crystal panel

The picture shown below indicates a state under which the printer has received print data. On this screen, the printer's
current state and necessary information for printing are displayed.

10 1 2
3
Sample Data
4
B 14 x 16 inch OOO
6 4. 88c
1200401 @ 01 »
8 7 5
9 6 X0190
No. Indications Function
It displays a state of progress during the process of printing and/or print-data
1 Progress bar display area p. Y prog g P P g P
reception.
5 Text string display area on In this area, the print job name or file name, auto cleaning, receiving state,
basic display screen standby state, etc. are shown.
3 | Platen Size :Iearteen size that is specified by the print driver during file creation is indicated

The total number of printed sheets of which printing operation is completed in

4 | Number of printed sheets
! P response to the received print data is displayed here. (0 to 999)

This mark appears when any warning is issued. Pressing P> causes the

5 | Warning mark
g 0 current screen to move to the warning screen where the applicable warning

message is indicated.

6 | Resolution icon The printing resolution of received print data is displayed here.

The print direction is displayed here in the form of either bi-directional or
uni-directional icon.

The required ink volume (cc) for printing out one sheet of the received print data
8 | Ink volume to be used is displayed here.

(CMYK + White)

7 Print direction icon
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Name and function of each component

>

No.

Indications

Function

Remaining ink volume
indication area

In this area, current remaining ink volume of each cartridge is displayed.
In the left-to-right order, the remaining ink volume in the black (K), yellow (Y),
cyan (C), magenta (M) and two white (W12 and W34) ink cartridges are shown
here.

§ . The remaining ink volume is running low. Make ink available for use in the
==

.y . *q
next printing session.

.: Ink has been depleted.

10

Preview image

The preview display screen of received print data is shown in this window. The
preview display screen shown here is indicated upside down as opposed to the
page orientation (the upper side of the preview image is oriented toward the front
of the printer main unit).

Furthermore, it is possible to change the direction of the preview display screen
as well.

<IMPORTANT>

*1:

If you perform printing that requires a large volume of ink when the remaining ink level is low, the ink may be depleted during the
printing process. As a rough indication, replace the ink pouch before you perform printing that requires 20 cc or more ink.
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Menu list

On-screen menu manipulation

What to do How to operate

Start Pressing @ in the wait state causes the current screen to move to the menu

selection screen.

By means of A /¥, change a menu item to another menu item to be displayed.

Pressing P causes the current menu to change to another menu item which is

Select / Acknowledge i
one level lower in the menu layer.

Pressing @ causes the currently displayed menu to be acknowledged.

Return to previous menu in Pressing :) causes the current menu to change to another menu item which is

upper menu layer : .
PP y one level higher in the menu layer.

e Ifyou press : ) when a menu in the uppermost menu layer remains

Exit displayed, the menu will exit and the system will return to the standby state.

e Ifyou press @ when an optional menu remains displayed, the menu will

exit and the system will return to standby state.
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Menu list
1st layer 2nd layer 3rd layer Description
In the event that no ink-jet droplets are ejected,
[All Colors] this menu item enables you to perform cleaning
of all the nozzles of the color heads.
In the event that no ink-jet droplets are ejected,
[Normal Cleaning] [All Whites] this menu item enables you to perform cleaning
of all the nozzles of the white heads.
In the event that no ink-jet droplets are ejected,
[All Print Heads] this menu item enables you to perform cleaning
of the nozzles of all the print heads.
[All Colors] Perform one of the powerful cleaning operations
[Powerful Cleaning] | [All Whites] when poor ejection of ink-jet droplets is not
[All Print Heads] improved by means of the normal cleaning.
[Head Cleaning] [All Colors] Perform one of the super cleaning operations
[Super Cleaning] [All Whites] when poor ejection of ink-jet droplets is not
[All Print Heads] improved by means of the powerful cleaning.
[White-1]
[White-2]
[White-3]
[White-4]
[Flash Firing] [Black] Eerform one of the ﬂush?ng operations when the
[Yellow] ink-jet droplets are not ejected stably.
[Cyan]
[Magenta]
[All Whites]
[All Colors]
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1st layer 2nd layer Description
This is the test pattern to check to see if ink-jet droplets are
Nozzle Check CMY!
st Prinf [ Kl ejected from the color heads properly or not.
[Nozzle Check White] This is the test pattern to check to see if ink-jet droplets are

ejected from the white head(s) properly or not.

[Print Data Load]

With this menu item, any print data stored in a USB flash
memory (ARXP or ARX4 file) is loaded into the system.

[Receiving History]

By selecting this menu item, you can display any print data
received in the order in which they are sorted from the
newest to the oldest ones, and you can select any one of
them.

[Maintenance]

[Maintenance Part Clean/Replace]

[White Ink Circulation]

[Head Replacement]

[Install Ink after Replacing Head]

[Initial Ink Installation]

[Exchange color filter]

[Printer transport preparation]

[Log copy to USB]

Use when performing printer maintenance.

[Printer Setting]

[Print Direction]

[Back Light]

[Auto Screen Erase Time]

[Menu TimeOut Setting]

[Speaker Volume]

[Temperature]

[Preview display settings]

[File name display setting]

[Platen Obstacle sensor]

[Platen too low sensor]

[Low Temperature Mode]

[Auto Cleaning Setting]

[Auto Cleaning Start Timing]

[Flushing Interval Setting]

[Flushing Volume Setting]

[Wiping frequency]

[Auto Job Delete]

[IP Address Set]

[Network filtering]

[Shortcut button]

[Cartridge Attach/Remove Check]

[CR Speed Adjustment]

Use when configuring the printer.
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[Head information]

1st layer 2nd layer Description

[Total Print]

[CTG Attach/Remove History]

[Check circulation schedule]

[Temperature/Humidity Info]
[IP Address]

[Confirm network [Subnet Mask]

, [Default Gateway]

setting] Use when needed.
[Host name]
[MAC address]

[Language]
[Firm Version]

Version] [Data Info]
[Serial No.]
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n Installation and preparation

Be sure to use the printer after making correct setting in accordance with the instructions described in this chapter.

A WARNING

Do not set up the printer in a dusty environment. If dust collects inside the printer, it may cause fire or electric
shocks or problems with correct operation.

Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a
serious electric shock, and problems with correct operation may also occur.

Do not bend the cords excessively or fasten them too hard with staples or anything similar to secure cords.
Otherwise it may cause fire or electric shocks.

PP @PPO

A.CAUTION

Setting up and moving of the printer should only be carried out by a qualified technician.

The printer machine weighs 128 kg (282 Ib).
Transporting and setting up of the printer should be held in the proper way. The machine may fall down and
cause injury.

When the printer falls down, disconnect the power cord and contact the place of purchase or a qualified
technician. If you continue to use it, it may result in fire or electric shocks or poor printing quality.

Do not place the printer on a shaky table or high shelf or other unstable location. Otherwise it may tip over or
fall down and cause injury. Furthermore, the table that supports the machine should be at least 35.4 in. (90
cm) in width and 23.6 in. (60 cm) in depth, and should be able to bear a weight of 150 kg (330 Ib) or more.

Do not set up the printer in a place where it will be affected by vibration. Otherwise the printing quality may be
degraded or the printer may fall down, which causes injury or results in failure of the printer.

Do not connect the power cord until installation is complete. The printer may operate if the power switch is
turned on by mistake, which could result in injury.

Do not climb onto the printer or place heavy objects on top of it. Otherwise it may become unbalanced and tip
over or fall down and cause injury.

Be careful not to touch the claws of the mounting portion on the upper side of the rear cover. Otherwise you
may be injured.

QP PP PPPPOO
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4-1. Installation of printer

Please refer to the Setup Manual included with the printer, for details of unpacking procedures and installation
procedures of accessories.
For an installation site of the printer, please bear the following points in mind:

e  When installing the printer, avoid any place that presents direct sunlight or a large amount of dust.

e  The body size is 55.1 in. (width) x 51.2 in. (depth) x 21.7 in. (height) (140 cm (width) x 130 cm (depth) x 55 cm
(height)). The main unit weighs 128 kg (282 Ib).

e  The right-and-left width of the legs is 34.1 in. (86.7 cm) while the front-to-rear width is 16.7 in. (42.3 cm). The
diameter of the legs is 1.57 in. (40 mm).

e  The height from the table to the top surface of the platen is approx. 12.6 in. (32 cm).

e Do not use any extension cable.

e  Asworkspace in front of and on both sides of the printer, always keep 39.4 in. (100 cm) or wider space around it
from obstruction. Also, as a space to install the rear cover, keep 15.7 in. (40 cm) or wider clearance at the back
of the printer. Keep 17.7 in. (45 cm) or wider space free above the unit as well. As the air is exhausted toward
the rear side, keep 7.9 in. (20 cm) or more space open behind the exhaust opening. If this space is not secured,
you will have to move peripherals or the printer when making a repair.

e  Be sure to use a table that supports the printer should be at least 35.4 in. (90 cm) in width and 23.6 in. (60 cm) in
depth, and its top plate should be level and should be able to bear a weight of 150 kg (330 Ib) or more without
rattling the printer when in operation.

¢  When installing the printer, place a level gauge on the top surface of the cover and the top surface of the platen
to make adjustments so that the main unit is set horizontally level.

e In preparation for a major earthquake or other natural disasters, fix the table and the main unit with a tool like a
fixing band to prevent the main unit from falling from the table.

. 17.7 in. (45 cm) or more s N

Printer installation dimensions

Exhaust

=

o 15.7 in. (40 cm) or more

106:3n. (270 cm) ormore_— 4.

394 ’iiaé\)
4in. cm
>\/"ormore N

39.4in. (100 cm)

or more

39.4 in. (100 cm) or more
‘/,'

,

133.9in. (340 cm) or more \ . . 2
*..35.4in. (90 cm) or more 23.6 in. (60 cm) or more

/ X0310
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Leg dimension

&

1.57 in. (40 mm) SN
Leg

34.1in. (86.7 cm)

Platen height dimension surface

\ / Platen top surface

> I Aoprox. 12.6 in. (32 cm)

Base
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Seismic protection example
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Installation and preparation >

4-1-1. Installation of waste ink tank

Insert the waste ink tube into the main body. Fasten the waste ink tank to the table leg or the like by using two pieces of
string, etc. Insert the waste ink tube into the waste ink tank.

<IMPORTANT>
. If the tip of the waste ink tube is immersed in the liquid, it will prevent the smooth flow of the waste ink, to disable the ink

suction operation of the head cleaning function. After the waste ink tank is fastened, the waste ink tube should be cut so

that the length from the tube connection is 5.9 in. (150 mm).
. Avoid placing the waste ink tube horizontally as much as possible, and be sure not to let it bend. Otherwise the waste ink

may have difficulty flowing through the tube.

<TIPS>
. Install the waste ink tank in the front, because it must be emptied when the waste ink is full.
N
e ~N 0]
/(—,4:)\ 5.9 in. (150 mm)
7
(e
N\
A\ J/ )
X0312
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Installation and preparation

4-2. Power supply of printer

Even when the printer is placed in standby mode, such maintenance as white ink circulation is performed automatically.
PLEASE LEAVE THE PRINTER POWERED ON 24 HOURS A DAY.
<TIPS>

. Every time this printer is powered on or off, maintenance operations are performed to keep its print heads in good condition.
Turning on and off the power frequently causes more ink to be consumed because of the maintenance operations. In order to
reduce the ink consumption, it is advisable to keep the power turned on for proper use of the printer.

4-2-1. Turning on the power

Please refer to the Setup Manual, after the unpacking procedures and installation procedures are completed.
Please check the following points, before connecting the power cord to the printer:

e  Check whether or not the cartridge is correctly installed.

e  Check whether or not the wiper cleaner and flushing receiver are correctly installed.

e Ascertain whether the ink tube is connected to the print head correctly.

Wiper cleaner

X’ k Cartridge
> Frxw v
(’{// T

@%/ %

Flushing receiver _

X0313
° Ascertain whether the waste ink tube is inserted into the waste ink tank which has been made available.

e  Ascertain whether the rear cover is put in position.

e  Ascertain whether there is enough cleaning solvent in the cleaning liquid tank and the tank is mounted correctly
in place.
e  Ascertain whether the required space (at least approx. 11.8 in. (30 cm)) for the platen to be moved forward is

kept and the min. clearance (7.9 in. (20 cm)) is maintained at the back side of the printer for exhausting air from
the exhaust opening.
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Installation and preparation

(1) Connect the power cord included with the printer to the power cord insertion port.
(2) Insert the power plug into an electric outlet.
(3) Make sure that the printer's earth terminal is properly grounded.

(4) With the main unit's cover being closed, turn on the power to the printer.

<IMPORTANT>

. Never power off the printer while it is in operation. Otherwise, the printer may be damaged.

. Do not activate the printer with the ink tube not connected to the print head. Otherwise, the printer may be damaged.

° Make sure that no flushing foam extends off the outboard end portions of the flushing receiver. If it sticks out of the end
portions, it may interfere with any nozzles and may result in non-gjection of ink-jet droplets.

3 Do not turn off the power because if you do so, the machine mail fail because necessary maintenance operations are not
performed.

<TIPS>

. If the printer is activated after having been off for a long time, the maintenance operation including white ink circulation will
be performed for up to 40 minutes.

4-2-2. Turning off the power

When you need to turn off the power

Turn off the power in the following cases.

e  When the front cover needs to be opened for maintenance of the printer, etc.

e When moving the printer elsewhere.

e Inthe event that the power supply interruption is anticipated in advance, including the case where a planned

power outage is scheduled.
<IMPORTANT>
3 When you want to move the printer, perform [Printer transport preparation] before doing so. Otherwise, the print head may
fail to eject ink-jet droplets due to the vibration during transport.= "4-5. Moving the printer >>P.66"

How to turn off the power

(1) Press the power button for a short time (Release your finger when a beep sounds).
If the printer is operating, wait for it to finish.

(2) Cleaning will start at the end of the print job.
Then the power will be turned off.
<IMPORTANT>
. No cleaning will be performed at the end of the print job to keep the print heads in good condition, if you open the front
cover before turning the power off or disconnect the AC power cable. In these cases, the print heads may fail to eject ink-jet
droplets. For this reason, be sure to activate the printer once again and perform the head cleaning after activation.
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Installation and preparation >

4-2-3. When there is no prospect of electric power recovery for a while due to power outage

(1) Open the front cover and move the carriage to the left, and stop it at the position where the left side of the carriage

reaches the end. The position of the print head and the cap should match.
Returning the print heads to the cap position prevents them from drying up.

(2) Insert the carriage fixing pin into its specified hole, and fix the carriage to the cap position.
<TIPS>
. Note that the carriage fixing pin is housed in the area on the left side of maintenance unit.
. The front cover will not close completely if the carriage is fixed with the carriage fixing pin.

Carriage fixing pin

Pad

\ : 1
A

\é Fixed location
/ﬁ

Stowed position
&

X0314

Front cover

*The cover will not close
completely while the
carriage is fixed.

/ Y %
Carriage fixing pin

N

(3) When the current state is brought to an available condition to turn on the power, pull out the carriage fixing pin,

X0200

return it to its stowed position and reactivate the printer.
<IMPORTANT>
3 For this reason, be sure to activate the printer once again and perform the head cleaning after activation.
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Installation and preparation

4-3. Connection between Printer and PC (for Windows)

This chapter provides information about the procedures to install the GTX pro printer driver onto your PC and connection

method of the printer to PC.

For Windows 8.1 and 10, different dialog boxes may be displayed. Proceed with the next step while checking each

procedural step.

Installing the printer driver

"4-3-1. Installing printer driver onto your PC >>P.45"

When connecting via
USB

Add a Printer to PC

"4-3-2. Connect with
USB2.0 cable: Adding the
printer to the PC >>P.46"

A2

When connecting via LAN

B2

Set static IP
address on PC

C Set static IP address on
Printer main unit

Printer static IP Address
Set
"4-3-3. When connecting via

LAN: Static IP address setting
>>P48"

Printer static IP Address
Set

C2

"8-17. Static IP address setting
>>pP.238"

Add a Printer to PC

"4-3-4. When connecting via LAN: Adding a printer to PC >>P.52"

Adjusting Printer

"7-4-1. CR (Carriage) speed adjustment >>P.216"
"7-4-2. Initial settings after head replacement >>P.217"

"7-4-4. Platen-rolling adjustment >>P.219"

"7-4-3. Firing adjustment >>P.218"

"7-4-5. White/color alignment >>P.220"
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Installation and preparation >

4-3-1. Installing printer driver onto your PC

To begin with, on your PC, install the printer driver for file output, "Brother GTX pro FileOutput".
At this stage, do not connect the printer to your PC yet.
<TIPS>

. You must log into your PC with administrator privileges.

(1) Activate the PC.

(2) Complete all of the current sessions.

(3) Double-click on the "setup.exe" to execute the installer.

(4) Then, the installation procedures will begin. Follow the on-screen instructions to complete the installation.

(5) When the dialog box shown below appears, click [Install].

E=] Windows Security X

Would you like to install this device software?

MName: Brother Printers

.:?:. Publisher: Brother Industries, Ltd.

O :Always trust software from "Brother Industries,
iLid.",

m Don't Install

@) You should only install driver software from publishers you trust. How can | decide which
device software is safe to install?

(6) After the installation is completed, reactivate the PC.
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Installation and preparation >

4-3-2. Connect with USB2.0 cable: Adding the printer to the PC

™

2
@)

(4)

(5)

Once you have installed the printer driver, with the printer powered on, make a connection with a USB 2.0 cable

between the printer and your PC.
<TIPS>

. For this connection of the USB cable, secure it in place by means of the cable clamp as required.

Follow the on-screen instructions to complete the installation.

After the installation is completed, open [Devices] > [Devices and Printers] from [Settings].

<TIPS>

. In the case of Windows 8.1, select the [View devices and printers] from [Control Panel].

#fa Devices and Printers

Add a device Add a printer

~ Devices (4)

7}

AS242W DESKTOP-FRE5K3
2

USB Keyboard

~ Printers (5)

=22

Brother GTX pro Brother GTX pro Fax

FileQutput

g items

e

4 Fa « Hardware and Sound » Devices and Printers

s

USB Optical
Mouse

=

Microsoft Print
to PDF

LY

Search Devices and Printers

=

Microsoft XPS
Document Writer

(]

® * x

- v

Right-click the "Brother GTX pro" icon or the "Brother GTX pro FileOutput” icon for file output, and select the [Set as

default printer].

If LAN connection is required, perform static IP address setting on the printer and add the printer to the PC.

If connecting only via USB and LAN connection is not required, configuration task on the PC is now completed.
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(6) Adjust the carriage speed. Then adjust the printer using "GTX pro Maintenance".

dark color T-shirt

Menu name Things to prepare See the operating procedure with
GTX pro Maintenance
, "7-4-1. CR (Carriage) speed
1 | [CR Speed Adjustment —
[ P i ] adjustment >>P.216"
5 [Initial settings after head "7-4-2. Initial settings after head
replacement] replacement >>P.217"
Black paper or transparent sheet
3 | [Firing Adjustment] (such as OHP sheet) "7-4-3. Firing adjustment >>P.218"
White paper
. . . "7-4-4. Platen-rolling adjustment
4 | [Platen-Rolling Adjustment] White paper >>P 219"
Black paper or pretreated black or | "7-4-5. White/color alignment
5 | [White/Color Alignment] pap P I

>>p.220"

What to do in the White Ink Pause Mode

For the White ink pause mode, perform the following steps using the maintenance tool.

Menu name

When in White Ink Pause Mode

[CR Speed Adjustment]

Performed

[Initial settings after head replacement]

Performed for color head only

Upon completion of color head
setting, click [Cancel] to close the
maintenance tool once and then start
it. Then proceed to the following
steps.

[Firing Adjustment]

Performed for color head only

Upon completion of color head
setting, click [Cancel] to close the
maintenance tool once and then start
it. Then proceed to the following
steps.

[Platen-rolling adjustment]

Performed

()]

[White/Color Alignment]

Not required

[Setting of the time displayed on the nozzle check pattern]

Performed
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4-3-3. When connecting via LAN: Static IP address setting

When connecting via LAN, Printer static IP address needs to be obtained beforehand. There are two ways to set a static
IP address for the printer: from the PC and from the printer. For information on the setting from the printer, see Chapter 8.
=="8-17. Static IP address setting >>P.238"
<TIPS>
o If the PC cannot recognize the Printer, a correct static IP address might not be assigned. ="4-3-4. When connecting via LAN:
Adding a printer to PC >>P.52"
Consult your administrator.

(1) With the printer powered on, make a connection with a USB 2.0 cable between the printer and your PC.
<TIPS>
. For this connection of the USB cable, secure it in place by means of the cable clamp as required.

(2) From [All Programs] in the Start menu, select the "GTX pro Maintenance" from "Brother GTX pro Tools".
(3) After the window shown below appears, select the [IP Address Set] and click [Next].

@/ Brother GTX pro Maintenance *

Confirm the printer is turned ON and connected to your PC.
Select the printer,

Brother GTX pro i Search

Select an item from the menu below and dick "Next”.

(") Initial settings after head replacement
Parform this satting whaen replacing the head or whan setting up the printer only,

(O Firing Adjustment
Adjust this sefting when the edges of the print look vagus, solid aress are not even, or sfter 2 Print Head & replaced.

(O Platen-rolling adjustment
Make adjustments whan horizontal stripes (banding) eccur in the printed image, Use this adjustment as a
troubleshoaoting method when other Rems such as proper temperature and humidity have already besn verified,
(O white/Color Alignment
Adjust when white print doss not align with enler print.

(C) Log Data Retrieval
Exerite if there was a request afier troubleshoating service.

() Setting of the time displayed on the nozzle chedk pattern
This & not necessary if you have configured the scheduled time for white ink circulation.

(0) set the scheduled time for white ink droulation
Configure this setting to set or cancel the scheduled time fior white ink circulation.

< Back MNext > Close
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(4) Select the desired IP address setting method and click [Next].

@ Brother GTX pro Maintenance X

Step 1:
Select the method of setting the IP address.

(® Manually enter the IP address

(O Automatically acquire the IP address

< Back INext:-I Cancel
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If you selected "Manually enter the IP address™

(5) Enter each of the pre-determined values of the printer for [IP Address], [Subnet Mask] and [Default Gateway], and

click [Next]. (One instance of each value is cited as shown in the window below.)

§ Brother GTX pro Maintenance X

Step 2:
Input IF address.

Input IP address, Subnet Mask and the default Gateway to the printer.

1P Address 192,168, 0 . 2

Subnet Mask 255 , 256 , 255 . O

Defait Gateway

=TI [
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If you selected "Automatically acquire the IP address™

(5) Enter the host name to be set for the printer and click [Next].
<TIPS>
. The host name can contain up to 31 characters.

UE? Brother GTX pro Maintenance X

Step 2:
Enter the host name.

Enter the host name to be associated with the printer.

Host name : ‘ GTpro|

Press "Mext” to automatically acquire the IP address.

= ==

(6) When [IP address was successfully assigned to Printer.] is displayed, the process is complete.
If there is any error in each of the values you have entered for the static IP Address, Subnet Mask and Default Gateway, an error
message to inform you thereof accordingly will appear. In this case, correct the error and attempt the process again.

¥ Brother GTX pro Maintenance X
P

Step 3:
TP address was assigned.,

IP address was successfully assigned to the Printer.

s [EET] | oo
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4-3-4. When connecting via LAN: Adding a printer to PC

Installation and preparation

>

(1) Connect your PC with the printer by means of the LAN cable to make a network connection, and power on the

printer.
<TIPS>

. For this connection of the LAN cable, secure it in place by means of the cable clamp as required.

(2) Select [Settings] > [Devices] > [Devices and Printers].
<TIPS>

. In the case of Windows 8.1, select the [View devices and printers] from [Control Panel].

(3) Click the [Add a printer].

#fa Devices and Printers

Add a device Add a printer

v Devices (4)

=

AS242W DESKTOP-FR85K3 USB Keyboard USB Optical
2 Mouse

~ Printers (5)

9 items

5

4 H& « Hardware and Sound » Devices and Printers v O Search Devices

22w

Brother GTX pro Brother GTX pro Microsoft Print Microsoft XPS
FileOutput to PDF Document Writer

and Printers

(4) Select [The printer that | want isn't listed].
<TIPS>

. In the case of Windows 8.1, select [The printer that | want isn't listed] -> [Add a local printer or network printer with manual

settings], then click [Next].

B Add a device

Choose a device or printer to add to this PC

No devices found

I The printer that | want isn't listed I

Mext
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(5) Select [Add a local printer or network printer with manual settings], then click [Next].

@ Add Printer

Find a printer by other options

(O My printer is a little older. Help me find it.

() Select a shared printer by name

Browse...

Example: \\computermame\printername or
http://computername/printers/printername/.printer

(O) Add a printer using a TCP/IP address or hostname

(0) Add a Bluetooth, wireless or network discoverable printer

(@ Add a local printer or network printer with manual settings

(6) Select the [Create a new port], then select [Standard TCP/IP Port] for [Type of port], and finally click [Next].
*

€ = Add Printer

Choose a printer port

A printer port is a type of connection that allows your computer to exchange information with a printer.

(O Use an existing port: LPT1: (Printer Port)

Type of port: I WI

=
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(7)

(8)

9)

Installation and preparation >

In the [Hostname or IP address] field, enter the already-setup static IP address of the printer, uncheck the [Query
the printer and automatically select the driver to use], and click [Next]. (One instance of each value is cited as

shown in the window below.)

X
¢ mm Add Printer
Type a printer hostname or IP address
Device type: TCP/IP Device
Hostname or IP address: 192.168.0.2
Port name: 192.168.0.2 |

l|_| Query the printer and automatically select the driver to use l

<TIPS>

. If you set the printer's IP address by automatic acquisition, you must check the IP address of the printer in advance. You
can confirm the IP address by selecting [Confirm network setting] -> [IP Address] from the menu. ="8-25. Confirm network
setting >>P.243".

. If you are using a DNS server, you can use a host name and domain name instead of the IP address. Enter the host name
of your choice.= "4-3-3. When connecting via LAN: Static IP address setting >>P.48"
As for the domain name, check with your network administrator.

Then, the detection window of TCP/IP port appears, and the current window will automatically go to the additional
port information window after the detection is completed.

After the window shown below appears, select the [Custom] in the [Device Type], and click [Settings].

X

4 @ Add Printer

Additional port information required

The device is not found on the network, Be sure that:

1. The device is turmed on.

2. The network is connected.

3. The device is properly configured.

4. The address on the previous page is correct.

If you think the address is not correct, click Back to return to the previous page. Then correct the

addrese and perform another search on the network. If you are sure the address is comrect, select the
device type below.

Device Type

D) standard  Generic Network Card

@ Custom Settings...
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(10) In the [Protocol], select the [LPR], enter "BINARY_P1" in [Queue Name] of the [LPR Settings], and click [OK].

When the current screen goes back to the previous screen, click [Next].

Configure Standard TCP/IP Port Monitor X

Port Settings

Port Name: | 192.168.0.2

Printer Name or IP Address: I 192.168.0.2

- Protocol -
" Raw @ LPR

~ Raw Settings
Port Wumber |g|oe

r~ LPR Settings

Queue Name: | BINARYP1

[~ LPR Byte Counting Enabled

1 SNMP Status Enabled

Cammunity Narme: | public

SNIMP Device Inde | 1

e

(11) After the window shown below appears, click the [Have Disk].

& d=h Add Printer

Install the printer driver

g Choose your printer from the list. Click Windows Update to see more models.

To install the driver from an installation CD, click Have Disk.

Manufarturer Printers

3 Brother GTX pro
4

Microsoft

[5] This driver has an Authenticode(tm) signature.
Tell me why driver signing is important
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(12) Click the [Browse], select the "64bit_OS" folder in the installer according to the PC's OS (64 bit version).

After the file path appears, click [OK].

Install From Disk X
Insert the manufacturer’s installation disk, and then
.‘E make sure that the comect drive is selected below.
Cancel
Copy manufacturer’s files from:

(13) Make sure that a list of printer drivers is shown for the selected folder.

After that, click [Next].

& d=h Add Printer

Install the printer driver

$ Choose your printer from the list. Click Windows Update to see more models.

To install the driver from an installation CD, click Have Disk.

[=J Brother GTX pro

= This driver has an Authenticode(tm) signature. | Windows Update | ‘ Have Disk...
Tell me why driver signing is im; nt
can:d

(14) After the window shown below appears, select the [Replace the current driver], and click [Next].

x
& d%h Add Printer

Which version of the driver do you want to use?

Windows detected that a driver is already installed for this printer.

(O Use the driver that is currently installed (recommended)

I@ Replace the current driver I

=~
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(15) Enter [Printer name], and click [Next].

< =h Add Printer

Type a printer name

Printer name: I | Brother GTX pro (LAN)|

This printer will be installed with the Brother GTX pro driver.

==

(16) Then, the specified printer will be added to the system, following which the window shown below appears, select

the [Do not share this printer], and click [Next].

\J = Add Printer

Printer Sharing

I you want to share this printer, you must provide a share name. You can use the suggested name or
type & new one. The share name will be visible to other network users.

[ _Net Jf Concel |
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(17) Click [Finish]. This exits the setting for the PC.
<TIPS>
. If the PC cannot recognize the Printer, a correct static IP address might not be assigned. Consult your administrator.

x

@ Add Printer

You've successfully added Brother GTX pro (LAN)

To check if your printer is working properly, or to see troubleshooting information for the printer, print a
test page.

Print a test page

Cancel

(18) Adjust the carriage speed. Then adjust the printer using "GTX pro Maintenance".

>

Menu name Things to prepare See the operating procedure with

GTX pro Maintenance

"7-4-1. CR (Carriage) speed

1 | [CR Speed Adjustment] adjustment >>P.216"

5 [Initial settings after head
replacement]

"7-4-2. Initial settings after head
replacement >>P.217"

Black paper or transparent sheet

3 | [Firing Adjustment] (such as OHP sheet) "7-4-3. Firing adjustment >>P.218"
White paper
. . ) "7-4-4. Platen-rolling adjustment
4 | [Platen-Rolling Adjustment] White paper >>P 219"
) ) Black paper or pretreated black or | "7-4-5. White/color alignment
5 hite/Color Al t
[White/Golor Alignment] dark color T-shirt >>P.220"

[Setting of the time displayed
on the nozzle check pattern]

"7-4-6. Setting of the time displayed
on the nozzle check pattern >>P.221"
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What to do in the White Ink Pause Mode

Installation and preparation

For the White ink pause mode, perform the following steps using "GTX pro Maintenance".

>

Menu name

When in White Ink Pause Mode

1 | [CR Speed Adjustment]

Performed

2 | [Initial settings after head replacement]

Performed for color head only

Upon completion of color head
setting, click [Cancel] to close the
maintenance tool once and then start
it. Then proceed to the following
steps.

3 | [Firing Adjustment]

Performed for color head only

Upon completion of color head
setting, click [Cancel] to close the
maintenance tool once and then start
it. Then proceed to the following

steps.
4 | [Platen-rolling adjustment] Performed
5 | [White/Color Alignment] Not required
6 | [Setting of the time displayed on the nozzle check pattern] Performed
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4-4. Connection between Printer and PC (for Macintosh)

This chapter provides information about the procedures to install the GTX pro printer driver and connection method of
the printer to the PC. You can connect the printer to your PC using either a USB cable or a LAN cable.

-Using a USB cable="4-4-2. Connecting the printer to your PC via a USB 2.0 cable >>P.61"

-Using a LAN cable="4-4-3. Connecting the printer to your PC via a LAN cable >>P.63"

4-4-1. Installing printer driver onto your PC

To begin with, onto your PC, install the printer driver for file output, Brother GTX pro FileOutput.
At this stage, do not connect the printer to your PC yet.
<TIPS>

. You must log into your PC with administrator privileges.

(1) Activate the PC.

(2) Complete all of the current sessions.

(3) Double-click on the "BrotherGTX pro_ver*.pkg" to execute installer.

(4) Then, the installation procedures will begin. Follow the on-screen instructions to complete the installation.

(5) After the installation is completed, reactivate the PC.
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4-4-2. Connecting the printer to your PC via a USB 2.0 cable

(1) With the printer powered on, make a connection of USB 2.0 cable between the printer and your PC.

(2) From the Apple menu, open the [System Preferences] and click on the [Printers & Scanners].

oo k3 System Preferences [Qseor )

Sign in to your Apple ID .
Set up iCloud, the App Store, and more. Sign In

E DB EOC QO ER

General Desktop & Dock Mission Siri Spotlight Language Notifications
Screen Saver Control & Region
@ =2 ©® © . 9
Internet Users & Accessibility Screen Time Extensions Security
Accounts Groups & Privacy
Software Network Bluetooth Sound Printers & Keyboard Trackpad Mouse
Update Scanners
4 § (-
& m @
m y & &

(3) After that, click the + button in the lower-left corner.

0 < s Printers & Scanners Q

<> Brother GT-3 FileOutput, Drother OTX pro FleOuten
T o e

A Open Print Queue...
< Brother GT-3 USB BN
é ® Offiine

Options & Supplies...
< Brother GTX pro

« Oftine, Detaut
Brother GTX pro FileO. Location
die
<7 Brother GTX-4 FileOut... [ BretherenXere
i we: de

< GTX pro LAN
1 o e

7] Share this prir the network | Sharing Preferences.
D 4 Printer sharing is turned off.
Default printer: | Brother GTX pro
Default paper size: | A4 B
{5 Click the lock to make changes. ?

(4) Select the [Brother GTX pro xx] first, then click on the [Select Software...] of [Use].

Brother GTX pro

Name;  Brother GTX pro 3

U n
v Brother GTX pro |

|  select Software... i |

Other... ]

T c—
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(5) Select the [Brother GTX pro] and click on the [OK].

(6) Then, click [Add].

000 Printer Software

[a o)

[ Brother GTX pro | |

e

ece Add
@ - Q o

1P Windows Search

Name v Kind

Brother GTX pro

Name: | Brother GTX pro 3 |

Location: \

Use: | Brother GTX pro

Installation and preparation

(7) Inthe [Default printer], select either [Brother GTX pro xx] or [Brother GTX pro FileOutput].
This exits the setting for the USB connection.

@80 < | > | = Printers & Scanners Q Searc

Brother GTX pro 3
@ Open Print Queue...
Options & Supplies...
Location

Kind: Brother GTX pro
Status: Idie

@\ Brother GT-3 FileOutp
o idie
<> Brother GT-3 USB

= offiine
<> Brother GTX pro
B« otfine, Dotaut
7> Brother GTX pro 2

o die

o Brother GTX pro 3
|2 ™

@ Brother GTX pro FileO |
o idie

Brother GTX-4 FileOut o )
Fida ’ [ Share this printer on the network _Sharing Preferences...

r"T’\. GTX oro LAN.
+-

(SN TR
Default paper size: A4
. CE—

Bl Clickthe lock to prevent further changes. 2
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4-4-3. Connecting the printer to your PC via a LAN cable

When you connect your Macintosh to the printer via a LAN cable, configure the IP address settings for the printer,
referring to the Instruction Manual.
Subsequently, perform the procedures below to add the printer to your PC.

(1) Connect your PC with the printer by means of the LAN cable to make a network connection, and power on the

printer.
<TIPS>
. For this connection of the LAN cable, secure it in place by means of the cable clamp as required.

(2) From the Apple menu, open the [System Preferences] and click on the [Printers & Scanners].
o = S T

E 2B EH O QO B W

General Desktop & Dock Mission Siri Spotlight Language  Notifications
Screen Saver ontrol
© 2@ © 8 . @9
& -

Internet Users & Accessibility Screen Time Extensions Security
Accounts Groups & Privacy
Software Network Bluetooth Sound Printers & Keyboard Trackpad Mouse
Update Scanners

-
> B @

|y & B ™=

Saver Machine Disk

(3) After that, click the + button in the lower-left corner.

L] < s Printers & Scanners Q

< Brother GT-3 FileOutput Drother OTX pro FleOuten

B o e < Open Print Queue...
< Brother GT-3 USB <
13"« oftine Options & Supplies...
< Brother GTX pro
I3« offine, Detaui

Brother GTX pro FileO...

idie

<7 Brother GTX-4 FileOut... Sl

o ide ide

~ GTX pro LAN

v i Sharing Preferences.

D s Printer sharing s turmed of.

Default printer: | Brother GTX pro B
Default paper size: | A4
{8 Click the lock to make changes 2
[ ] Add
= -
2 e |- a
efaul]l 1P [vindows Search
Address:
Enter host name or IP address.
Protocol: | Line Printer Daemon - LPD
Queue:

Leave blank for default queue.

Name:
Location:

Use:
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(5) Inthe [Address], enter the IP address of the printer you have just set up.
Select the [Line Printer Daemon - LPD] of [Protocol].
In the [Queue], type in the word "BINARY_P1".
Enter the name of the printer in the [Name].

Click on the [Select Software...] of [Use].

eC e Add

SEw o

Default 1P Windows Search

|| Address: [192.168.000.002 ] |
i Neritying address
[[Protocol: | Line Printer Daemon - LPD
Queue: | BINARY_P1 |
Leave blank for default queue.

—
| Name: | GTX pro LAN | |

Locatior  Auto Select
v Generic PostScript Printer

Select Software...

(6) Select the [Brother GTX pro] and click on the [OK].

aN ) Printer Software

| Q gtxp o

Brother GTX pro

Coe “

(7) Then, click [Add].

Address: |192.168.000.002
£ Verifying address...
Protocol: | Line Printer Daemon - LPD

o

Queue: |BINARY_P1
Leave blank for default queue.

Name: | GTX pro LAN |

Location: |

Use: | Brother GTX pro
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(8) Then, the current window goes back to the [Printers & Scanners] window into which the GTX pro printer (LAN) is

added.
In the [Default printer], select your desired GTX pro printer, as required.

This exits the setting for the LAN connection.

[ ) < Printers & Scanners Q
7> Brother GTX pro
1 « oftine GTX pro LAN

iy iBrother OTX pro 2 S Open Print Queue..
- ™
4

@ Brother 6TXpro3 Options & Supplis...
<7 Brother GTX pro 4
=
7> Brother GTX pro FileO
Sother 67X pro

1 o e

<7 Brother GTX-4 FileOut

e
e
Share this printer on the network Sharing Preferences.

<7 GTX pro LAN
1" < e, Detautt

==
I Default printer: | GTX pro LAN H

Default paper size: | A4

idle

[ Click the lock to prevent further changes.
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4-5. Moving the printer

<IMPORTANT>
When you want to move the printer, perform [Printer transport preparation] before doing so. Otherwise, the print head may
fail to eject ink-jet droplets due to the vibration during transport.
(1) While the printer is in standby mode, press the @ on the operation panel to bring the menu screen into the view.
(2) From the menu, select [Maintenance] > [Printer transport preparation], and press @ .

(3) Check the remaining ink in the ink pouch and press @ .

Printer transport preparation

[ 2Imin[39]sec

Please Wait

(4) Once the transport preparation is complete, turn off the power.

(5) Remove the power plug from the outlet and move the printer.
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H Creating print data

5-1. Types of applications

You can create print data by either “using Brother products” or "using other applications”. Select applications to use
depending on your needs. You are recommended to use Brother product applications as far as possible. If you want to
use other applications, however, you are recommended to use one of the three recommended applications to achieve
high-quality print results. This chapter describes the procedures for using other applications.

Using Brother product

Applications to use Reference
GTX Graphics Lab Graphics Lab Instruction Manual
When using other applications

Applications to use Reference
CoreIDRAW(2018/2019) "5-3-1. When using CorelDRAW >>P.70"
Adobe Photoshop(CC2020/CC2019) "5-3-2. When using Adobe Photoshop >>P.78"
Adobe lllustrator(CC2020/CC2019) "5-3-3. When using Adobe lllustrator >>P.83"

<TIPS>

. Make proper settings, such as color settings and printing conditions, of each application, in accordance with the setting contents
of the application.

. In this chapter, the value RGB=(254,254,254) is described as "RGB=254", and the value RGB=(255,255,255) is described as
"RGB=255".
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About color mode (color space)

The GTX pro printer is a printer of RGB type.

Be sure to create image data in RGB mode, and always set the color space (input) you use for such data to sSRGB

(sRGB IEC61966-2.1).

<TIPS>

. When such application as Adobe and Corel is used, there are instances in which an image in CMYK mode cannot reproduce the
color that is intended.

. Even for an image in RGB mode, a similar color reproduction failure occurs when other color space than the specified one, such
as Adobe RGB, is used.

About print layout

Specify the platen size that uses the paper size specified in the Print menu, and confirm the print layout.

Moreover, use the "Brother GTX pro FileOutput" printer driver for file output, then display and check the print preview.

<TIPS>

. In order for a print image to be oriented properly at all times, it is advisable to set the GTX pro printer to the [Set as default
printer].

How to create white data

When creating print data with [Color + White Ink] or [White Ink Only], RGB=(255) is treated as "Transparent color",
ejecting no ink. For such an image that you wish to print out in pure white color with white ink, make such a setting as
RGB=254.

<TIPS>

. The treatment of RGB=255 varies depending on the applications. Configure the settings appropriately.

About ARXP file

Use the "Brother GTX pro FileOutput" printer driver for file output in order to save your print data in the ARXP format.

When your print data is saved in the ARXP format, its information and the amount of used ink will be able to be reviewed.

<TIPS>

. When performing file output, be sure to use the printer driver, "Brother GTX pro FileOutput". If file output is performed using [Print
to file] command that is supplied with each application, there may be some cases where the file extension cannot be saved
as .arxp, or the file destination cannot be specified.

o ARX4 files created with the GTX can be printed with the GTX pro.

° The GTX pro printer cannot print out the print data that has been created for the GT-541/GT-782/ GT-3 series.

. If you make a printer driver setting from the Control Panel of your PC, such setting sometimes will not take effect in each
application. For this reason, verify that your printer driver has been set up properly before you begin printing.
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5-2. Sending print data using Brother GTX pro FileOutput (for Macintosh only)

Saving print data to a file

When using the "Brother GTX pro FileOutput" printer to save print data to a file, be sure to perform the save operation
with the " GTX pro FileViewer" being activated.

If you try to output and save the data to a file without activating the " GTX pro FileViewer", an error shown below will
occur and the file cannot be saved to the system.

<TIPS>

. Not all applications display an error message. If that is the case, start the "GTX pro FileViewer" and try again.

Error
% GTX pro FileViewer does not launched.

<TIPS>
o The procedures to output a file from the "Brother GTX pro FileOutput" are the same as those for Windows PC.

Transmission of print data

Send such print data that has been saved using the "Brother GTX pro FileOutput" printer to the printer by performing the
procedures mentioned below.

<TIPS>

. The procedures to send the print data are the same as those for Windows PC.

(1) Double-click on a file with the extension ".arxp" assigned to its flename which has been saved by means of the
"Brother GTX pro FileOutput" printer.
(2) Subsequently, the " GTX pro FileViewer" starts working, then, under that condition, click on the [Send to Printer],

which results in the file transmission.
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5-3. Using other applications

5-3-1. When using CoreIDRAW

First of all, perform the following procedures:
e  Color setting
e  Printsize
As required, perform the following procedures:
e  Create print data (ARXP file)
e  Use the color palette in Useful Tools.
e  Convert data to bitmap image data
¢ Replace RGB=255 in bitmap image data with RGB=254

<TIPS>
. For this printer, it is recommendable to use CorelDRAW 2018/2019. The display screen is described assuming CorelDRAW
2019.

Color management settings

(1) Inthe menu bar, select [Tools] > [Color Management].

(2) Establish the settings of [Color Management Settings] as follows:
o [RGB profile]: [sSRGB IEC61966-2.1]
¢ [Primary color mode]: [RGB]
¢ [Rendering intent]: [Relative colorimetric]

Coler Management Settings X
Default

Preset: | Custom > ﬂ

RGE profile: | (Default) sSRGB IEC61966-2.1 =

CMYK profile: | (Default) U.S. Web Coated (SWOP) v2 -
Grayscale profile: | (Default) Dot Gain 20% -
Primary color mode: |RGB >
Rendering intent: | Relative colorimetric -

Color conversion
Color engine: | Microsoft ICM CMM v

Preserve pure black
+| Map gray to CMYK black

2 OK Cancel
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Print size

(1) Inthe menu bar, select [File] > [Print].

(2) Set the [Printer] to either "Brother GTX pro" or "Brother GTX pro FileOutput", click on [Apply], and close the [Print]
dialog box.
<TIPS>

. If [Printer] is set to "Brother GTX pro", the print data at the time of printing will be sent to the printer.
If [Printer] is set to "Brother GTX pro FileOutput", the print data at the time of printing will be saved as an ARXP file.

Print X
General Color Composite Layout Prepress PostScript No Issues
Destination
Printer: Brother GTX pro -| &
Orientation: | Match orientation (Letter, Portrait) b
Status:
Location:
Comment: Single File -
Print range Copies
® Current document Documents Number of copies: 1 =
Current page Selection
] I
(2K
Print as bitmap: 300 dpi
Print style: CorelDRAW Defaults o Save As...

g Print Preview E* Print Cancel

(3) Inthe menu bar, select [Layout] > [Page Layout].
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(4) Make the following settings in the [Page Size] window:

o [Size]: [Custom]

o [Width]: 14.0in. (355.6 mm)
e [Height]: 16.0 in. (406.4 mm)

o Page orientation: Portrait
<TIPS>

Creating print data >

° Set the width and height to the size of platen to be used. ="5-4-1. Select the platen size >>P.91". The above size is the

standard 14X16 platen size.
Document Options

General
Page Size
Layout
Background
Guidelines
Grid

Rulers

Save

? Save as Default...

Create print data (ARXP file)

® Page size Label presets

Size and orientation

Sizel§ Custom > [~ ]
Widthfl 355.6 | | millimeters -
Heightfll 406.4 ol (| O

Apply size to current page only
+| Show page border
Add Page Frame
Rendering resolution: ~  dpi
Bleed: |4.0

Show bleed area

OK

Save the image data and print settings as a set of print data in ARXP file format.
The following will be made available if the print data is converted into an ARXP file:
e Image data and print settings can be put together and stored.
e  Without connection to a PC, the printing can be performed directly from a USB flash memory unit.

<TIPS>

Cancel

. Image editing is unavailable for any ARXP file. As such, save your image data for an editing purpose in advance.

o For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file]

command. Be sure to use the printer driver "Brother GTX pro FileOutput".

. For details of directly sending data to the Printer from an application=-"6-6-2. Sending print data from applications >>P.155".
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(1) Inthe menu bar, select [File] > [Print].

(2) Open the [Color] tab, and make the following settings:

¢ Place a checkmark in the [Document color] checkbox.
[Color conversions]: "Brother GTX pro" or "Brother GTX pro FileOutput"
[Color profile]: [sSRGB IEC61966-2.1]

¢ [Rendering intent]: [Relative colorimetric]
Print X
General Color Composite Layout Prepress 1lIssue
Color: ® Composite
Separations

Settings: ® Document color
Color proof

Color conversions: Brother GTX pro FileQutput

Color profile: sRGB IEC61966-2.1

|| Preserve pure black

Rendering intent: Relative colorimetric

o The color settings and preview available in this dialog box are set for the Windows
Graphic device printer that you selected on the General tab.

7 Print Preview | Print Cancel || Apply

(3) On [General] tab, select [Printer] and select "Brother GTX pro FileOutput" for file output.
<TIPS>
. If the specified [Printer] is set to "Brother GTX pro ", the print data will be sent to the printer.
If the specified [Printer] is set to "Brother GTX pro FileOutput", the print data will be saved as an ARXP file.

(4) On [Preferences], create your settings of printer driver.== "5-4. Set up the printer driver >>P.89".
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(5) When you press [OK] in the [Print] dialog box, the dialog box shown below will be displayed. After that, click [Save].
<TIPS>

. There may be cases where this saving process takes several minutes.

&' Brother GTX pro File Qutput Preview window ] X
Job Name : IMG_1404 7.0
Date : 20/01/2020 19:28 o
Plten Size : 14x16
Select Ink : Color+White Ink
Highlight : 5
Mask : 3
Print Time : x10
Whiteness : 400 %

Use background black color :  Off
Color Multiple Pass Printing : Off

Detai...

8.0 ¥

Color Ink : 0.06 cc B >
' I

White Ink : 0.20 cc 100% | " 600%
Print : 1 piece

Present Layer 1 W+CMYK  ~| [T White Data

Background Color _ Change...

(6) Specify the [Save In] and [File name] first, then click [Save] to save the ARXP file to your PC.

What to do when using the color palette in Useful Tools

(1) Save the color pallet files for CoreDRAW, "GT_Colors.xml" and "GT_Tshirts.xml", on your PC, following the
instructions on screen.

(2) Inthe menu bar, select [Window] > [Color Palettes] > [Open Palette].

(3) Select the files having such filename as "GT_Colors.xml" and "GT_Tshirts.xml", respectively.

<TIPS>

. Do not use any color from the color sample palette, such as HKS and Pantone. Otherwise, an on-screen color may differ from
the resulting print color.

74



Creating print data >

Convert data to bitmap image data

(1) Inthe menu bar, select [Bitmaps] > [Convert To Bitmap].

(2) Setthe [Color mode] to [RGB Color].
<TIPS>
° When the white ink is used for performing the printing, unmark the [Anti-aliasing] checkbox.

Convert To Bitmap X

Resolution: |300 ~ | dpi

Color mode: | RGB Color (24-bit) -

Options
| Anti-aliasing
| Transparent background

Uncompressed file size: 8.33 MB

7 oK Cancel

<TIPS>
. Even when the platen size to be used has been selected from the printer driver, the current setting in [Page Layout] may change

to [Settings from printer].
In the [Page Layout], be sure to change the width and the height according to the size of the platen.
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Replace RGB=255 in bitmap image data with RGB=254

RGB=255 is identified as a transparent color. In a portion where RGB=255 is contained, no ink will be ejected.
In order for the white ink to be printed, select an area for RGB=255, and replace it with RGB=254.
To make such replacement, use the method mentioned below.

(1) Inthe menu bar, select [Effects] > [Adjust] > [Replace Colors].

(2) From the [Old color] pull-down menu, set RGB=255 in [Replace Colors].
Replace Colors X

Old color: - I A

New color

=

Options:

]

RGB -| 3 RGB=255
@ R 255 /
Difference Be
G: 255
_— B: 255
Saturation: #FFFFFF
Lightness:

[ |

Range:

~| Preview R i
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(3) Inthe same manner, set [New color] to RGB=254.

(4) Set[Range]to "1", and click on the [OK] button.

Replace Colors X

0Old color: :l - ﬂ

MNew color: - A

Options: |_| Ignore grayscale
Single destination color

Difference Between Colors

Hue: 0 =

Saturation: 0 N
Lightness: 0

Range: | 1 {

+ | Preview Reset 0K I Cancel

<TIPS>
. For the vector data, change the fill color to RGB=254.
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5-3-2. When using Adobe Photoshop

In Photoshop, configure the settings mentioned below:

Color setting

As required, perform the following procedures:

Create print data (ARXP file)
Use the color palette in Useful Tools.
Replace RGB=255 with RGB=254

<TIPS>

For an image created in the CMYK color mode, select [Image] > [Mode] in the menu bar, and change the color to the RGB color
(sRGB). In order to edit an image, select [Image] > [Adjustments] in the menu bar and edit it, or edit it by means of the image
quality improvement of the printer driver (=="5-4-9. Set up the image quality >>P.103").

For this printer, it is recommended to use Photoshop CC2020/CC2019. The display screen is described assuming Photoshop
CC2020.

Color setting

(1)

In the menu bar, select [Edit] > [Color Settings].

(2) Establish the settings of [Color Settings] as follows:

[Working Spaces]
o [RGB]: [sRGB IEC61966-2.1]
[Conversion Options]
o [Engine]: [Adobe(ACE)]
¢ [Intent]: [Relative Colorimetric]
[Color Management Policies]
e [RGBI: [Convert to Working RGB]
o [CMYK]: [Convert to Working CMYK]
e [Gray]: [Convert to Working Gray]
o [Profile Mismatches]: Mark the [Ask When Opening] and [Ask When Pasting] checkboxes.
¢ [Missing profiles]: Mark the [Ask When Opening] checkbox.

Color Settings X

Desatural

Blend RGB C ing Gamma:

n Opening % Ask When Pasting Blend Te 0 Gamma:

Description
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Create print data (ARXP file)

Save the image data and print settings as a set of print data in ARXP file format.
The following will be made available if the print data is converted into an ARXP file:
o Image data and print settings can be put together and stored.
e  Without connecting to a PC, the printing can be performed directly from a USB flash memory.
<TIPS>
. Image editing is unavailable for any ARXP file. As such, save your image data for an editing purpose in advance.
o For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file]
command. Be sure to use the printer driver "Brother GTX pro FileOutput".
. For details of directly sending data to the Printer from an application=-"6-6-2. Sending print data from applications >>P.155".

(1) Inthe menu bar, select [File] > [Print]. If the PC's default printer is either "Brother GTX pro" or "Brother GTX pro
FileOutput", the layout is set to the platen size.

(2) Make the settings as follows:
e [Color Handling]: [Printer Manages Colors]
¢ [Rendering Intent]: [Relative Colorimetric]

Photoshop Print Settings X

Printer Setup

ng Intent:  Relative Colorimetric

) Description

ion and Size

(3) From [Printer], select "Brother GTX pro FileOutput" for file output.
<TIPS>
. If [Printer] is set to "Brother GTX pro", the print data will be sent to the printer.
If [Printer] is set to "Brother GTX pro FileOutput", the print data will be saved as an ARXP file.

(4) On [Print Settings], make your settings for the printer driver.== "5-4. Set up the printer driver >>P.89".
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(5) When you press [Print], the dialog box shown below will be displayed on the screen. After that, click [Save].

<TIPS>

. There may be cases where this saving process takes several minutes.

& Brother GTX pro File Output Preview window

Job Name : IMG_1404
Date : 20/01/2020 19:28
Plten Size : 14x16
Select Ink : Color+White Ink
Highlight : 5
Mask : 3
Print Time : x10
Whiteness : 400 %
Use background black color:  Off
Color Multiple Pass Printing : Off
Detals...
Color Ink : 0.06 cc
White Ink : 0.20 cc
Print : 1 piece

c‘use

o
-8.0
0
8.0 —¢ 5
' . . . . I
100% | 600%
Present Layer 1 W+CMYK  ~| [T White Data

Background Color _ Change...

(6) Specify the [Save In] and [File name] first, then click [Save] to save the ARXP file to your PC.
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What to do when using the color palette in Useful Tools

(1) Save the color pallet file for Photoshop, "GT_Colors_T.ase", on your PC, following the instructions on screen.

(2) Inthe menu bar, select [Window] > [Swatches].

(3) Click onthe == to open the submenu.

Swatches

(4) From [Replace Swatches], select [Swatch Exchange (*.ASE)] for the type of file and then select the file name
[GT_Colors_T.ase].

<TIPS>

. Do not use any color from the color sample palette, such as HKS and Pantone. Otherwise, an on-screen color may differ from
the resulting print color.
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What to do when replacing RGB=255 with RGB=254

RGB=255 is identified as a transparent color. To a portion where RGB=255 is contained, no ink will be ejected.
In order for the white ink to be printed, select an area for RGB=255, and replace it with RGB=254.
To make such replacement, use the method mentioned below.

(1) On the menu bar, select [Layer] > [New Adjustment Layer] > [Selective Color], and create a new layer.

(2) Setthe opacity to 20%, and click [OK].

New Layer X

Nar Selective Color 1

Use Previous Layer to Create Clipping Mask

Color: E] MNone

Mode: Normal Opacity: 20|

(3) From the [Selective Color], make the following settings:
o [Colors]: [Whites]
e [Black]: 1%
o Mark the [Absolute] option

Properties

<TIPS>
° The method to replace RGB=255 with RGB=254 as shown above can be used only when the [Color mode] is set to [8 bit] of
[RGB Color].

. For Photoshop, the action file "SolidWhite.atn" is made available in Useful Tools, which changes RGB=255 to RGB=254 (=~
"5-5-2. Replace RGB=255 with RGB=254 (for Photoshop only) >>P.106"). For how to use it, refer to the Help feature that
Photoshop is provided with.
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5-3-3. When using Adobe lllustrator

In lllustrator, perform the required procedures mentioned below:
e  Color setting
e  Open a new file
As required, perform the following procedures:
e  Create print data (ARXP file)
e  Use the color palette

<TIPS>

. Take one of the actions mentioned below, in order to avoid such troubles that no image data is inserted into the print range or part
of image data is cut off.

- Before start-up, specify the PC's default printer as the "Brother GTX pro" or the "Brother GTX pro FileOutput".
- Use the "Brother GTX pro FileOutput" printer driver to output a file, then display and check the print preview.

. For an image created in CMYK color mode, load the image into Photoshop, select [Image] > [Mode] in the menu bar, and change
the color to the RGB color (SRGB). In order to edit an image, load the image into the Photoshop, edit it in the form of bitmap data,
or edit it by means of the image quality improvement of printer driver (="5-4-9. Set up the image quality >>P.103").

° For this printer, it is recommended to use lllustrator CC2020/CC2019. The display screen is described assuming lllustrator
CC2020.
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Color setting

(1) In the menu bar, select [Edit] > [Color Settings].
(2) Click on the [More Options].

(3) Ensure selection of the settings as mentioned below, and click [OK].
o [Settings]: [Custom]
[Working Spaces]
¢ [RGB]: [sRGB IEC61966-2.1]
[Color Management Policies]
o [RGB]: [Convert to Working Space]
e [CMYK]: [Convert to Working Space]
¢ [Profile Mismatches]: Mark the [Ask When Opening] and [Ask When Pasting] checkboxes.
¢ [Missing profiles]: Mark the [Ask When Opening] checkbox.
[Conversion Options]
o [Engine]: [Adobe(ACE)]
¢ [Intent]: [Relative Colorimetric]

Color Settings

ons are not synchronized for consistent color. To

Settings: Custom
Working
B: sRGB IEC61966-2.1

(: U.5. Web Coated (SWOP) v2

Color Management Policies
Convert to Working Space
CMYK: Convert to Working Space
Profile Mismatches: B3 Ask When Opening [ Ask When Pasting
Missing Profiles: B Ask When Opening

Conversion Options
Engine: Adobe (ACE)
Intent: Relative Colorimetric

Use Black Point Compensation

onal information.

Less Options
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Open a new file

(1) Setup a new document as follows:
e [Width]: 14.0 in. (355.6 mm)
¢ [Height]: 16.0 in. (406.4 mm)
e [Orientation]: Portrait
¢ [Color Mode]: [RGB]

<TIPS>
. Set the width and height to the size of platen to be used. (=5-4-1. For other applications: Selection of platen size >>P.127)

The above size is the standard 14X16 platen size.

More Settings

Untitled-1
[Custom]

.:I-:l

7 [Custom]

Width: 355.6 mm Units: Millimeters

Height: 406.4 mm Orientation: m [l

Left Right

S 0mm = 0mm Z 0mm ~ 0mm
w Advanced
Color Mode: | RGB
Raster Effects:  High (300 ppi)

Preview Mode: Default

Templates... Create Document
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Create print data (ARXP file)

Save the image data and print settings as a set of print data in ARXP file format.
The following will be made available if the print data is converted into an ARXP file:
o Image data and print settings can be put together and stored.
e  Without connecting to a PC, the printing can be performed directly from a USB flash memory.
<TIPS>
. Image editing is unavailable for any ARXP file. As such, save your image data for an editing purpose in advance.
o For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file]
command. Be sure to use the printer driver "Brother GTX pro FileOutput".
. For details of directly sending data to the Printer from an application=-"6-6-2. Sending print data from applications >>P.155".

(1) Inthe menu bar, select [File] > [Print] > [Color Management].

(2) Make the settings as follows:
o [Document Profile]: [sSRGB IEC61966-2.1]
e [Color Handling]: [Let lllustrator determine colors]
o [Printer Profile]: [sSRGB IEC61966-2.1]
¢ [Rendering Intent]: [Relative Colorimetric]

Print

Print Preset: Custom

Printer: Brother GTX pro FileQutput

el Color Management
Marks and Bleed

Output

Graphics

Fr e errreTet Handling: Let Illustrator determine colors

Printer Profile: sRGB IEC61966-2.1

Rendering Intent: | Relative Colorimetric
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From [Printer], select "Brother GTX pro FileOutput" for file output.
<TIPS>

. If [Printer] is set to "Brother GTX pro ", the print data will be sent to the printer.
If [Printer] is set to "Brother GTX pro FileOutput", the print data will be saved as an ARXP file.

On the [Advanced], make your settings for the printer driver.s= "5-4. Set up the printer driver >>P.89".

<CAUTION>

° For Adobe lllustrator, set the platen size for the paper size in the Print dialog box in the application. The size or placement of
the image may not be set correctly if you make settings in the Print Settings dialog.

When you press [Print], the dialog box shown below will be displayed on the screen. After that, click [Save].

<TIPS>

. There may be cases where this saving process takes several minutes.

P’ Brother GTX pro File Output Preview window ] X
Job Name : IMG_1404 o i
Date : 20/01/2020 19:28 i Ll
Phten Size : 14x16
Select Ink = Color+White Ink
Highlight : 5
Mask : 3 -
Print Time : x10
Whiteness : 400 %

Use background black color :  Off
Color Multiple Pass Printing : off

Detalks...

8.0 i

Color Ink : 0.06 cc & < >
' . ' . ' '

White Ink : 0.20 cc 100% %‘ - - - - - 600%
Prnt : 1 piece

Present Layer 1 W+CMYK | [T White Data

Background Color _ Change...

(6) Specify the [Save In] and [File name] first, then click [Save] to save the ARXP file to your PC.
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Using Useful Tools

(1) Save the color pallet file for lllustrator, "GT_Colors_T.ase", on your PC, following the instructions on screen.

(2) Inthe menu bar, select [Window] > [Swatches].

(3) Click on the==, and select [Open Swatch Library] from the submenu.

(4) Select [Other Library].

Swatches

(5) On the [Open] screen, select the file having such filename as "GT_Colors_T.ase".
<TIPS>
. Unlike the Photoshop or CorelDRAVW, this Swatch needs to be selected each time a file is opened.
However, you can fix the Swatch library in the following method to display the screen automatically whenever you start the
application if you are using lllustrator CC.
Click == on the top right corner of the Swatch library and select [Fix] from the submenu.

GT_Colors T

Add to Swatches

Sort by Name
Sort by Kind
Show Find Field

Small Thumbnail View
Medium Thumbnail View
Large Thumbnail View
Smiall List View
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5-4. Set up the printer driver

<TIPS>

1)

Creating print data >

The GTX pro printer driver treats RGB=(255) as "Transparent color" and does not eject the ink. For such an image that you wish
to print out in pure white color with white ink, make such a setting as RGB=(254).

For the color replacement method, refer to a relevant page or help menu of each application software .="5-3. Using other

applications >>P.70".

By following the printing procedures of each application software, open the print setup dialog box of the printer

driver.

@ Printing Preferences

Paper/Qualty Main Setting

Platen Size : 14x16
Select Ink : Color+White Ink
Mode : ® Normal
White Ink Settings : 1 3 5 7
Highight - 0
1 2 3

Mask : I

[ Fast White Print Mode
[]2 Layer White 0 10 20 30
tery .c.|
[ WhiteColor Pause [ 10 20 30
nterval [zec. |
D Use background black color for black T-shirts only)
[ Color Multiple Pass Printing

\Advanced :
[Chck to open advanced menu,

e Advanced '

(O Eco-Mode

Print Time - | 1 Mﬂeness:lg,mg;

Cancel
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(2) Inthe dialog box for setting the printer driver, configure required settings.
If you click on the [Advanced], [White Ink Settings], [Color Processing], [Color Balance] and [Uni-Directional Printing] can be
configured.
<TIPS>
° Depending on the settings you have made in the [Select Ink:] option or the like, setup items that appear on the screen vary.
e  The rollover help is displayed in the square portion at the bottom of dialog box. Place the mouse pointer over it to browse
the help feature.
. For the detailed description of setup items, refer to each chapter mentioned below.

Brother GTX pro Advanced menu X
White Ink Settings
[Jtransparent Color : Ml green (0,199,0) Custom. ..

Minimum Whiteness : (® Normal (O special

-
~

0123 45678910

|l

Choke Width £ I
Color Processing

0 10 20 30 40
Saturation : l | 5
Brightness : I | 5
Contrast : I | 5
Color Balance

54 3-2-101234°§5
Cyan: I I 0
Magents : l | 0
Yellow : l | 0
Black : I | 0
[CJuni-Directional Printing

tom :
put RGB values for transparent color. Only one Custom Color is available.

——

(3) After your settings are completed, click [OK].
<TIPS>
. You can refer to each value you have set up here by opening an ARXP file from the "GTX pro File Viewer".
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5-4-1. Select the platen size

From the pull-down menu of [Platen Size:], select a platen size for print area.
<TIPS>
° The platen size is equivalent to the paper size.

Setup item Platen to be used Size
[16X21] 16X21 platen 16.0in. x21.0in. (406.4 mm x 533.4 mm)
[16X18] 16X18 platen 16.0in. x 18.0in. (406.4 mm x 457.2 mm)
[14X16] 14X16 platen 14.0in. x 16.0in. (355.6 mm x 406.4 mm)
[10X12] 10X12 platen 10.0in. x 12.0in. (254.0 mm x 304.8 mm)
[7X8] 7X8 platen 7.0in.x 8.0 in. (177.8 mm x 203.2 mm)
@ Printing Preferences x

Paper/Qualty Main Setting

Platen Size : Advanced
Select Ink
Mode :
White Ink Settings 1 3 5 - 9 13
Highiight : [ | 5
1 2 3 4 5

Mask | 3
Print Time - | 4 Weneus:l‘;m-;a.

[ Fast White Print Mode

]2 Layer White 0 0 20 W 40 S0 B0

[] WhiteColor Pause 0 10 20 30 0 a0 B0

[(] Use background black color for black T-shirts only)

[ Color Multiple Pass Printing Default

Platen Size :
\Select the size of the platen used for print.

16x21 (406.4¢533 4mm)
1618 (406.4¢457 2mm)
14x16 (355.6x406.4mm) “standard
10x12 (254.0x304.8mm)
(78 (177.8x203.2mm)

==

91



5-4-2. Select the ink type

Creating print data

>

From the [Select Ink:] option, select a combination of inks to be used.

Setup item

Description

[Color+White Ink]

This option enables a color image to be printed out on the mask layer of white ink.

[White Ink Only]

This option enables the white ink only to be used for printing out a monochrome image.

[Color Ink Only]

pale color background.

This option enables a color image to be printed out on a white background or lighter and

[Black Ink Only]

This option enables the black ink only to be used for printing out monochrome image.

@ Printing Preferences

Paper/Quality Main Setting

Platen Size : 14x16 v
St -
Color+White Ink
White Ink Only
Mode : Color Ink Only -
| Black Ink On
White Ink Settings :
Highlight :
Mask
[] Fast White Print Mode
[ 2 Layer White [ 3 4 :
nterval [sec
[ Whie/Color Pause | 2 3 4 5

terval [sec.

[] Use background black color for black T-shits only)
[[] Color Multiple Pass Printing

Select Ink :
Selects ink combination.

Color+White Ink : Prints color images on White ink mask.

White: Ink Only : Prints monochrome images with only white ink.

Color Ink Only : Prints only color images on white or light color materials.
Black Ink Only : Prints monochrome images with only black ink.

Cancel

X
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5-4-3. Select the mode

Creating print data

>

If you set [Mode:] to [Eco-Mode], the white ink volume serving as the background is automatically adjusted to reduce the

overall ink consumption.
<TIPS>

The luminance on the finished print may be slightly reduced depending on the color.

i Printing Preferences

Paper/Qualty Main Setting

Platen Size : 1416 v Advanced
Select Ink - Color+Whte Ink v

Mode - O Nommal @® Eco-Mode

Whie Ik Setings: 1 3 5 7 g IRE

Highiight - [ | | 5
Mask : | | 3
Fri'ltTlme:l x1 %Iemu:ld_m};

[ Fast White Print Mode
Dzw"m’- ] 10 20 30 10 1] [=1]
[] White/Color Pause 0 10 20 30 10 50 60

|
nterval [zec.) | 2U
Defaukt

[[] Use background black color for black T-shirts only)
[ Color Muttiple Pass Printing

[Mode :

\Adjust the amount of the base layer white ink automatically to reduce ink consumption
pverall.

|However, the level of brghiness of the end result may be decreased slightly depending on
the color.

[ok [ cance
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5-4-4. Set up the white ink

Creating print data

>

If you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:], the setup items for [White Ink Settings:] will

appear.

Adjust the white ink volume separately in the [Highlight:] (visible white ink volume) and in the [Mask:] (white ink volume to

cover the background color).

Also, set the white ink time in the [Fast White Print Mode], [2 Layer White], and [White/Color Pause].

i Printing Preferences

Paper/Qualty Main Setting

Platen Size : 14x16 v Advanced
Select Ink Color+White Ink ~
Mode : (®) Normal (O Eco-Mode

Fri'ﬂ'ﬁrne:l x1 Whleneu:l_mo-,;

[[] Fast White Print Mode
[]2 Layer White

[ White/Color Pause
nterval [zec.

|| Use background black color for black T-shirts only)
[ Color Multiple Pass Printing Defauk
\White Ink Settings :

[You can set "Highlight” and "Mask ™ when "Color+White Ink™ or "White Ink Only"is
selected.

X

[ok ]| cancel
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Highlight
This enables you to select whiteness (thickness) of RGB=254 in such nine levels as [1] to [13]. When you increase this
value, the White ink volume will increase. You can specify [10] to [13] only if [2 Layer White] is enabled.

Highlight setpoints Ink volume

1] White ink volume 200%
[2] White ink volume 250%
[3] White ink volume 300%
[4] White ink volume 350%
[8] White ink volume 400%
[6] White ink volume 450%
[7] White ink volume 500%
[8] White ink volume 550%
9] White ink volume 600%
[10] White ink volume 650%
[11] White ink volume 700%
[12] White ink volume 750%
[13] White ink volume 800%
<TIPS>

. Appropriate highlight setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an
appropriate highlight setting value before creating print data. Perform a highlight check pattern print and select an appropriate
setting value.="5-5-6. Print out of highlight check pattern/mask check pattern >>P.110".

. Depending on the settings of [Highlight:] and [Color Multiple Pass Printing], the [Print Time:] and [Whiteness:] will change
accordingly.

. [Print Time:] will be set to [X1] if the setup value of [Highlight:] is [5] and [Color Multiple Pass Printing] is turned OFF. With this [X1]
serving as a reference value, how many times relates to how long the print time will take when printing.

. Actual ink consumption depends on the actual colors used in the original image. As such, use this number as a reference for ink
consumption.

Mask

This enables you to select the volume of white ink which is used as background color for color inks in such five levels as
[1]to [5].

Setup value Description

[1]or[2] These setup values are suitable for such lighter and pale background colors as pale pink,
ash and cream.

[3] This is the default value.
This value will reproduce the most smooth white-gray-black gradation.

[4] This value is suitable for vivid background color, e.g. red, purple, green, etc. It also covers
the strong background colors.

[9] This value enables the printing with the largest amount of white ink under all colors except
darker color areas.

<TIPS>

. Perform a mask check pattern print and select an appropriate setting value. ="5-5-6. Print out of highlight check pattern/mask

check pattern >>P.110"
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Fast White Print Mode

This option allows high speed printing in the white ink use mode. This does not change the ink amount or concentration.
Turn it off if remarkable horizontal stripes are seen.

<TIPS>

. This setting menu will be enabled only if you have selected [Color+White Ink] in the [Select Ink:] settings.

o Selecting [White Ink Only] from [Select Ink:] forcibly switches the printer to the high speed mode.

2 Layer White

You can make highlight settings at a level of [1] to [13] when 2 Layer White is enabled.

Set the time from the start of printing the first white ink layer to the start of printing the second white ink layer.

If you set a time shorter than the time it takes to print the first layer, the additional waiting time will be set to 0 seconds.
<TIPS>

. This setting menu will be enabled only if you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:] settings.

White / Color Pause

Set the time from the start of printing the previous white ink layer to the start of printing the color ink layer.

If you set a time shorter than the time it takes to print the previous white ink layer, the additional waiting time will be set to

0 seconds.

<TIPS>

. This setting menu will be enabled only if you have selected [Color+White Ink] in the [Select Ink:] settings.

. Check this checkbox to activate it when you print a tiny image.

. Tiny images may become black when printed. When that occurs, print a white layer first and wait for a while (waiting time), to
print the color layers.
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5-4-5. Specify whether or not to use the background black color

Creating print data

>

If you have selected [Color+White Ink] in the [Select Ink:], the setup items of [Use background black color (for black

T-shirts only)] will appear.

In the event that you wish to print a black T-shirt making use of the T-shirt's background black color, mark the [Use
background black color (for black T-shirts only)] checkbox.

) Printing Preferences

Paper/Qualty Main Setiing

Platen Size 1416 s Advanced
Select Ink : Color+White Ink ~

Mode O Nomal (®) Eco-Mode

White Ink Settings : 1 3 5 7 9

Highiight : [ | | 5
Mask : | | 3
Prht'ﬂme:[ x1 Mumu:l;,mg

[T Fast White Print Mode
Dz Layer White ] 10 20 30 40 1] B0
[ White/Color Pause [ 10 20 30 40 50 5]

Default

Use background black color :

[Tum ON this item when printing an image on black material with its black color used.
|Black (RGB = 0} is automatically transparent.

[Tum OFF this item when you select some transparent color in advanced menu.

[k ]| cancel
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5-4-6. Specify whether or not to perform Multiple Pass Printing

If you have selected one of the [Color+White Ink], [Color Ink Only] or [Black Ink Only] in the [Select Ink:], the setup items

for [Color Multiple Pass Printing] will appear.

In cases where small and horizontal stripes are highly noticeable in the print result, mark the [Color Multiple Pass

Printing] checkbox.

<TIPS>

o Even if the [Color Multiple Pass Printing] checkbox is marked, the amount of inks to be consumed will remain unchanged.

. When the [Color Multiple Pass Printing] checkbox is marked, it takes a longer time for the print time to be completed. For typical
print time, refer to [Print Time:].

= Printing Preferences hod

Paper/Qualty Main Setting

Platen Size : 14x16 v Advanced
Select Ink Color+White Ink ~
Mode : O Nomal (®) Eco-Mode
White Ink Settings : i 3 5 7 9 17
Highlight - l 5
1 2 3 4 5
Mask - | 3
Print Time - | L2 Whiteness : | 400 %

[[] Fast White Print Mode
]2 Layer White 0 10 20 30 0 50 ED

P | 20
[JWhie/ColorPause 0 10 20 30 40 50 60

nterval [zec. | | 1}
- e DU R CTERUIPMC] DSl o]
[ Color Multiple Pass Printing

Color Multiple Pass Printing :
Color Muttiple Pass printing, for color print data, increases the number of platen line feeds to
produce finerink dots. |t takes longerto print but enables better color printing.

‘or black T-shirts only)
Default

==
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5-4-7. Set up the color ink

Creating print data

>

If you have selected [Color Ink Only] or [Black Ink Only] in the [Select Ink:], the setup items of [Color Ink Settings:] will

appear.

In the [Color Ink Settings:] window, you can make your setting from the [Ink Volume:] or [Double Printing:] option.

Ink volume

@ Printing Preferences

Paper/Qualty Main Setting

Platen Size : 1416 v Advanced
Select Ink Color Ink Only ~
Mode : Normal Eco-Mode

Color Ink Settings :

Ink Volume: :

Double Printing :

[C]Color Multiple Pass Printing Default

Color Ink Settings :
Enables you to set "Ink Volume™ and " Double Printing™ when "Color Ink Only” or "Black Ink
Only™ is selected.

Cancel

X

This enables you to select the ink volume in such ten levels as [1] to [10].

Setup value Description

[10] This is the default value.
This value corresponds to 100%-cotton fabrics as well as for blended yarn fabrics (hemp
50%/polyester 50% or cotton 50%/polyester 50%).

[91to [7] These values correspond to a thinner T-shirt, thick towel, and cotton products woven with
twill fabrics.

[6] to [4] These values correspond to thin and plain fabrics as well as for blended yarn fabrics that
consist of cotton, polyester and polyurethane.

[38]to[1] These values correspond to polyester jerseys and synthetic fabrics that have no water
absorbency.

<TIPS>

. When you print other clothes than a thick T-shirt, check on the actual blurring first, then adjust a value in the [Ink Volume:] option.
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Double Printing

Performing the print cycle two times separately will make the printed color stand out more.

Setup value Description
[0] No separate processes
[1] Separate processes (wait time between the 1st and 2nd print cycle)
[2] Separate processes (longer wait time than the case with setting [1] between the 1st and
2nd print cycle)
[3] Separate processes (longer wait time than the case with setting [2] between the 1st and
2nd print cycle)

<TIPS>
° For the options [1] to [3], the platen will reciprocate two times.
o The higher the setpoint is, the longer the print time will be.

5-4-8. Set up the white ink

If you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:], this setting menu will be enabled.
When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [White Ink Settings]
appear.

In the [White Ink Settings], you can make settings for [Transparent Color:], [Tolerance:], [Minimum Whiteness :],and
[Choke Width:].

Brother GTX pro Advanced menu X

White nk Settings
[ Transparent Color : Bl green (0,199,0)

Minimum Whiteness : (®) Normal
1

0 123 45678689 W

szl

Choke Width :
Color Processing
0 10 20 30 40
Saturation : I I 5
Brightnass : I | 5
Contrast : l | 5
Color Balance

-5 4 3-2-10 12 3 45

Cyan : l IT
T— i KB
- i [
Black : ] [0

[C] uni-Directional Printing

Transparent Color ;

Selecting a color to make it transparent, RGE=255 white |5 always transparent, Tuming this feature
0N allows you to select another color in the image and make it transparant, you can input RGB
wvalues for custom transparent color. It is recommended that the [Use background black color]

function is turned OFF to produce better colors.
o1 o
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Transparent color

With this option, specify a color which is treated as a transparent color without using any color during the printing
process. If you want to specify other colors excluding the RGB=255 as "Transparent color", perform the following
procedures to make your setting.

<TIPS>

o The RGB=255 is treated as a "Transparent color" (non-printing color).

. You would be better off making [Use background black color (for black T-shirts only)] OFF to produce better colors.

(1) Click the [Transparent Color:] checkbox.
Then, the pull-down menu for color selection becomes active.

(2) In the pull-down menu, select a color which serves as a background color of T-shirt, or click on the [Custom...] to

specify a RGB value.
<TIPS>

3 This custom color you have specified is valid only for one color which is specified immediately before. This color cannot be
saved in the list.

Brother GTX pro Advanced menu X ‘ Color X
m Ink Settings . = . & Silors:
T anwen o 0 550 =
daalitiaces " i 8 0000
P =Hue (0,108,255) |’T FrAENNENEN
L R FEEEEE
es5 ot
7 yellow (255,255,0) FEEEEEN
= gold (255, 174,0)
I o ange (255, 108,0) - =- EEEEEN
I req (255,0,0) EEENERETE
i I pink (255,0,150)
Choke Widh B eep red (255,0, 102) : ks ok
_ W rraroon (109,0,62)
Er e [0 pale orange (255,221, 154) ...
[0 sand (204,196, 171)
Saturation : (] light areen (96,255,0) 5 I_ l_ I_ I_ I_ I_ I_ I_
I |celly green (0,154,70)
Brightness : W Giive (117,115,51) = Define Custom Colors >>
N [ lime (213,255,44) l_
Contrast : 5
b B acuamarine (0,126,82) Cancel
N spruce (0,98,110)
= [ aquatic biue (36,213,255)
I steel blue (117,145,174)
Cyan: B (avender (174,111,255) 0
Tereree I light: brown (180,148, 120) 4 IT
Yellow : l 0
Black : | 0
[[J uni-Directional Printing
[Transparent Color ;
Selecting a color to make it transparent, RGB=255 white |5 always transparent, Turning this feature
ON allows you to select another color in the image and make it transparent, you can input RGB
wvalues for custom transparent color. Itis recommended that the [Use background black color]
function is turned OFF to produce better colors.
o1 oo

Tolerance

Specify the gradation range (RGB values) to smoothly connect the zone between "Unprinted color" and "Printed color"
to be gradually changed in tone.

<TIPS>
o If this value is increased, the gradation range in which the mask white is generated from a state in which no mask white exists will
increase.

. The gradation's image quality depends on image data. For this reason, it is advisable to perform a test printing beforehand.
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Minimum white ink volume

When printing with [Color+White Ink], the volume of background white color ink for dark or black color ink can be
controlled.

When printing with [Color+White Ink], you can increase the amount of the white ink volume used as the base in a dark
area by specifying a larger value.

Selecting [Special] allows you to select a value of [3] or higher.

<TIPS>

. Larger the value, the more likely that blurring occurs.

White Ink Choke Width

This enables you to select the white ink choke width in such ten levels as [1] to [10]. When you increase this value, the

choke width increases. By decreasing the print range of white ink, the white ink will be prevented from extending off from

under the color inks.

<TIPS>

. Check the original image if white lines and/or dots are seen around the image, this may be caused by "Anti-alias" bitmap.

. There are instances in which fine lines (characters or photographs) will disappear if this level is increased. For this reason, it is
advisable to perform a test printing beforehand.
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5-4-9. Set up the image quality

>

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Processing] appear.

In the [Color Processing] option, you can make settings for [Saturation:], [Brightness:] and [Contrast:].
Make adjustments to increase vividness, brightness and clarity of an image without using any functions of application

software.
Setup item Description
[Saturation:] The more vivid the color is, the higher its value.
[Brightness:] The brighter the color is, the higher its value.
[Contrast:] Contrast makes the image lighter for lighter colors and darker for darker colors if its value
increases.
<TIPS>

o If a value of [Contrast:] is increased, there may be some cases in which fine lines will disappear.

. For this reason, it is advisable to perform a test printing beforehand when you specify a higher value.

Brother GTX pro Advanced menu x
‘White Ink Settings
[] Transparent Color : B gresn (0,199,0) Custom. ..

Minimum Whiteness : (®) Normal

*
3 |

0123 456768 9% W0

=
I e
=

Choke Width : I

Color Processing
Saturation : I 5
Brightnass : | 5
Contrast : | 5

Color Balance

-5 4 -3-2-1012 3 4 5
Cyan : l | 0
Magenta : l I 0
Yellow : [ | | 0
Black : [ | | 0
[C] uni-Directional Printing
Saturation !

Saturation increases the color brightness, Use for grayish and colorless images, artwork created in
CMYK color mode, scanned data, ete.

I
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5-4-10. Set up the color balance

>

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Balance] appear.
In the [Color Balance], you can make settings for [Cyan:], [Magenta:], [Yellow:], and [Black:].

You can adjust the color in 11 gradations, -5 to +5.

<TIPS>

o If you select [Black Ink Only] for ink selection, you can adjust [Black:] only.

Setup item Description

[Cyan] Adjust the cyan ink volume.
If you increase its value, the color becomes light bluish overall. If you decrease its value,
the color becomes reddish overall.

[Magenta:] Adjust the magenta ink volume.
If you increase its value, the color becomes reddish-purple overall. If you decrease its
value, the color becomes greenish overall.

[Yellow:] Adjust the yellow ink volume.
If you increase its value, the color becomes yellowish overall. If you decrease its value,
the color becomes bluish overall.

[Black:] Adjust the black ink volume.
If you increase its value, the color becomes blackish overall. If you decrease its value, the
color becomes whitish overall.

Brother GTX pro Advanced menu X
‘White Ink Settings
[] Transparent Color : B gresn (0,199,0) Custom...
] 10 20 30 10 50

Minimum Whiteness : (®) Normal
1

0123 456769% W

Q
i

B N L

(]

Choke Width : I
Color Processing
0 10 20 30 0
Saturation : I I 5
Brightnass : l | 5
Contrast : l | 5

|T
=
=
=

[C] uni-Directional Printing

Cyan :

Adjust the cyan ink volume,

If you increase its value, the color becomes light bluish overall,
If you decrease its value, the color becomes reddish overall,

I
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5-4-11.

Specify the print direction

Creating print data

>

When you click on the [Advanced] in the [Printing Preferences] dialog box, you can make the settings for [Uni-Directional

Printing].

<TIPS>

. What you have specified on the printer's operation panel are prioritized, and this option becomes active only when the print

direction specified on the printer side is set to [Auto].

. Print time will be doubled.

Brother GTX pro Advanced menu

White Ink Settngs
[ Transparent Color : B green (0,199,0) Custom...
] 10 21 3 50
ara I
Minimum Whiteness (®) Normal (O spedal
1 7
I | 1
01 23 45 6 7 8 % 10
Choke Width : I 2
Color Processing
0 10 20 30 0
Saturation : l I 5
Brightnass : l | 5
Contrast : l | 5
Color Balance
-5 4 -3-2-1012 3 4 5
Cyan : I | 0
Magenta : I I 0
Yellow : . I 0
Black : [ | | 0
Uni-Directional Printing :
Makes the print uni-directional.

The value of Print Direction set by the Panel has priority. This is avaiable only if [Auto] is selected
in Print Direction through the Control Panel.

l 0K | Cancel
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5-5. Using Useful Tools

Useful tools and print data are provided for adjusting colors or searching for an appropriate print setting.
The "Useful Tools" will be installed onto the subdirectory under the "Brother GTX pro Tools" of your PC.
For the details of each tool, please refer to the chapters described later.

5-5-1. Use the color palette

The different color palettes are available for each software application as follows:
e  Adobe Photoshopl/lllustrator: “GT_Colors_T.ase”
e  CorelDRAW: “GT_Colors.xml" and "GT_Tshirts.xml"
For more information, refer to a relevant page or help menu of each application software (="5-3. Using other
applications >>P.70").
<TIPS>
. When using the printer driver by default, use one of them as a color sample to check color reproduction and create/edit the
image data. (Because CorelDRAW cannot contain identical color in the same palette, the color palette is divided into two files.)

5-5-2. Replace RGB=255 with RGB=254 (for Photoshop only)

For Photoshop, use this to change RGB=255 to RGB=254.
(1) From the "Useful Tools", click "SolidWhite.atn", and follow the on-screen instructions to save the file on your PC.
(2) Inthe menu bar of Photoshop, select [Window] > [Action file].

(3) Click onthe == to open the submenu.

(4) From the [Load Actions], select "SolidWhite.atn" saved on your PC.
<TIPS>
. For information on using action files, refer to the Help feature that Photoshop is provided with.
° "SolidWhite.atn" can be used only when the [Color mode] is set to [8 bit] of [RGB Color].
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5-5-3. Check the color sample

Use when checking the color sample.

Please use this color chart as a color sample like the one that is commonly provided by an ink maker, for the print data
(ARXP file) you created using your desired printer driver setting.

<TIPS>

. Make use of this color chart when you perform the printing after changing the settings of the printer driver.

RECHEE
Uthead

“waita

RMGHEY  RWGEE  RHGNED RSOEEM RMGEEM RECEEW AR ARG
o Wi Do ok G Tt Vw st

e

RECEES RS GHE RYCMEN MECBEE RWNOMEN AMGES RGN B REGHES | RBAIEN
= s PR tmpat oyl 4 & Bt

Brother GT Garment Printer T-shirt Transparent Colors

(1) From the "Useful Tools", click a required file name to download the data. The following files are provided as color

samples.
e  GT_Blues.pdf
e  GT_Greens.pdf
e  GT_Oranges.pdf
e  GT_Reds.pdf
e  GT_ColorChart.pdf

(2) Configure the printer driver and create print data.
<TIPS>
. For details of the printer driver's setting procedures, refer to "5-4. Set up the printer driver >>P.89".
. For information on creating print data, refer to "5-3. Using other applications >>P.70".

(3) Send the created print data to the printer and perform printing.= "6. Basic printing procedures >>P.113".
<TIPS>
. Check the print result and adjust the printer driver's settings.
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5-5-4. Print a grid pattern on the platen sheet

You can print a grid pattern onto a new platen sheet.

Platen sheet Grid

AN /

/

Platen
X0163

(1) From the "Useful Tools", open such an ARXP file (for example, Grid14x16.arxp) that has a grid size suitable to the
platen size.
(2) Send the print data of grid pattern to the printer.

(3) Without putting a T-shirt in place, print the grid pattern directly onto the platen sheet.
<TIPS>
. Atter the printing is completed, press down the printed surface lightly with a dry cloth or a sheet of paper to dry the ink.
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5-5-5. Adjust the ink volume

Set an optimum setting for [Ink Volume:] of the printer driver.

Download the data from "Useful Tools" and perform printing to check the blurring beforehand (="6. Basic printing

procedures >>P.113").

<TIPS>

. Appropriate ink volume setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an
appropriate ink volume setting value before creating print data.

. There are four types of ink volume printing data. Select the ink volume print data to match the [Double Printing:] setting for the
printer driver.

(1) Select the desired file from "Ink Volume SinglePrint.arxp”, "Ink Volume DoublePrint1.arxp", "Ink Volume
DoublePrint2.arxp", and "Ink Volume DoublePrint3.arxp" from the "Useful Tools" to download data.
(2) Send the data to the printer and perform printing.

(3) Check the print result and adjust the value for [Ink Volume:] of the printer driver.

& C:\Program Files (x26)\BrotheA\GTX pro Tools\Usefulink Volume SinglePrint.angp - m} X
Job Name : Ink Volume SinglePrint e T U =
o ~
e (110100100,
AR S P -

Platen Size : 14x16
Select Ink - Color Ink Only

Color Ink Volume : 10 0

Double Printing : 1

Color Multiple Pass Printing : off

Detai...
v
Color Ink : 041 cc 80 = >
Print : 1 piece 100% [I 600%

Send to Printer

Browse... Close
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5-5-6. Print out of highlight check pattern/mask check pattern

This is one of the print data files for selecting the ideal setting for [Highlight:] of the printer driver.

Download the data from "Useful Tools" and print the highlight check pattern for checking whiteness, background hiding

level, and blurring beforehand.

<TIPS>

° Please print on a pretreated T-shirt. ="6. Basic printing procedures >>P.113".

e  Appropriate highlight setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an
appropriate highlight setting value before creating print data.

(1) From the "Useful Tools", click "Highlight-Mask Check at MW1.zip" or "Highlight-Mask Check at MW2.zip" to

download data.

<TIPS>

. The file you should select differs depending on whether "Minimum Whiteness:" is set to [1] or [2].
° Check the number at the end of the file name before downloading the file.

(2) Unzip the file and the following print data will be displayed.
e  "HighlightCheckPattern"
e "MaskCheckPattern" at each highlight

(3) Print "HighlightCheckPattern" and select the optimum highlight setting.
(4) Print "MaskCheckPattern" for the optimum highlight setting and select the optimum mask setting.
(5) Check the print result and adjust the values for [Highlight:] and [Mask:] of the printer driver.

T C:\GTX pro\HighlightCheckPattern MW1.ang - m] X
Job Name : Highlight Check MW1 e e U e
Date : 09/04/2018 01:05 ' ey o
Piaten Size : 14x16
Select Ink : Color+White Ink

Highlight : 1

Mask : 3 0

Print Time : x1

Whiteness : 200 %
Use background black color :  Off
Color Multiple Pass Printing : off

Detais...
v
8.0

Color Ink : 0.64 cc E
White Ink : 10.66 cc 100% I 600%
Print : 1 piece

Present Layey Total | CJwhite Data

Send to Printer

sackrou B -
Browse... Close
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5-5-7. Check the ejection timing

Creating print data

>

Check whether or not the ejection timing is correct.

(1) From the "Useful Tools", click "FIRING CHK COLOR.arxp" or "FIRING CHK WHITE.arxp" to download data.

(2) Send the data to the printer and perform printing.

(3) Check the print result to make sure the firing timing has been set correctly.

Job Name : FIRING CHK COLOR
Date : 17/09/2015 00:05
Platen Size : 14x16
Select Ink = Color Ink Only
Color Ink Volume : 10
Double Printing : 1

Color Multiple Pass Printing : off

Detaik...
Color Ink : 0.08 cc
Print : 1 piece

Send to Printer

Browse... Close

“F_-’f C:\Program Files (x86)\BrothenGTX pro Tools\Useful\FIRING CHK COLOR.ancp

-7.
8.0

8.0

100% I

L

EEE
1L

5-5-8. Check the platen feed setting

Check whether or not the platen feed adjustment is appropriate.

(1) From the "Useful Tools", click "FEEDING PATTERN(1).arxp" to download data.

(2) Send the data to the printer and perform printing.

(3) Check the print result to make sure the platen-rolling adjustment has been set correctly.

Job Name : FEEDING PATTERN(1)
Date : 13/12/2015 18:52
Platen Size : 14x16
Select Ink = Color Ink Only

Color Ink Volume = 10

Double Printing : 1

Color Multiple Pass Printing : off

Detaik...
Color Ink : 0.09 cc
Print : 1 piece

Send to Printer

Browse... Close

W C\Program Files (x26)\Brothen\GTX pro Tools\Useful\ FEEDING PATTERN(1).anp

7.0
-8.0

8.0

100% I

0

OTX Carvio Adiusting Patiwn

]

7.0

A

600%

X
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5-5-9. Check the print position

Creating print data

>

Check the alignment of the print position on the white side with the print position on the color side.

(1
()
©)

From the "Useful Tools", click "ALIGN CHK.arxp" to download data.

Send the data to the printer and perform printing.

Check the print result to make sure the print position on the white side has been aligned with the print position on

the color side correctly.

19/04/2017 16:31

Color+White Ink

Job Name : ALIGN CHK
Date :
Platen Size : 14x16
Select Ink :

Highlight : |

Mask : 3

Print Time : x1

Whiteness : 200 %
Use background black color = off
Color Multiple Pass Printing : Off

Detais...
Color Ink : 0.00 cc
White Ink : 0.65¢cc
Print : 1 piece

Send to Printer
Browse... Close

W C:AProgram Files (x26)\Brothe\GTX pro Tools\UsefuALIGN CHK.anp

- ]
7.0
8.0
"
0
8.0 B
% < >
100% I 600%

Present Layer 1 W+MYK  ~| [Jwhite Data

Background Color _ Change...
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n Basic printing procedures

AWARNING

If a foreign object gets inside the printer, immediately turn off the power, disconnect the power cord, and
contact the place of purchase or a qualified technician. If you continue to use the printer while there is a
foreign object inside, it may result in fire or electric shocks or problems with correct operation.

Do not allow the printer to come into contact with liquids. Otherwise it may cause fire or electric shocks or

problems with correct operation.
If any liquid gets inside the printer, immediately turn off the power, disconnect the power cord, and contact

the place of purchase or a qualified technician.

Do not use the printer when smoke or a bad odor is coming from the printer. Otherwise it may cause fire or
electric shocks or problems with correct operation. Immediately turn off the power, disconnect the power
cord, and contact the place of purchase or a qualified technician.

Keep your finger or any body part away from the rotating fan. Otherwise it will be caught up, which results in

> PP e e

injuries.
Turn off the power when you approach the fan.
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ACAUTION

Q0 QP e pPo

This printer should only be used by operators who are appropriately trained in its safe operation.

Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand
may get caught between the platen and an object, which may result in injury.

Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and
the covers, it may be injured.

Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may
touch against moving parts and this may result in injury.

Do not disassemble the ink pouch. If the ink gets into your eyes or onto your skin, it may cause inflammation.
In case of contact with eyes, do not rub but immediately rinse the eyes with water.

Do not disassemble the ink cartridge.

Do not drink liquids such as the ink, maintenance solution, cleaning solution, pretreatment, or waste. They
may cause diarrhea or vomiting.

Avoid causing your eyes or skin to make contact with the ink, maintenance solution, cleaning solution,
pretreatment or waste. It may cause inflammation. In case of contact with eyes, do not rub but immediately
rinse the eyes with water.

Keep the liquids out of the reach of children.

When the pretreatment is applied to printed objects (like a T-shirt) with a spray or pretreatment applicator,
sprayed mist is generated. So wear a pair of plastic gloves, a mask and protective glasses (or goggles)
designed to shield against liquid splash, and fully take care of the air ventilation when you are working with it.

When a problem occurs with the operation of the printer, contact the place of purchase or a qualified
technician.

(1) mPorTANT

Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.

Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be
hit and damaged.
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6-1. Basic printing process flow

What are described below are the basic work flows before the start and after the completion of print process.

Tasks to be performed
before starting print
operation

Pretreatment for print
medium

Platen adjustment

Placing print medium
in position

Sending/Loading
Print data

Removing printed
matter
from platen

Fixation of ink

Before starting printing, perform check and preparation tasks on the printer.
Refer to "6-2. Tasks to be performed before starting print operation >>P.116".

To fixate the white ink onto a T-shirt, apply the pretreatment to it beforehand.
If you are not using white ink, you do not need to pretreat print medium.
Refer to "6-3. Pretreating process for print medium >>P.121".

Replace the currently used platen with another one that suits the print medium.
After the platen replacement is completed, adjust the platen's height.
Refer to "6-4. Platen adjustment >>P.134".

Put a print medium on the platen.
Refer to "6-5. Placing print medium in position >>P.148".

Send or load print data to the printer.
Refer to "6-6. Sending/Loading Print Data >>P.151".

Start the print operation.
Refer to "6-7. Executing a printing job >>P.160".

Remove the print medium from the platen.
Refer to "6-9. Removing printed matter from platen >>P.165".

Fixate the ink onto the print medium.
Refer to "6-10. Fixation of ink >>P.166".
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6-2. Tasks to be performed before starting print operation

6-2-1. Confirmation and disposal of waste ink

Check the amount of waste ink in the waste ink tank, and if the tank is filled with the waste ink up to its one-half or higher
level, discard the ink.

(1) Check on the waste ink tank, and discard the waste ink.

In an area under the other end of the waste ink tube (when removed) from the waste ink tank, place a receiving tray or the like so
that the waste ink spilled from the tube will not be discharged onto the floor, etc.
<NOTE>

. Dispose of the waste ink properly as water-based waste fluid in accordance with applicable laws and ordinances.

Waste ink tank

(- C/‘\

~ g X0315
Waste ink tank
7
Waste ink tube
Receiving tray
O
X0316

(2) Return the waste ink tank to its original state, and insert the waste ink tube into the tank.
<IMPORTANT>
. The waste ink tube should be cut diagonally. If the tip of the waste ink tube is immersed in the liquid, it will prevent the
smooth flow of the waste ink, to disable the ink suction operation of the head cleaning function. Otherwise, waste fluid may
flow reversely, causing the waste ink to spill contaminating the floor.
. Avoid placing the waste ink tube horizontally as much as possible, and be sure not to let it bend.
Otherwise the waste ink may have difficulty flowing through the tube.

116



Basic printing procedures >

6-2-2. Confirmation and refilling of cleaning solution

Check to see if the amount of cleaning solution is kept at a proper liquid level in the cleaning liquid tank, and refill the
tank with the solution when its amount is below the proper level.
<TIPS>

. Also, refill the tank with the solution when a warning message appears on the operation panel screen or in the warmning message
window when the cleaning liquid tank is not pulled out.

(1) Pull out the cleaning liquid tank from the side of the printer.

(2) Openits lid and refill it with the cleaning solution up to the "FULL" line.
<IMPORTANT>

. Be sure not to put the cleaning solution into the tank above the "FULL" line.

Cleaning solution

Cleaning liquid tank
X0044

(3) Close the lid and slowly place the cleaning liquid tank into the printer.
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6-2-3. Daily agitation of the white ink

Perform the procedures shown below if a white ink cartridge stirring message is displayed before starting operation.

% Maintenance

Remove the White Ink Cartridge
and shake it

After shaking the White Ink
Press OK

(1) Take out the white ink cartridge from the printer.
<CAUTION>
. The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

( N\

N

A

W12 W34

T

White Ink Cartridge
X0317

(2) Shake the cartridge 100 times side by side to stir the white ink.

<IMPORTANT>

. The white ink cartridge should be held horizontally when shaking it.

. Holding the white ink cartridge upside down or shaking it too roughly could break the ink pouch.

<NOTE>

e  Wear the provided gloves when performing this task.

. When the remaining ink level becomes approximately 5.9 in. (15 cm), shake the cartridge with its cover open and with the
edge of the ink pouch slightly winded, to make the ink easier to stir.

White Ink Cartridge
Ink pouch

Remaining ink volume should
be approx. 5.9 in. (15 cm)
Shake 100 times (for approx. 50 seconds) X0194
(Swing distance should be approx. 2 in. (5 cm).

Increase the swing distance when the

remaining ink level becomes low.)
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(3) Open the lid of the cartridge and place the ink pouch in its correct position.

<IMPORTANT>

e  Always open the cartridge lid and properly rewind the ink pouch. If the pouch is placed without opening the lid, ink can flow
into the wound section of the pouch when stirred, which can cause improper winding of the pouch.

e  When opening the lid, place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge
downward and open the lid.

. When setting the ink pouch, avoid unevenness or wrinkles on the pouch.

. When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.

<NOTE>

. If the remaining ink level is low, hold the sagged part of the ink pouch and close the lid.

Cartridge Lid

X0182
|
]
Lid
/
| =—
X0078
Ink pouch No wrinkles
Not sagged
X0142
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(4) Close the lid, and put the white ink cartridge in position inside the printer.

<IMPORTANT>
. W12 and W34 cartridges should correctly be placed at their original locations. Wrongly placed cartridges could cause the
printer malfunction.

e  When setting the cartridge, do not shake the cartridge with the ink pouch facing down with the aim of facilitating the winding
of the pouch. Doing so will cause wrinkles, and the proper winding of the ink pouch will not be possible.

X0283
(5) Repeat the same process to shake the other white ink cartridge to stir up the ink.

(6) On the operation panel, press @

Then, the white ink refilling will be performed automatically.
The following screen will be displayed without white ink refilling in the case of insufficient agitation.

After performing steps (1) to (5), press ® again.
% Maintenance
Remove the White Ink Cartridge
and shake it
(over 60 seconds)

After shaking the White Ink
Press OK

(7) When you are finished replacing the white ink, press ® in the operation panel to print the nozzle check pattern.

="7-2-1. Print out of the nozzle check pattern (checking on the print heads) >>P.199".

% Maintenance

Perform test print (White/Color)

and check head firing

Press OK
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6-3. Pretreating process for print medium

To fixate the white ink onto the surface of fabric of a T-shirt, apply the pretreatment to it beforehand. If you are not using
white ink, you do not need to pretreat print medium.

Workflow of pretreating process

Step ltem

Detailed description

1 Dilution of pretreatment

Put the pretreatment into a polypropylene container or the like, and dilute it with

pure water.

Application of diluted
pretreatment

By means of a spray or roller, apply the diluted pretreatment onto the print medium.

3 Fixation of pretreatment

Fixate the pretreatment by using the heat press to apply heat and pressure onto

the print medium.

6-3-1. Provisions for pretreatment

Items to be prepared

Two types of application means are available for the pretreatment—roller and spray.
With reference to the table below, make what you need available in advance.

o: What you need
A: Useful items, if any

—: Not required

Items to be prepared

For roller coating

For spray coating

Pretreatment

(@]

o

Pure water

(0]

Pretreatment roller

Handle (handgrip of roller)

Tray

Agent-coating table

Weighing instrument

o|>lojo|o|o

Spray

Heat press

Peel-off sheet

Silicone foam (of open-cell structure)

Adhesive roller

> (> (D> |o

>|D>|D>|o|o|o

° Pretreatment

It is the white liquid that is needed for pretreating process for printing with white ink. If a print medium is not
coated with this agent, no color development of white ink takes place, and the whiteness becomes insufficient.
Also, no color will be produced from the color inks that are applied onto the white ink. In order to apply the

pretreatment onto a T-shirt, use a spray or roller, and use the heat press to fixate it.

<CAUTION>

. Be sure to wear a pair of plastic gloves, a mask and protective glasses during the work operation.

. For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.

http://sds.brother.co.jp/sdsapp/index.html

° Pure water

It refers to distilled water, purified water, etc. which is used to dilute the pretreatment with it.

121


http://sds.brother.co.jp/sdsapp/index.html

Basic printing procedures >

Pretreatment roller (option)
This is used to apply the pretreatment onto a T-shirt. It is advisable to use such a handgrip for the roller that is
resistant to rust formation.

<NOTE>

Separately provide a tray (container for dilution), handle (handgrip for roller), agent-coating table and weighing instrument
for amount of coating.

Spray (commercially available item)

This is used to apply the pretreatment onto a T-shirt. Use a spray (preferably of an electrically-operated type)
that can emit fine spray. As compared with a roller, a spray allows for easy and even coating and reduces
non-uniform coating, while it requires a special space for using it.

In addition to a spray, a pretreatment application device (commercial product) is available that can apply the
pretreatment onto a T-shirt automatically. As required, make them available for use separately.

<CAUTION>

Fully take care of the air ventilation when you work on operation that generates mist such as spray application.

Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash
during the work operation.

For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co.jp/sdsapp/index.html

<IMPORTANT>

If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer.
Otherwise, it may cause failure of print heads.

Heat press

It must deliver the performance through which the print range of the platen can to be covered and 180°C
(356°F) can be kept for 35 seconds or more. At a fixing stage of the pretreatment, be sure to use the heat press,
but not an oven, to smoothen the surface.

Peel-off sheet

When using the heat press, place this sheet on a T-shirt so that neither inks nor pretreatment can be attached to
the press surface of the heat press. As a peel-off sheet, use a silicone-coated paper or a fluororesin sheet.
There is a tendency to bring the print result to an almost matte finish if a silicone-coated paper is used at the ink
fixation stage. There is a tendency to bring the print result to an almost bright finish if a fluororesin sheet is used
at the ink fixation stage.

Silicone foam (of open-cell structure)
It is the foamed mattress which is made of silicone that resists heat. When fixating the inks or pretreatment by

means of the heat press, use this foam to ventilate steam with ease.

Adhesive roller
Use these to remove lint from a T-shirt or debris from its surface.
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e  T-shirt (printing medium)
100%-cotton fabric or polyester blended yarn fabric (cotton 50% or more)

<TIPS>

. Although it is advisable to use a 100% cotton T-shirt, some textiles cannot necessarily guarantee good printing quality even
if they are made of 100% cotton or blended yarn. In particular, for a T-shirt made of new material, perform a printing test on
it beforehand.

. Some textiles may leave noticeable imprints of the pretreatment after it is fixated. In that case, wash them away with water.

. Perform a printing test beforehand. Then, the following phenomena may occur:
- The textiles may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.
- A deep-colored polyester blended yarn fabric dissolves dye, which may cause the white ink to change to a slightly different
color.
- ltis likely that a textile may become yellowish in color after the pretreatment is fixated.
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6-3-2. Dilution of pretreatment

Be sure to use the pretreatment after diluting it with pure water.

<CAUTION>

. Be sure to wear a pair of plastic gloves and protective glasses during the work operation.

. For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co.jp/sdsapp/index.html

Dilution ratio

Use within the ratio range of x3 (Pretreatment:Pure water=1:2) (Volume ratio).

Dilution method

<TIPS>

. The figure below is based on the pretreatment (20 kg (44 Ib)). When using the pretreatment (5 kg (11 Ib)), remove the cap and
pour the agent into the container, and dilute it with pure water, referring to step (4) and the subsequent steps. Dilution ratio is the
same.

(1) Unpack the pretreatment container from the shipping carton by cutting off the perforated paper along the perforated

tear-off line to open the carton.

Pretreatment

X0079

(2) Remove the cap, and place the cap in position.

@ Faucet

Pretreatment
\
Cap

X0080
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(3) Orient the pour spout of faucet in the position as shown in the figure below.

Faucet

Pretreatment

~~

X0081

(4) Lean the entire shipping carton of pretreatment toward a container for dilution to pour the agent into the container,

and dilute it with pure water.

<IMPORTANT>

. Use with the dilution rate of x3 (Pretreatment:Pure water=1:2) (Volume ratio).

. Close the cap of the container for dilution, and shake it sufficiently to provide equal concentration.

Pure water

Pretreatment

Container for dilution

e

X0082
(5) To provide safekeeping for the pretreatment, close the faucet, place the pretreatment with the faucet part facing

upward, and store the entire carton in a safe place.
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6-3-3. Application of pretreatment

>

In order for the pretreated portions to be printed with inks, apply the pretreatment evenly to a wider area than the print
range.
<CAUTION>

Fully take care of the air ventilation when you work on operation that generates mist such as spray application.

Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash
during the work operation.

For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co.jp/sdsapp/index.html

<IMPORTANT>

Some T-shirts may leave distinct imprints of the pretreatment after it is fixated. Wash away any imprint of the pretreatment with
water, if any.

Also, some T-shirts may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.
When performing the printing for the first time, do that after applying the agent to an unnoticeable area on trial.

If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer.
Otherwise, it may cause failure of print heads.

Reference guide for amount of coating of pretreatment

Determine a coating area and amount of coating according to a platen size. When your coating area differs from what
are shown in the table below, calculate the amount of coating based on the area ratio.
<IMPORTANT>

Depending on the type of fabric, the print quality cannot be guaranteed with the amount of coating of pretreatment shown below.
It is therefore necessary to conduct sufficient print tests and adjust the amount of coating.

If the amount of coating of pretreatment is too small, imprints of the pretreatment may become less noticeable after it is fixated,
whereas color reproduction of the white ink and color inks on the white ink will deteriorate.

Meanwhile, if the amount of coating of pretreatment is too large, imprints of the pretreatment may become noticeable, the printed
surface may be cracked or discoloring may occur after washing.

Platen Size Amount of coating of pretreatment
16 x 21 459 (1.6 0z)
16x18 39g(140z2)
14 x 16 309 (1.1 0z)
10x12 16 g (0.6 02)
7x8 89(0.302)
Letter size/Ad-size 159 (0.502)
Pocket size
(3.9in. x 3.9in. (10 cm x 10 cm)) 39(0.102)
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For coating with a spray (commercial product: preferably of an electrically-operated type)

(1) Fill a spray with the diluted pretreatment.
<TIPS>
. Please use a spray (preferably of an electrically-operated type) that can emit fine spray.

Pretreatment

X0083

(2) Puta T-shirt flatly on a flat surface or lean it back against wall, and apply the pretreatment evenly onto it.

<CAUTION>

. Fully take care of the air ventilation when you work on operation that generates mist such as spray application.

. Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash
during the work operation.

. For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co.jp/sdsapp/index.html

<IMPORTANT>

. If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer.

Otherwise, it may cause failure of print heads.

<TIPS>

. Note that pretreatment will not soak into the back (reverse) side of a T-shirt if you put an intermediate plate in the T-shirt.
Remove the intermediate plate from the T-shirt before the pressing stage.

3 When you are still unaccustomed to the spray coating, perform it while measuring the amount of coating by means of a

weighing instrument.

Spray

oy \ T d_

> T | > = >

N

T-shirt X0084
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For coating with a pretreatment roller (option)
(1) Make a polypropylene tray or the like, handle (handgrip for roller), weighing instrument to measure the amount of

coating and agent-coating table ready for use.

<TIPS>

. It is convenient for you to use an agent-coating table that can cover the print area, because it prevents the pretreatment

from soaking into the underside of the area.

Tray Agent-coating table

' Handle (handgrip of roller) Weighing instrument
X0086

(2) Weigh a T-shirt before applying the pretreatment to it, so that you will be able to know how much of the agent you

have applied to it later.

T-shirt

9

Weighing instrument
®)
(@)

(3) Slide a T-shirt onto the agent-coating table, with its printing side facing upward.

<TIPS>
Note that pretreatment agent will not soak into the back (reverse) side of a T-shirt if you put an intermediate plate inside the

X0087

T-shirt when there is not an agent-coating table.

T-shirt Agent-coating table

X0088
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(4) Attach the pretreatment roller to the handle (handgrip of roller).
<TIPS>
. Use a commercially available handle provided with a roller that fits the pretreatment roller's inside diameter of 0.8 in. (21
mm).

Pretreatment roller

Handle (handgrip of roller)
,5)

(5) Pour the diluted pretreatment into the tray, and dip the pretreatment roller in the agent so that it will be dampened

/ Pretreatment

o
s

Tray '

(6) Rub the pretreatment roller well against the scrub board of the tray and squeeze a redundant agent out of it.

0.8in. (21 mm)
X0089

with the agent.

Pretreatment roller

X0090

Pretreatment roller

Tray

X0091
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(7) Move the pretreatment roller on the T-shirt in a longitudinal direction, and apply the agent evenly onto the print

range.

T-shirt —__ | _ Pretreatment roller
X0092

(8) Move the pretreatment roller on the T-shirt in a lateral direction, and apply the agent evenly onto the print range.
<TIPS>

Depending on a difference in the force applied by you to the pretreatment roller, the pretreatment may not be applied evenly
to a T-shirt. Move the pretreatment roller repeatedly on each area to apply the agent evenly onto such area.

When there is any area (gap) that fails to be coated with the pretreatment or any other area that is found to be unevenly
coated, dip the pretreatment roller in the agent again, and apply the agent evenly there.

T-shirt

Pretreatment roller

Uneven coating

X0093

(9) Weigh the T-shirt to check to see if the required amount of pretreatment has been applied to it.
<TIPS>

For the amount of coating of pretreatment=-"6-3-3. Application of pretreatment >>P.126".

If the amount of coating is small, color reproduction of the white ink and color inks on the white ink will deteriorate.
Meanwhile, if the amount of coating is too large, it is likely that a T-shirt may harden, imprints of the pretreatment may
become noticeable or washing fastness may get worse and so on after the pretreatment is fixated.

Weighing instrument

T-shirt

X0094
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Maintenance of pretreatment roller

If you continue using the pretreatment roller under a state in which any fuzziness, yarn waste, dust, etc. remain attached

to its surface, you may not provide a uniform coating.

In such case, use a toothbrush or the like to brush off such fuzziness to remove it from the surface.

<CAUTION>

. Be sure to wear a pair of plastic gloves and protective glasses during the work operation.

. For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http:/sds.brother.co.jp/sdsapp/index.html

<NOTE>

. After the pretreatment roller is used, put it in a plastic bag or the like hermetically to prevent it from drying up, and keep it in a flat

place in an upright position.
Also, when it remains unused for two weeks or longer, wash it well with running water, and let it dry in a shaded area before using
it again.

Toothbrush, etc. Pretreatment roller

D\

X0095
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6-3-4. Fixation of pretreatment

<CAUTION>

. As the operation will generate mist, fully take care of the air ventilation.

. Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash
during the work operation.

o For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co.jp/sdsapp/index.html

<TIPS>

. Because the pretreatment will not work best if it is dried through oven-based drying or air drying, be sure to use the heat press.

As the oven does not bind fuzziness, the agent may be applied unevenly on white print.

. When you put a T-shirt on the heat press, set it so as to flatten the T-shirt's surface, place a peel-off sheet on the entire press
area, and apply pressure.

. Note that any area in which the pretreatment is fixated may cause its effect to deteriorate or could cause the agent to be coated
there unevenly if such area gets wet once.

. Do not touch the treated area with your hand after the pretreatment is fixated.

. After the pretreatment is fixated, do not touch or place the T-shirts on top of each other.

. Avoid leaving the pretreatment as it is in any highly humid areas.

. If the agent is left unchecked for a long time, use the heat press to apply pressure to a T-shirt immediately before the printing in
order to dry it well.

Guidelines on fixation conditions of pretreatment

The undermentioned fixation temperature/time serve as guidelines only, and optimum conditions vary with your heat

press. Be sure to perform the fixation after checking on the temperature and fixation results beforehand.

<TIPS>

. Prior to and during a fixation process, check the heat press's temperature. If the fixation is performed continuously, the heat
press's temperature will decrease, resulting in improper fixation of the pretreatment. In this case, the whiteness cannot be
reproduced because the white ink soaks into the fabric of a T-shirt.

. Such a pressure is required that is adequate enough to flatten the surface. As the fixation conditions differ by heat press, check
the ink fixation result in advance and adjust the pressure.

o If it is not dry enough after pressing for 35 seconds, extend the time while checking the dried condition of the pretreatment.

. The following values should be regarded as guidelines only, for the optimum fixation conditions depend on the amount of coating
of pretreatment.

Temperature Time
180°C (356°F) 35 seconds

132


http://sds.brother.co.jp/sdsapp/index.html

Basic printing procedures >

(1) Place the silicone foam, T-shirt and peel-off sheet in position under the heat press first, and fixate the pretreatment

properly.

<TIPS>

. Water droplets are generated around the heat press to evaporate water content of the pretreatment by the heat of heat
press. Keep your working space clean so that the surface to be coated with the agent will not get wet.

. A peel-off sheet should be used if needed, depending on the heat press you use.

Heat press

Peel-off sheet

Water droplets

Silicone foaM

T-shirt

X0096

(2) Remove the T-shirt from the heat press so that the steamy heat will escape from it.

Heat press

T-shirt

X0097
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6-4. Platen adjustment

Replace the currently used platen with another one that suits the medium to be printed.
<TIPS>

. In cases where such an optionally sized platen as 10X12 platen is used, ascertain that a proper "Platen size" has been selected
in the printer driver's setting menu. ="5-4-1. Select the platen size >>P.91".

° When using the 16X21 platen: ="6-4-3. Using the 16X21 platen >>P.146"

6-4-1. Replacing the currently used platen with another one

(1) On the operation panel, press , and move the platen toward the front of the printer.
-

Platen

X0164

(2) Loosen the platen fixing lever by rotating it one to two turns.
<TIPS>

3 Depending on the height of the platen, the platen fixing lever may strike against the platen, and prevent rotation. In that

case, move the platen fixing lever in the direction (a), draw the edge of the platen fixing lever forward as shown in (b), then
loosen it again.

Platen fixing lever

Platen

Platen fixing lever \ J
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(3) Remove the platen moving it straight upwards by holding both ends of it.

Platen

X0258
(4) Putanother platen to be used in position directly from above.
| ‘ Platen
X0259
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(5) Tighten the platen fixing lever.

136

Platen fixing lever

X0260



Basic printing procedures >

6-4-2. Platen height adjustment

When constantly printing on thick material, the platen height can be lowered by up to 1.2 in. (30 mm) by adjusting the

platen bearing and collars.

<TIPS>

. Please refer to the table below for the platen's height adjustment range (height A, measured from the platen height adjustment
lever; with the standard parts installed).

. Spacers are installed on your printer so that the height can be the reference value. Do not change the number of spacers.

. When using the 16X21 platen, it can be used only at the lowest position. Remove all the collars before mounting the platen. Also
note that the height adjustment range of the 16X21 platen is 0.4 in. (10 mm) at maximum.

. When adjusting the height, put the latch of the platen height adjustment lever into the groove of the platen bearing.

(0 to 10 mm)

0to 0.4 in. ii Collars
=

@\ Collars

0.41t00.8in.
(10 to 20 mm) ‘
@
Collars l ‘\\,ﬁﬁé// Spacer
=SS
IIIIIIIIIIIIIIIIIIIIIIiIiiiipiTIIiiIoOOl {g‘@@)‘
T =zt .
) i —P
5 0.8to1.2in.
RPN (20 to 30 mm)
Y\ = Spacer
\\ﬁﬁg

X0102
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Case of 16X21 platen

0to 0.4 in.(0to 10 mm)

_________________________________________________________________ —7

X0165

As an example, the cases where the platen's height is set to the lowest position from the standard position and to the
middle position from the lowest position are described below.

From the standard to the lowest position
(1) Detach the platen.
(2) Remove the platen fixing lever, platen height adjustment lever, and collars.

The number of collars and the height adjustment range are as follows:

Position Height No. of collars
Highest position
0to 10 mm 2
(standard)
Middle position 10 to 20 mm 1
Lowest position 20t0 30 mm None

Case of 16x21 platen

No. of collars
Lowest position 0to 10 mm None

<TIPS>

. Spacers are installed on your printer so that the height can be the reference value. Do not change the number of spacers.

Platen height adjustment lever

Collars

Platen fixing lever
X0261
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(3) Attach the platen height adjustment lever to the platen bearing.
<CAUTION>
e  Attach the platen height adjustment lever to the position as illustrated in the figure below. The lever installed in
the wrong position will interfere with the stopper when the platen is attached.

<TIPS>
o  When adjusting the height, put the latch of the platen height adjustment lever into the groove of the platen
bearing.
e N
Latch

Platen height adjustment

lever Groove

Platen bearing

Stopper

J X0262

Platen height adjustment
lever
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(4) Check that the end position of the platen height adjustment lever is aligned with that of the platen bearing.

Platen height adjustment
lever

X0208

(5) Loosen the knob while holding the platen height adjustment lever and lower the platen bearing and the height

control lever.

Platen bearing

Platen height adjustment lever

X0263
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(6) Use the platen fixing lever to secure the platen temporarily.

The number of collars and the position of screw hole for the platen bearing differ by the height of the platen

adjusted.

<TIPS>

e If you are setting the platen's height to the lowest position, remove all the collars and fix the platen bearing at
its highest screw hole temporarily.

e If you are setting the platen's height to the middle position, attach one collar and fix the platen bearing at its
middle screw hole temporarily.

e If you are setting the platen's height to the highest position, attach two collars and fix the platen bearing at its
lowest screw hole temporarily.

Platen bearing

=

Platen bearing \§ /

\v ~

Platen fixing lever
X0264

(7) Tighten the knob to secure the platen bearing in place.
<TIPS>

e Align the center of platen fixing lever with the position as illustrated in the figure below, and secure the platen
bearing in place.

Platen bearing s N

Platen fixing lever ‘ Platen bearing

Center
position
alignment

IS

gy I

=

R
<

¢

C

Knob Platen fixing lever

Knob

X0265

(8) Insert the platen to be used and tighten the platen fixing lever.
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From the lowest position to the middle position

(1) Detach the platen.
(2) Remove the platen fixing lever, platen height adjustment lever.

The number of collars and the height adjustment range are as follows:

Position Height No. of collars
Highest position 0to 10 mm 5
(standard)

Middle position 10 to 20 mm 1
Lowest position 20t0 30 mm None

Case of 16x21 platen
Position Height No. of collars

Lowest position 0t0o 10 mm None

<TIPS>
3 Spacers are installed on your printer so that the height can be the reference value. Do not change the number of spacers.

Platen height adjustment lever

Spacer

Platen fixing lever
X0266

(3) Loosen the knob while holding the platen bearing and lift the platen bearing to the top to tighten the knob again.

ii Platen bearing
N/

Knob
X0267
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(4) Attach the collar.

Collars

X0268

(5) Attach the platen height adjustment lever to the platen bearing.

<CAUTION>
3 Attach the platen height adjustment lever to the position shown below. The lever installed in the wrong position will interfere

with the stopper when the platen is attached.

<TIPS>
o  When adjusting the height, put the latch of the platen height adjustment lever into the groove of the platen bearing.

~
Platen height adjustment |
lever Groove _ (i
c
C
c
N J
Stopper
Platen height adjustment
lever
X0269
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(6) Check that the end position of the platen height adjustment lever is aligned with that of the platen bearing.

Platen height adjustment lever

X0208

(7) Loosen the knob while holding the platen height adjustment lever and lower the platen bearing and the height

control lever.

Platen bearing

Platen height adjustment lever

X0270

144



Basic printing procedures

(8) Use the platen fixing lever to secure the platen temporarily.

The number of collars and the position of screw hole for the platen bearing differ by the height of the platen
adjusted.

<TIPS>

. If you are setting the platen's height to the lowest position, remove all the collars and fix the platen bearing at its highest
screw hole temporarily.

3 If you are setting the platen's height to the middle position, attach one collar and fix the platen bearing at its middle screw
hole temporarily.

3 If you are setting the platen's height to the highest position, attach two collars and fix the platen bearing at its lowest screw
hole temporarily.

@ Platen bearing
\

N
& J
Platen fixing lever

X0271
(9) Tighten the knob to secure the platen bearing in place.
<TIPS>
3 Align the center of platen fixing lever with the position as illustrated in the figure below, and secure the platen bearing in
place.
Platen bearing s N
Platen fixing lever )
‘ Platen bearing
/f . Center
_ —— j position
i < \& L. alignment
o i |
| E
Knob Platen fixing lever
- J
Knob
X0272

(10) Insert the platen to be used and tighten the platen fixing lever.
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6-4-3. Using the 16X21 platen

<CAUTION>

. When using the 16X21 platen, handle it with care because it is heavy. Be sure not to touch the moving parts of the platen.
Otherwise you may be injured.

. When you slide the 16X21 platen manually, move it slowly.

When you place or remove a T-shirt, and when you replace the platen, manually slide the platen forward and draw it out

of the main unit completely to perform such operation. At this time, slide the platen while lifting it a little. When you
perform printing, slide the platen backward and return it to the printing position before starting the print process.

16X21 platen

When placing/removing T-shirt
and replacing the platen

Position for printing

X0158

<TIPS>
. When using the 16X21 platen, remove all the collars for height adjustment before using it. For information on platen height
adjustment, refer to "6-4-2. Platen height adjustment >>P.137".

i,i Take off the collars

X0273
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(1) On the operation panel, press , and move the 16x21 platen toward the front of the printer.
"

(2) Slide the 16X21 platen while lifting it a little to draw it forward.

(3) Perform the work for placing or removing a T-shirt and replacing the platen in this condition.

<TIPS>
. For information on replacing the platen, refer to "6-4-1. Replacing the currently used platen with another one >>P.134".
. For information on placing or removing a T-shirt, refer to "6-5. Placing print medium in position >>P.148".

Replace the platen

Slide it forward

o

(=]

X0166

(4) When you finish placing or removing a T-shirt, and replacing the platen, slide the platen backward and return it to its
printing position.
<IMPORTANT>

. As the platen is positioned higher when it is slid forward, it is detected by the obstacle sensor, which prevents printing from

being performed. However, if the platen's height is set at the lowest position, the platen is not detected by the obstacle

sensor, and printing may be performed outside the print range of the platen.
Make sure to start printing after sliding the platen to the printing position.

16X21 platen

Slide it backward

X0168

147



Basic printing procedures

6-5. Placing print medium in position

In order to provide an optimum printing image quality when a print medium is placed in position, you need to adjust the

platen's height in accordance with the thickness of the T-shirt or other print medium.

<CAUTION>

. Ensure there is adequate space left in front of the printer and avoid placing any objects that may hinder your movement or the
complete movement of the platen. The platen moves forward while operating and it can strike/damage anything set in its path of
movement.

. Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and the covers, it may be
injured.

<IMPORTANT>

. Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.

<TIPS>

. Adjust the height of the platen corresponding to the print medium before using it. You can use the platen height adjustment lever
to adjust the height of the platen. As a rough indication, adjust the height so that it is lowered by one step from the limit height
detected by the obstacle sensor, and check that the platen is not detected by the sensor.
In the event that the platen's height is lowered excessively, ink mist will be scattered inside the printer, which may result in
staining of the printing surface, blurring of the printed image, and malfunction of the sensor and the main unit.

o Use Uni-Directional Printing in the case where the platen's height needs to be lowered to avoid a hemmed (edge) and seam.
="8-1. Setting the print direction >>P.229".

. You can specify the Uni-Directional Printing for each print data from the printer driver as well.
="5-4-11. Specify the print direction >>P.105".

. When you print a thick printing material, you can always lower the platen's height by adjusting the platen bearing, collars.
="6-4-2. Platen height adjustment >>P.137".

(1) If the platen has not been moved forward, press on the operation panel.
-

(2) Use the platen height adjustment lever to adjust the height of platen.
<TIPS>
. Set the platen height adjustment lever to the position around "A" for a T-shirt, or to the position "C" for such thick material as
a sweatshirt.
. If the platen's height is lowered too much, the printing quality may deteriorate, the main unit may be soiled with ink mist and
SO on.

Platen

X0274
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(3) Puta T-shirt onto the platen, with its printing side facing upward.

<IMPORTANT>

. If the 16X21 platen is mounted, slide it forward and place a T-shirt on it.

<TIPS>

. For the position alignment of white or pale-colored T-shirts, a grid to be printed out on the platen sheet is available from [All
Programs] in the Start menu, by selecting "Brother GTX pro Tools" > "Useful Tools".
="5-5-4. Print a grid pattern on the platen sheet >>P.108".

Platen

X0110

(4) Smooth down the creases in the T-shirt and remove lint and dust from it.

<TIPS>

. Seams on a hemmed (edge), neck portion, armhole, tucks and sleeves or the like are easily detected by the obstacle
sensor.

. In particular, both ends of the T-shirt tend to be raised easily during the printing operation if not flattened properly and
detected by the obstacle sensor.

3 Touching on the fixated pretreated surface should be avoided during the work.

. Do not pull the T-shirt with the pretreatment applied. Instead, flatten it in such a way that it will fit onto the platen surface
well.

. When the surface of the T-shirt does not remain flattened properly, the obstacle sensor detects it.

. In the event that any T-shirt is placed on the platen by pulling it outward forcibly, there are instances in which ejection areas
of the white and color inks are misaligned and the white ink extends off its specified printing area. In particular, be careful
not to stretch a thin T-shirt outward on the platen.

Smooth out the wrinkles ‘

T-shirt
X0111
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(5) The T-shirt should be placed on the T-shirt tray, trying not to draw the excessive parts like sleeves and hems into

the printer.

T-shirt

T-shirt tray

X0112

(6) On the operation panel, press , and move the platen toward the rear of the printer.
—_

Try moving the platen, and check on the gap between the T-shirt surface and the obstacle sensor over the entire print area.

<TIPS>

3 If this gap is too wide, adjust it by rotating the platen height adjustment lever.

. Adjust the height so that it is lowered by one step from the limit height detected by the obstacle sensor, and check that the
platen is not detected by the sensor.

. If the platen's height is too high, a print medium will strike against the print head during the printing process, which in turn
results in ink stains or malfunction.

. If the 16X21 platen is mounted, manually slide it backward until it returns to the original position, then move the platen

toward the rear of the printer.

(7) On the operation panel, press , and move the platen toward the front of the printer.
_

<TIPS>
. Repeat the height adjustment until the platen will be positioned at a proper height.
. After your desired height is determined, start the printing operation.="6-7. Executing a printing job >>P.160".

T-shirt

T-shirt tray

X0113
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6-6. Sending/Loading Print Data

Print data can be loaded into the printer in the following ways:
e  Receive the print data from the PC connected with the USB or LAN cable.
e Load the print data from the USB flash.

For details, please refer to the chapters described later.

6-6-1. Sending print data from ARXP file preview

(1) Open an ARXP file.
<TIPS>
. Double click on the ARXP file, or select [All Programs] > "Brother GTX pro Tools" > "GTX pro File Viewer", to select and
open the ARXP file. You can also load an ARX4 file.

(2) The file's printing conditions and preview window will be displayed.

<TIPS>

. If you have selected [Color+White Ink] or [White Ink Only] in the Select Ink operation, the preview window will be displayed
against a "Black" background or a "Transparent color" background which has been specified in the Advanced settings.

. If you have selected [Color Ink Only] in the Select Ink operation, the preview window will be displayed against a "White"
background.

. When you press the Details button, those items that have been specified in the Advanced setting window of the printer
driver appear.

e When [Color+White Ink] or [White Ink Only] is selected

B CAGTX pro\IMG_1404.anep - o X
Job Name : IMG_1404 2]
Date : 13/02/2020 15:06 s
Plten Size : 14x16
Select Ink : Color+White Ink
Highlight : 5
Mask : 3
Print Time : x1
Whiteness : 400 %

Use background black color :  Off
Color Multiple Pass Printing : Off

Detaik...

v

Color Ink : 0.97 cc s >
White Ink : 8.65 cc 100% I 600%
Prnt : 1 piece
Present Layer 1 W+CMYK  ~| [Jwhite Data
Send to Printer
Background Color _ Change...
Browse... Close
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¢ When [Color Ink Only] is selected

[Details]

T CAGTX pro\IMG_1404.anp

)
Job Name : MG_1404 L 2
-8.0 - 2
Date : 13/02/2020 15:10
Phten Size : 14x16
Select Ink = Color Ink Only 4
Color Ink Volume : 10 0
Double Printing : 1 l
Color Multiple Pass Printing : off
Detak... | 1
N v
Color Ink : 11lcc 80—, >
Print : 1 piece 100% I 600%
Send to Printer
Browse... Close
B CAGTX pro\IMG_1404.arxp G Details
Job Name : mq | kem Value
. Job Name : IMG_1404
LTE 131 | pate : 13/02/2020 15:10
Plten Size : 14x16
Platen Size : 14Y | select Ink : Color Ink Only
Color Ink Volume : 10
Select Ink : Cold Double Printing : 1
Color Multiple Pass Printing : Off
Color Ink Volume : 10 g
Double Printing : 1 Syl w1 =
Brightness : 5
Color Multiple Pass Printing : Off| | Contrast : 5
Cyan balance : 0
Magenta baknce : 0
Yelow balance : 0
Black balance : L] g
k: 5
Gl & Uni-Directional Printing : Off
Print : ip 600%
Color Ink : 111 cc
Print : 1 piece

Send to Printer

Browse... Close
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(3) If you have selected [Color+White Ink] or [White Ink Only] in the Select Ink operation, you can change the
background color of the preview window and preview the print image. Select [Change...] > [Define Custom Colors],

and enter RGB value.
<TIPS>
. When the [White Data] checkbox is marked, the preview window for white ink only will be displayed.

W CAGTX pro\IMG_1404.arp - o X

Color X

Job Name : MG_1404 . '_7'0 9 7;“ e
Date : 13/02/2020 15:06 i L] :
Phten Size : 14x16 Coler b4 : [': : : l': : : =
Select Ink Color+Wh| Basic colors:

Hghight - s “Ind 0 B8 0 0 EEEEEENEN

= : ECEEEEEN EFEEEEEN

Wheness: 40% =====:== EEEEEEEN
Use background black color :  Off
Color Mukiple Pass Printing :  OFF EEEEEEEN ..

Detak. EEEEEEET st sale”
Cubflnkk: 0.97 cc | Custom colors: I_ l_ l_ I_ l_ '_ l_ l_
White Ink : ssce | rrr mine nenEE
= — o | o W+HCMYK Owhie Data

i ~ e Dat
Send to Printer Define Custom Colors >>
Define Custom Colors >> I
| change... |
sowse.. | | cse | ok ]| Coes = oK Cancel Addto Custom Colors

"Example: Preview window for printing an image on a brown (R=128, G=64, B=64) T-shirt"

T CAGTX pro\IMG_1404.3rcp - O X
Job Name : IMG_1404 e
Date : 13/02/2020 15:06 :
Platen Size : 14x16
Select Ink : Color+White Ink
Highlight : 5
Mask : 3 o
Print Time : x1
Whiteness : 400 %

Use background black color :  Off
Color Mulkiple Pass Printing : Off

Detals...
8.0
Color Ink : 0.97 cc < ’
White Ink : 8.65 cc 100% I 600%
Print : 1 piece

Present Layer 1 W+CMYK  ~ [Jwhite Data
Send to Printer |

=l = w— =
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>

(4) For the print data that requires multiple cycles of platen reciprocate movement, print data of each layer can be
verified separately by selecting the desired layer to be displayed. From the [Present Layer], select a layer that you

want to bring into the view.

<TIPS>
. In the layer that is shown as [Total], the preview window of the final print result is displayed.
. When the [White Data] checkbox is marked, the preview window for white ink only will be displayed.
B CAGTX pro\IMG_1404.arxp - O X
Job Name : IMG_1404
-8.0
Date : 13/02/2020 15:06
Phten Size : 14x16
Select Ink : Color+White Ink
Highlight : 5
Mask : z -
Print Time : x1
Whiteness : 400 %
Use background black color :  Off
Color Multiple Pass Printing : off
Detaik...
8.0
Color Ink : 0.87 cc . e
White Ink : 8.65 cc 100% I 600%
Print : 1 piece
Present La Total v [ whie Data
T = Background Color _ Change...

(5) Check the printing conditions and preview window, and click on [Send to Printer].
Then, the ARXP file is sent to the printer.
<TIPS>

3 Make sure that a connection of USB 2.0 cable or LAN cable is made between your PC and the printer.
. In the event that two or more GTX pro printer drivers have been installed on your PC, select one of them and click [OK].
T CAGTX pro\IMG_1404.a0p - ] X
Job Name : IMG_1404
8.0

Date : 13/02/2020 15:06
Phten Size : 14x16
Select Ink : Color+White Ink

Highlight : 5

Mask : 3 c

Print Time : x1

Whiteness : 400 %
Use background black color :  Off
Color Multiple Pass Printing : off

Detaib...

8.0
Color Ink : 0.97 cc < *
White Ink : 8.65 cc 100% i 600%
Print : 1 piece
ﬁ Present Layer 1 W+CMYK  ~ [Jwhite Data
Send to Printer
m— = Background Color _ Change...
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6-6-2. Sending print data from applications

CorelDRAW

(1) Inthe menu bar, select [File] > [Print].

(2) Open the [Color] tab, and make the following settings:
¢ Place a checkmark in the [Document color] checkbox.
o [Color conversions]: "Brother GTX pro" or "Brother GTX pro FileOutput"
e [Color profile]: [SRGB IEC61966-2.1]
¢ [Rendering intent]: [Relative colorimetric]

Print X
General Color Composite Layout Prepress 1 lssue
Color: @ Composite
Separations
Settings: @ Document color
Color proof
Color conversions: Brother GTX pro FileOutput v
Color profile: sRGB IEC61966-2.1 -
| Preserve pure black
Rendering intent: Relative colorimetric -

The color settings and preview available in this dialog box are set for the Windows
Graphic device printer that you selected on the General tab.

[ £ Print Preview b Print Cancel Apply

(3) Open [General] tab and select "Brother GTX pro" from [Printer].
<TIPS>
. If the specified [Printer] is set to "Brother GTX pro", the print data will be sent to the printer.
If the specified [Printer] is set to "Brother GTX pro FileOutput", the print data will be saved as an ARXP file.

(4) On [Preferences], set up the printer driver and send the print data by clicking [OK] in the [Print] dialog box.
<TIPS>
. Setting the printer driver ="5-4. Set up the printer driver >>P.89"
. Clicking on [OK] will not start the print operation of the printer itself. The print button of the printer should be pressed to start
the printing operation.
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Adobe Photoshop
(1) Inthe menu bar, select [File] > [Print]. If the PC's default printer is either "Brother GTX pro" or "Brother GTX pro
FileOutput", the layout is set to the platen size.

(1) Make the settings as follows:
e [Color Handling]: [Printer Manages Colors]
¢ [Rendering Intent]: [Relative Colorimetric]

Photoshop Print Settings X

Printer Setup
Printer Brother GTX4 FileQutput

1 Print Settings...

i B

~  Color Management

»  Description

* Position and Size

(2) From [Printer], select "Brother GTX pro".
<TIPS>
. If [Printer] is set to "Brother GTX pro ", the print data will be sent to the printer.
If [Printer] is set to "Brother GTX pro FileOutput", the print data will be saved as an ARXP file.

(3) Inthe [Print Settings], set up the printer driver, and send the print data by clicking [Print].
<TIPS>
° Setting the printer driver ="5-4. Set up the printer driver >>P.89"
. Clicking on [Print] will not start the print operation of the printer itself. The print button of the printer should be pressed to
start the printing operation.
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Adobe lllustrator
(1) Inthe menu bar, select [File] > [Print] > [Color Management].

(2) Make the settings as follows:
e [Document Profile]: [sSRGB IEC61966-2.1]
o [Color Handling]: [Let lllustrator determine colors]
e [Printer Profile]: [SRGB IEC61966-2.1]
¢ [Rendering Intent]: [Relative Colorimetric]

Print

Print Preset: Custom

Printer: Brother GTX pro FileQutput

General

Marks and Bleed

LU oc rofile: SRGB IEC6
Graphics

Color Management ng: Let Illustrator determine colors

: SRGB IEC61966-2.1

tent: | Relative Colorimetric

(3) From [Printer], select "Brother GTX pro".

<TIPS>
° If [Printer] is set to "Brother GTX pro", the print data will be sent to the printer.
If [Printer] is set to "Brother GTX pro FileOutput", the print data will be saved as an ARXP file.

(4) Inthe [Advanced], set up the printer driver, and send the print data by clicking [Print].

<TIPS>
. Setting the printer driver ="5-4. Set up the printer driver >>P.89"
. Clicking on [Print] will not start the print operation of the printer itself. The print button of the printer should be pressed to

start the printing operation.
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6-6-3. Loading print data (ARXP file) from USB flash memory

™

2

@)

Insert a USB flash memory into the insertion slot near the operation panel of the printer.

<IMPORTANT>

o Do not apply undue force to the USB flash memory when you insert it into the slot. Otherwise, it could be damaged.

<TIPS>

° Please use a FAT32-formatted USB flash memory of which storage capacity is 2 GB to 32 GB in total. You cannot use a
USB memory with security functions such as password lock function or beyond 32 GB.

. Note that the data which can be loaded from the USB flash memory is only the data in the ARXP or ARX4 format.

USB flash insertion

X0038

From the menu, select [Print Data Load], and press @ .

<TIPS>
e  The information on file is shown on the liquid crystal panel.

Menu

Head Cleaning
Test Print
Print Data Load

Receiving History

Maintenance

Select a filename to be printed out, and press @ .
<TIPS>

. Selecting r__l will display the file stored in r__l

3 Folders in the USB flash memory are shown down to the 3rd layer. Folders created in the 4th layer or below are not

displayed
(7 Sample Folder
LD Sample Folder2 ; (3 Sample Folder?
o Sample Datal.arx4 o Sample Datal.arx4
~3 Sample DataZ.arxp ‘ Sample DataZ.arxp
Sample Data3.arxp Sample Data3.arxp
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(4) Check the printimage displayed in the preview window, and press @ .

<IMPORTANT>

. Never touch the USB flash memory when the print button is blinking. Otherwise, any already-saved data may be corrupted.
<TIPS>

. Depending on data size, it may take several minutes before the loading process is completed.

e When any files of USB flash memory cannot be read out. ="9-1. Troubleshooting instructions >>P.248"

. If a folder contains more than one print data, you canuse A W buttons to switch the preview display screen.

. It is possible to change the direction of the preview display screen as well. ="8-7. Preview display settings >>P.232".

Sample Data

# 14 x 16 inch
¢ Hh.4hcc

Data Load OK

The print data loading will be completed when the print button stops blinking and remains lit, while the electric chime sounds.
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>

6-7. Executing a printing job

6-7-1. Executing a print job once for a single print medium

™

(2

Receiving a print data file.

The print button blinks during reception of data. WWhen the data reception is completed, an audible alarm is activated and the print
button illuminates.

As there are two types of audible alarms, make sure the mounted platen matches the platen size of the print data.

<TIPS>

. When data of the same platen size as the previous one was received: A notice sound of "ping-pong" is output.

. When data of a different platen size from the previous one was received: A notice sound of "ping-pong pan-pong" is output.

Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press the print button

to start the printing.

When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard.

<TIPS>

. If the print button is pressed when the platen has not moved toward the front, the platen will move toward the front of the
printer, but no print job will be started. In this case, press the print button once again.

. Pressing @ causes the printing to be canceled.

e The printer may shift to low temperature operation mode, when the room temperature is less than 18°C
(64.4°F) and white ink is used.
During low temperature mode, it may take a longer time for print operation and maintenance before starting the print.
Change the low temperature operation setting as needed.= "8-11. Print Operation Settings Under Low Temperature
>>P.234",

. High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any
warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly
s0 as to conform with the print warranty scope.= "11-1. Apparatus >>P.350"
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Basic printing procedures

6-7-2. Executing a print job several times for multiple print media

You can keep the identical print data and execute a print job several times for multiple print media.

<TIPS>

. When the power is turned off, the retained print data is erased.

. In the event that [ON] is selected from the [Auto Job Delete] in the [Printer Setting] window, the print data will be erased after the
printing of the specified number of print media is completed. To change the setting, refer to "8-16. Automatic deletion of print data
>>P.237".

(1) Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press the print button

to start printing.

When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard.

<TIPS>

. If the print button is pressed when the platen has not moved toward the front, the platen will move toward the front of the
printer, but no print job will be started. In this case, press the print button once again.

. Pressing @ causes the printing to be canceled.

. The number of print media of which printing is completed is shown on the liquid crystal panel.

. The printer may shift to low temperature operation mode, when the room temperature is less than 18°C (64.4°F) and white
ink is used.
During low temperature mode, it may take a longer time for print operation and maintenance before starting the print.
Change the low temperature operation setting as needed.= "8-11. Print Operation Settings Under Low Temperature
>>P234".

3 High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any
warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly
so as to conform with the print warranty scope.= "11-1. Apparatus >>P.350"

(2) Replace the platen's printed medium (T-shirt) with the next one and repeat the procedure until the desired number

of print jobs are completed.
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Basic printing procedures

6-7-3. Performing the printing from receiving history

>

You can print out such print data that you have received before.
<TIPS>

™

(2

The print data that can be retained are max. 100 pieces of them and 800 MB in total capacity, wherein each print data will be
erased in the order from the oldest to the latest.

When the power is turned off, the retained print data is erased.

In the event that [ON] is selected from the [Auto Job Delete] in the [Printer Setting] window, the print function in the [Receiving
History] is disabled. Change the settings as needed.="8-16. Automatic deletion of print data >>P.237"

From the menu, select a print data you want to print out in the [Receiving History].
<TIPS>
. Each of the pieces of print data is displayed in the order in which they are received from the newest to the oldest ones.

Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press the print button

to start the printing.

When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard.

<TIPS>

If the print button is pressed when the platen has not moved toward the front, the platen will move toward the front of the

printer, but no print job will be started. In this case, press the print button once again.
. Pressing @ causes the printing to be canceled.

. The printer may shift to low temperature operation mode, when the room temperature is less than 18°C (64.4°F) and white
ink is used.
During low temperature mode, it may take a longer time for print operation and maintenance before starting the print.
Change the low temperature operation setting as needed.="8-11. Print Operation Settings Under Low Temperature
>>P.234".

. High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any
warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly
so as to conform with the print warranty scope.="11-1. Apparatus >>P.350".
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Basic printing procedures

6-8. Scheduling a print

When the printer is not in the standby state, you can schedule a print by pressing the Print button so that the printer will
perform a print as soon as it returns to the standby state.

6-8-1. When you can schedule printing

You can schedule printing by pressing the Print button in advance while the print data is being received, during the
post-print processing, and during the circulation of white ink.

This is useful if the printer performs the post processing for the previous print job after you remove the printed T-shirt and
set a new T-shirt to the platen.

<TIPS>

. Be sure to remove the printed T-shirt from the platen and set the next T-shirt to the platen before you press the Print button.

. You cannot press the Print button in advance if the printer is being operated from the menu or an error has occurred.

When you can schedule printing Description
The printer is receiving print data While the printer is receiving print data sent via the USB or LAN cable
The printer is post-processing after | When a print job finishes and the platen is unloaded and while the printer is wiping,
a print capping, cleaning the wiper, or performing an auto purge after a print job
While the white ink is being circulated inside the printer at specified intervals or at a
scheduled time for circulation

During the white ink circulation

6-8-2. When a scheduled print begins

A scheduled print begins when each of the following conditions is true:
When you schedule printing When the print begins
The printer is receiving printdata | When the printer has completely received print data

The printer is post-processing | When the printer has finished all the processes such as wiping, capping, cleaning

after a print the wiper, or an auto purge after a print job
During the white ink circulation When the white ink circulation is completed
<TIPS>

. The Print button flashes fast during the period between when you schedule printing and when the printing begins.
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6-8-3. When printing does not begin

A scheduled printing does not begin when each of the following conditions is true:
e Ifan error occurs when printing should begin. (For example, this is true if the ink is depleted in the previous print
job.)
e Ifthe data to print is missing from the printer when printing should begin. (For example, this is true if the data
being printed when you schedule printing is deleted by the [Auto Job Delete] function. ="8-16. Automatic
deletion of print data >>P.237")

6-8-4. Cancelling scheduled printing

You can cancel scheduled printing by pressing the Cancel button during the period between when you schedule printing
and when printing begins.

If you schedule a print during the white ink circulation and press the Cancel button, both the white ink circulation and the
scheduled print are cancelled.
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Basic printing procedures >

6-9. Removing printed matter from platen

(1) Hold the shoulder portions of print medium with your hand, and pull it out slowly in the forward direction indicated.
<IMPORTANT>
. Because the printed surface is still wet with ink, avoid touching it.
. If any ink is attached to your hands, wash your hands with soap and water.
. Those inks that are attached to fabrics cannot be cleaned up, please handle the inks with utmost care.

<TIPS>
. The printed ink is not fixated at this point - therefore, handle the T-shirt with care to avoid the printed surface touching with

other objects.

T-shirt

X0114
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Basic printing procedures

6-10. Fixation of ink

For fixation of ink, use the heat press or oven.
e  Heatpress
It is useful because you can control its temperature and operating time with ease.

e Oven
If the number of articles to be printed is high, it will improve the operational efficiency.
<CAUTION>

. Please use the heat press and oven in a well-ventilated area. If your working area is not well ventilated, wear a protective mask.

<TIPS>

° If the inks are fixated insufficiently, discoloring may occur due to washing and friction.

. Keep the fixation surface of heat press and peel-off sheet clean.
Otherwise, the printing surface may be soiled with stains from the peel-off sheet.

. If a printed material is rubbed with vinyl-chloride-based white or light-colored synthetic leather, color transfer may occur.
When a color-printed surface is rubbed strongly against a printed surface with only white ink, color transfer may occur in the
same fashion.
When a color transfer takes place, wipe the color-transferred area and clean off dirt with a soft and clean cloth or a toothbrush
that is moistened with a small amount of mild detergent for home use and/or alcohol.

. Component of pretreatment remains on the T-shirt on which the ink was fixated after applying pretreatment. For this reason, it is
advisable to wash such T-shirts with water before wearing them.

Guidelines on fixation conditions of ink

The undermentioned fixation temperature/time serve as guidelines only, and optimum conditions vary with your heat

press or oven. Be sure to perform the fixation after checking on the temperature and fixation results beforehand.

<TIPS>

. Because optimum conditions vary depending on the type of your heat press or oven, use the fixation conditions as a reference
guide. Be sure to adjust the conditions while checking on the temperature and ink fixation results beforehand.

. Because some print media easily get scorched, please carefully check and see how the surface actually looks like.
In particular, the print media onto which the pretreatment has been applied will easily get scorched.

. When using the heat press, adjust the pressure while checking the ink fixation result.

. If it is not dry enough after processing for the period of the guideline, extend the time while checking the dried
condition of the ink.

Device Temperature Time
Heat press 180°C (356°F) 35 seconds
Oven Surface temperature: 160°C (320°F)*1 3 min. and 30 sec. to 5 min.

*!: Because a T-shirt may be discolored if this temperature increases too high, great care should be taken to exercise
temperature control.
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Basic printing procedures >

Ink fixation by means of heat press

(1) Place the silicone foam, T-shirt and peel-off sheet in position under the heat press first, and fixate the ink properly.

<TIPS>
3 For the guidelines on fixation conditions of ink=""6-10. Fixation of ink >>P.166".

. For details, refer to the instruction manual of your heat press.
. There is a tendency to bring the print result to an almost matte finish if a silicone-coated paper is used as a peel-off sheet or
to an almost bright finish if a fluororesin sheet is used as the same at the ink fixation stage. Selectively use either of them

according to your desired finish.

FI]

I

-‘

7%

Heat press
),

Peel-off sheet

Silicone foam \/

T-shirt
X0115
Ink fixation by means of conveyor-type oven
(1) Fixate inks onto a T-shirt by means of the conveyor-type oven.
<TIPS>
. For the guidelines on fixation conditions of ink=""6-10. Fixation of ink >>P.166".
. For the conveyor-type oven, identify the oven's internal temperature, and check up on actual ink fixation result.
. For details, refer to the instruction manual of your conveyor-type oven.
Toshirt Conve;or—type oven
l
l
@-------------------------@
out in
X0116
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Precautions to keep good printing quality/use printer over the long term

A DANGER

A Contact with high voltage sections may lead to a serious injury. Turn off the power, and remove the cover 5
minutes later.

A CAUTION

Be careful not to get your fingers caught when closing the front cover, otherwise it may result in injury to your
fingers.

Do not disassemble the ink pouch. If the ink gets into your eyes or onto your skin, it may cause inflammation.
In case of contact with eyes, do not rub but immediately rinse the eyes with water.

Do not disassemble the ink cartridge.

Do not drink liquids such as the ink, maintenance solution, cleaning solution, pretreatment, or waste. They
may cause diarrhea or vomiting.

Avoid causing your eyes or skin to make contact with the ink, maintenance solution, cleaning solution,
pretreatment or waste. It may cause inflammation. In case of contact with eyes, do not rub but immediately
rinse the eyes with water.

Keep the liquids out of the reach of children.

QO O P

Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your
eyes or onto your skin.

It can cause inflammation.

Do not drink or eat the grease. It may cause diarrhea or vomiting.

Keep the liquids out of the reach of children.

L

When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother
will not be held responsible for any accidents or problems resulting from the use of non-genuine parts.

-~

When replacing parts or installing optional accessories, be sure to follow the procedures described in the
Instruction Manual. Incorrect procedures could cause injuries or problems.

(IDIMPORTANT

Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.

Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be
hit and damaged.

e

168



Precautions to keep good printing quality/use printer over the long term

7-1. Tasks to be performed regularly

7-1-1. Replacement of ink pouch with a new one

If the . is displayed in the remaining ink volume indication window on the operation panel screen, replace the ink

pouch which is marked with X with a new one.

<IMPORTANT>

. No cartridges can be refilled with any ink. Do not disassemble the ink pouch. In order to use the printer for a long period and to
take full advantage of its capabilities, we recommend to use the ink pouches that are specified by us.

o During the printing process or head cleaning operation, avoid replacing any ink pouch with a new one. Otherwise, the printer may
break down.

<TIPS>

o If you replace an ink pouch that still has much amount of remaining ink in the way of use, the remaining ink volume indication
window may not display the correct remaining volume.

e  Anyink pouch has been designed to leave a small amount of ink in it when reading the end of its service life. This is required to
protect the printer and keep its good printing quality. Please keep this matter in mind.

X ERROR

No Ink Yellow

[ BEEEN

(1) Take out the ink cartridge displayed on the screen from the printer.
<CAUTION>
. The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

T A
I T

\ W12 W34

Cartridge X0318
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Precautions to keep good printing quality/use printer over the long term >
(2) Open the cartridge's lid.
<IMPORTANT>
. When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.
3 Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the lid.

. Lid
Cartridge

o
Latch AV Lid
. m—

X0042

(3) Pinch the latch at the front end of ink pouch, and draw out the depleted ink pouch from the cartridge.
<CAUTION>
. Remove the accumulated ink at the tip of the cartridge with a waste cloth (non-fuzzy cloth). Clean the printer on a regular
basis.

Ink pouch

Cartridge's tip end

Cartridge

&

(4) Unpack a new ink pouch from its shipping carton.
For the white ink pouch, shake it 100 times each in the side to side direction with its obverse side and reverse side facing upward

Latch

X0119

separately, as shown below.
<NOTE>
. Shake the pouch under the condition it remains contained in the inner box.

White ink pouch

X0048
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(5)

(6)

Precautions to keep good printing quality/use printer over the long term >

Unpack a new ink pouch from its inner box.

<IMPORTANT>

. Do not place the ink pouch near the sharp edges. It could break the pouch and leak the contained ink.

3 Handle the ink pouch with care. It could be damaged when bent, snagged by sharp objects, or dropped.

Ink pouch

X0143

Put a new ink pouch in the cartridge.
Push the tip end of the ink pouch into the cartridge until it clicks into place.
Straighten the ink pouch in such a manner that it will be aligned with the gutter of lid of cartridge, and mount in position by pulling
it with your hand.
<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.
iy

( \ -

Stretch
&
¢
% \ \
) Cartridge

Ink pouch

X0049
(7) Putthe ink pouch in its correct position.
<CAUTION>
. Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand.
(a) Place the pouch in a straight alignment with the cartridge
( A
’ ' Align lines with
: each other X0041
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rrreeeeeeeeeeeennnrnrrreeeeeeeeeeeeennnnriooadtions to keep good printing quality/use printer over the long term >
(8) Close the lid, and put the ink cartridge in position inside the printer.

<IMPORTANT>

. Be sure to put a cartridge in its correct position. If a different ink cartridge is put by mistake, the applicable print head may be
adversely affected. If a cartridge of different color is placed, please set it into the right position. If colors are mixed on the
print result or within the ink pouch, please contact your dealer.

. When setting the cartridge, do not shake the cartridge with the ink pouch facing down with the aim of facilitating the winding
of the pouch.

Doing so will cause wrinkles, and the proper winding of the ink pouch will not be possible.

X0283
<NOTE>
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
(9) Attach a shelf life seal included with ink pouch onto the front surface of the cartridge.
U eredner b
Usoantesde  Uso prima di
09. 2015
GTX Serfes /' 200X
/
Shelf life label
X0144

172



Precautions to keep good printing quality/use printer over the long term >

7-1-2. Cleaning and replacement of maintenance parts

Clean or replace individually selected maintenance parts.

(1) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

(2) Select [Select individually] and press @ .

Maintenance Part Clean/Replace

Error and warning parts

Select individually

(3) Select the maintenance part you want to clean or replace following the message and press @ .

<TIPS>
. The nozzle guard, wiper, exhaust cap, and suction cap should be cleaned at the same time.

(4) Clean and replace.
<TIPS>
. For the way to perform cleaning and replacement, refer to the respective maintenance parts.
="'7-1-3. Cleaning the nozzle guard, wiper, exhaust cap, and suction cap >>P.174"
="7-1-4. Replacing the wiper cleaner >>P.186"
="7-1-5. Replacing the flushing foam >>P.189"
="7-1-7. Replacing the fan filter >>P.197"
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Precautions to keep good printing quality/use printer over the long term >

7-1-3. Cleaning the nozzle guard, wiper, exhaust cap, and suction cap

When a warning message appears in the warning message window, perform the cleaning.
In the event that maintenance has been performed inadequately, a printed material may be soiled with waste ink during
a print session or a printed surface quality may deteriorate.

(1

()
©)

(4)

O Warning

Cap/Wiper Cleaning
Please Clean Nozzle Guards

[ EEETEN

Make the clean stick R, clean stick T, cleaning cup, gloves and cleaning solution, which come standard with the

printer, available for use.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

Select [Part with Error/Warning] and press @

<IMPORTANT>

3 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Follow the on-screen message and turn off the power.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

. If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select
[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink
from drying up.
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(5) Open the front cover, and clean each of the nozzle guards, wipers, exhaust caps, and suction caps.

Precautions to keep good printing quality/use printer over the long term

Two types of clean sticks are provided. Use either the clean stick T or R depending on what you want to clean.

<TIPS>

. For the cleaning method, refer to the description mentioned below.

Locations to be
cleaned with
clean stick T

Exhaust cap

2

Suction cap

On the color side

%\/ cap

.

Wiper

Exhaust cap
Suction

On the white side

N

Wiper

Locations to be
cleaned with
clean stick R

Nozzle guard

(6) After the cleaning is completed, close the front cover.

(7) Turn on the power.

<NOTE>

r

. Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.

<TIPS>

3 Then, a head cleaning will be performed to prevent any ink from drying up.

. Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.
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Precautions to keep good printing quality/use printer over the long term

Cleaning of the nozzle guard, wiper and exhaust cap should be performed separately for the white side and color side.
For the way to perform cleaning, refer to the respective items.

1 Perform cleaning of the white side.

Prepare a new clean stick R and the cleaning solution.

Perform cleaning of the nozzle guard part and the resin part on the white side.

Nozzle guard
="Cleaning the nozzle guard (Use clean stick R) >>P.177"

Cleaning

Prepare a new clean stick T and the cleaning solution.

Perform cleaning of the wiper part on the white side.
Wiper ="Cleaning wiper (Use clean stick T) >>P.180"

Cleaning

Perform cleaning of the exhaust cap part on the white side.
Exhaust cap ="Cleaning exhaust cap (Use clean stick T) >>P.182"
Cleaning

. Perform cleaning of the suction cap part on the white side.
Cleaning ="Cleaning suction cap (Use clean stick T) >>P.184"
suction cap

pl Perform cleaning of the color side.

Rinse the cleaning cup, and prepare a new clean stick R and the cleaning solution.

Nozzle guard Perform cleaning of the nozzle guard part and the resin part on the color side.
Cleaning ="Cleaning the nozzle guard (Use clean stick R) >>P.177"

Rinse the cleaning cup, and prepare a new clean stick T and the cleaning solution.

Perform cleaning of the wiper part on the color side.
="Cleaning wiper (Use clean stick T) >>P.180"

Wiper
Cleaning

Perform cleaning of the exhaust cap part on the color side.
Exhaust cap ="Cleaning exhaust cap (Use clean stick T) >>P.182"

Cleaning

Perform cleaning of the suction cap part on the color side.

Cleanin
9 ="Cleaning suction cap (Use clean stick T) >>P.184"

suction cap
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Precautions to keep good printing quality/use printer over the long term >

Cleaning the nozzle guard (Use clean stick R)

(1)
(2)

Put a proper amount of cleaning solution into the cleaning cup.

Moisten a new clean stick R with the cleaning solution.
<IMPORTANT>

Use a new clean stick R when you start cleaning.

Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the wiper, it may resultin a
printer malfunction.

Do not use other fluids (water, etc.), because they may damage the print heads.

Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.

Do not shed cleaning solution in the maintenance unit.

<NOTE>

For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick R
Cleaning cup

Cleaning cup

Cleaning solution

Do not drain waste ink.

X0320
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Precautions to keep good printing quality/use printer over the long term

(3) Wipe clean the sides of the nozzle guard with the clean stick R.

<IMPORTANT>

. Be sure not to touch the nozzle surface as well as the level surface and sidling surface of the nozzle guard.

<TIPS>

. Manually move the carriage to such a position that you can perform the cleaning with ease.

=
=
===

Nozzle guard

)

Pt
b

Side

Nozzle guard

Clean stick R

Nozzle surface

X0276
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Precautions to keep good printing quality/use printer over the long term >
(4) Wipe the resin part between the print head's nozzle surface and nozzle guard.
<IMPORTANT>
. Be sure not to touch the red-frame zone of the nozzle surface.
3 For cleaning, be sure not to use any tool other than clean stick R.

Cleaning location
Between the nozzle surface and nozzle guard

Clean this part

Nozzle surface

Nozzle guard
X0237
Cleaning conditions
Pre-cleaning state Post-cleaning state

Cleaning location Cleaning location X0238

Between the nozzle surface and nozzle guard Between the nozzle surface and nozzle guard
<IMPORTANT>
. Be sure to use the clean stick R separately for white ink and color ink.
<TIPS>

. There may remain white ink in the black resin part, but it doesn't matter if the severity is small as shown in the photo. Wipe away
the white ink spreading out of the nozzle guard and nozzle surface.
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Precautions to keep good printing quality/use printer over the long term

Cleaning wiper (Use clean stick T)

(1) Put a proper amount of cleaning solution into the cleaning cup.

(2) Moisten a new clean stick T with the cleaning solution.
<IMPORTANT>
. Use a new clean stick T when you start cleaning.
. Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a
printer malfunction.
. Do not use other fluids (water, etc.), because they may damage the print heads.
. Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.
. Do not shed cleaning solution in the maintenance unit.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick T
Cleaning cup

Cleaning cup

Cleaning solution

Do not drain waste ink.

X0321

(3) Use clean stick T to wipe clean the surface of the wiper as well as the gap between the convex part and the wiper.
<IMPORTANT>
3 Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a
printer malfunction.
. Be sure to use the clean stick T separately for color ink and white ink.
3 If ink clot floats on surface, remove it using the clean stick T. Do not use tweezers or other sharp objects. Using sharp
objects could damage the wiper, possibly resulting in failure to eject ink-jet droplets.
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(4) Use the clean side of clean stick T to wipe clean the back of the wiper.

(5) Rinse the clean stick T in the cleaning cup to use it for cleaning of the exhaust cap to be performed next.

Precautions to keep good printing quality/use printer over the long term

Convex part

Clean stick T

Wiper

Clean stick T

N

—

<IMPORTANT>
Be sure to use the clean stick T separately for white ink and color ink.
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Front

Wiper

Back

X0322
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Precautions to keep good printing quality/use printer over the long term

Cleaning exhaust cap (Use clean stick T)

(1) Wipe clean the rubber seal of exhaust cap with the clean stick T.

<IMPORTANT>

. Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a
printer malfunction.

. The clean stick T used for cleaning the wiper should be rinsed in the cleaning cup before the next use. Be sure to use the
clean stick T separately for color ink and white ink.

. If ink clot floats on surface, remove it using the clean stick T. Do not use tweezers or other sharp objects. Using sharp
objects could damage the exhaust cap and deteriorate its air tightness, possibly resulting in failure to eject ink-jet droplets.

(2) Use the clean stick T to soak up the ink accumulated in the exhaust cap, and remove it.
<IMPORTANT>
. If there is any ink clot in the exhaust cap, move the clean stick T in the direction as illustrated below. If the stick is moved
toward yourself, any of the exhaust suction ports may be clogged with ink clot.

e N

Clean stick T

Clean stick T

Rubber seal

Exhaust suction ports

X0323

(3) Rinse the clean stick T in the cleaning cup to use it for cleaning of the suction cap to be performed next.
<IMPORTANT>
. Be sure to use the clean stick T separately for white ink and color ink.
<TIPS>
. Some cleaning solution may remain in the exhaust cap, but it will not cause any functional problem.
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Cleaning conditions

Precautions to keep good printing quality/use printer over the long term

Pre-cleaning state

Post-cleaning state

On the
white side

On the
color side

Exhaust cap rubber part

Exhaust cap rubber part

X0389
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Precautions to keep good printing quality/use printer over the long term >

Cleaning suction cap (Use clean stick T)

(1) Wipe the rubber seal and lip of the suction cap with one side of the tip portion of clean stick T in parallel with the

seal.
<IMPORTANT>

Clean the lip of the suction cap with clean stick T. The print head dries and causes an ejection failure if solidified ink
remains.

Do not touch the sponge of the suction cap. The sponge may come off.

Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a
printer malfunction.

The clean stick T used for cleaning the wiper and exhaust cap should be rinsed in the cleaning cup before the next use.
Be sure to use the clean stick T separately for color ink and white ink.

If ink clot floats on surface, remove it using the clean stick T. Do not use tweezers or other sharp objects. Using sharp
objects could damage the suction cap and deteriorate its air tightness, possibly resulting in failure to eject ink-jet droplets.
Be sure not to pinch the rubber seal. If it is damaged, its sealing property will be degraded, which in turn may lead to
non-ejection of ink-jet droplets from the print heads.

Clean stick T

Rubber seal

Sectional view

Outer sid
uter si wuter side
l:;_\) li;—\:V %

The outer side of the suction cap does not need to

be cleaned.
&

Lips

I

Sponge

X0324

(2) Replace clean stick T with clean stick R, rinse the cleaning cup, and clean the nozzle guard on the color side head.
<IMPORTANT>

Be sure to use the clean stick T separately for white ink and color ink.

The used clean stick T should be disposed of, and should not be reused.

After cleaning the nozzle guard of the color side head, rinse the cleaning cup with pure water, let it dry sufficiently, and store
it so that dust does not get inside.
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Pre-cleaning state

Post-cleaning state

X0390
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7-1-4. Replacing the wiper cleaner

When a warning message appears on the operation panel screen or in the warning message window, replace the

specified wiper cleaner with a new one.

<TIPS>

. When you replace the wiper cleaner, check the staining state inside the printer. If parts inside the printer (carriage guide shaft,
roller guide, and carriage roller) are stained, perform cleaning.="7-1-6. Cleaning the internal area of printer >>P.192"

O Warning

Wiper Cleaner Replacing Color
Wiper Cleaner Replacing White

[ BN

(1) Have the supplied gloves and wiper cleaner ready.

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

(3) Select [Part with Error/WWarning] and press @ .
<IMPORTANT>
. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve

the problem, then perform the cleaning.
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

(4) Follow the on-screen message and turn off the power.
<IMPORTANT>
. Please complete the task within 15 minutes, in order prevent the print heads from drying up.
. If the task takes more than 15 minutes to complete, after attaching the wiper cleaner, close the front cover and turn on the
power, and then select [Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be
performed to prevent any ink from drying up.

(5) Open the front cover.
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(6) Raise the wiper cleaner and move it to its upright position, and remove it by moving it upward.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

Wiper cleaner Front cover

X0325
(7) Take out the wiper cleaner from its packing bag, and remove it from its protector.
<IMPORTANT>
. As soon as it is unpacked, do not leave it as it is and put it in position.
Wiper cleaner
Protector
X0128
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(8) Insert a new wiper cleaner into the printer from above, tip it leftward and put it in place.
<TIPS>
. First, insert the shaft from above. Then fold it to the left, press the area with the PUSH indication until a clicking sound is
heard, and get the latch into position.

( N\

Latch

Latch

Shaft

Wiper cleaner Shaft

)
83 ¢
(. J/
X0326
(9) Close the front cover.
(10) Turn on the power.
<NOTE>
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
<TIPS>

. A head cleaning will be performed to prevent ink from drying up.
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7-1-5. Replacing the flushing foam

When a warning message appears on the operation panel screen or in the warning message window, replace the

specified flushing foam with a new one.

<TIPS>

. When you replace the flushing foam, check the staining state inside the printer. If parts inside the printer (carriage guide shaft,
roller guide, and carriage roller) are stained, perform cleaning.="7-1-6. Cleaning the internal area of printer >>P.192"

O Warning

Flushing Foam Replacing Color
Flushing Foam Replacing White

[ BN

(1) Make the clean stick R, gloves and flushing foam, which come standard with the printer, available for use.

<TIPS>
. For this cleaning, you can use an already-used dirty clean stick R.

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

(3) Select [Part with Error/Warning] and press @ .

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

(4) Follow the on-screen message and turn off the power.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

. If the task takes more than 15 minutes to complete, after attaching the flushing receiver, close the front cover and turn on
the power, and then select [Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be
performed to prevent any ink from drying up.

(5) Open the front cover.
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(6) Remove the flushing foam from the maintenance unit.
<IMPORTANT>
° Remove the flushing foam without removing the flushing receiver from the maintenance unit.
. Ink droplets will drop off from the hole in flushing foam. After removal, apply a waste cloth to the bottom face.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

4 \

Flushing receiver  Waste cloth Front cover

r

Waste cloth

X0327

(7) Wipe the gloves with a waste cloth.

Waste cloth

N

Gloves

X0436

190



Precautions to keep good printing quality/use printer over the long term

(8) Assemble a new flushing foam to the flushing receiver.

<IMPORTANT>

° After this assembly process is completed, make sure that no flushing foam extends off the outboard end portions of flushing
receiver. If it sticks out of the end portions, it may interfere with any nozzles and may result in non-ejection of ink-jet
droplets.

<TIPS>

. It is not necessary to clean the flushing receiver.

Flushing receiver \
{

X0330

(9) Close the front cover.

(10) Turn on the power.

<NOTE>

. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
<TIPS>

. The head cleaning will be performed to prevent ink from drying up.

191



Precautions to keep good printing quality/use printer over the long term >

7-1-6. Cleaning the internal area of printer

When you replace the wiper cleaner and the flushing foam, check the staining state inside the printer. If parts inside the
printer (carriage guide shaft, roller guide, and carriage roller) are stained, perform cleaning.

(1)

()

@)

(4)

Prepare a clean stick R, cleaning cup, gloves, cleaning solution, and grease which come standard with the printer.

<IMPORTANT>
. Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may
result in a printer malfunction.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ :
<IMPORTANT>
3 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve

the problem, then perform the cleaning.
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Follow the on-screen message and turn off the power.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

. If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select
[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink
from drying up.

Open the front cover.

Front cover

X0331
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(5) Remove three screws to remove the encoder cover.

<CAUTION>

. Do not touch the latch under the encoder cover. Otherwise, the operator may get injured.
<IMPORTANT>

3 Do not touch the encoder on the main unit.

Encoder cover

X0148

(6) Put a proper amount of cleaning solution into the cleaning cup.
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(7) Moisten a clean stick R with the cleaning solution.
<IMPORTANT>
. Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.
3 Do not shed cleaning solution in the maintenance unit.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

. Clean stick R
Cleaning cup

Cleaning cup

Cleaning solution

Do not drain waste ink.

X0320
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(8) With the clean stick R, wipe away the ink mist on the carriage roller part.

(9) Move the carriage from side to side to rotate the roller part, and wipe all around the carriage roller.

e ™
Carriage roller

Carriage Clean stick R

X0448

(10) Clean the carriage guide shaft and the three sides (upper, front, and lower sides across which the roller rolls) of

roller guide.

<TIPS>

. Moisten a waste cloth (non-fuzzy cloth) with a small amount of alcohol, and use such cloth to wipe clean the internal
surface.

. Do not use alcohol on parts other than the carriage guide shaft and the roller guide.

(11) Apply a proper amount of the grease (which is included with the printer) onto the carriage guide shaft.

<CAUTION>
3 When handling the grease, perform the work operation in such a manner that it will not get into your eyes or onto your skin.

Front cover

Roller guide

Carriage guide shaft
X0063
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(12) Insert the two latches under the encoder cover and fix the cover with three screws.
(13) Close the front cover.

(14) Turn on the power.
<NOTE>
3 Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.
<TIPS>
. Then, a head cleaning will be performed to prevent any ink from drying up.
3 Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.

(15) Adjust the carriage speed.= "7-4-1. CR (Carriage) speed adjustment >>P.216".
(16) Print out a nozzle check pattern.== "7-2-1. Print out of the nozzle check pattern (checking on the print heads)

>>P.199".
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7-1-7. Replacing the fan filter

When a warning message appears in the warning message window, replace the fan filter with a new one.

(1)
()
©)

(4)
(S)

O Warning

Fan Filter To Be Replaced

EECEE 000

Make the gloves which come standard with the printer, as well as a new fan filter, available for use.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

Select [Part with Error/Warning] and press @ .

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.
. Pressing @ will not move the platen or head if the error and warning displayed are [Fan Filter To Be Replaced] only.

Follow the on-screen message and turn off the power.

Remove the fan filter from the main unit of printer.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

Fan filter

X0332
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(6) Mount a new fan filter to the frame of filter case.
<IMPORTANT>
. Mount the fan filter properly in correct position in such a way that its coarse mesh surface faces toward the inner area of
printer.

Toward the inner area of printer

Ao S

Toward the fan

>

Fan filter

Filter case

Coarse mesh surface _
Fine-meshed surface

X0062

(7) Mount the assembled fan filter in the main unit of printer.

(8) Turn on the power.
<NOTE>
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.

<TIPS>
. Then, a head cleaning will be performed to prevent any ink from drying up.
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7-2. Tasks to be performed when needed

7-2-1. Print out of the nozzle check pattern (checking on the print heads)

By printing out a nozzle check pattern, you can check on the printing quality.
It is recommended to always perform this procedure to verify the output.

1)

()

@)

(4)

(5)

<TIPS>
. The serial number, firmware version, and print date (day/month/year) and time are printed at the bottom of the nozzle check
pattern.

The date and time will be printed in Coordinated Universal Time with "(UTC)" printed at the end if time adjustment as a
maintenance tool has not been made. You can print the date and time according to your environment by making time
adjustment. ="7-4-6. Setting of the time displayed on the nozzle check pattern >>P.221"

Put the platen 14X16 in place, and position its level at "A".

="6-4-1. Replacing the currently used platen with another one >>P.134" and "6-4-2. Platen height adjustment
>>P137".

As illustrated below, put the Ad-size or letter-size white paper on the platen in alignment with the right-hand corner

of the platen at its front edge.

When the paper is loosely fitted, fix its edge with a tape or the like.
AT-shirt can also be used instead.

<TIPS>

3 When printing out a nozzle check pattern on the white side, print it on a pretreated black or dark color textile or black paper,
or a transparent sheet (such as OHP sheet).

Paper

Platen

\

X0043

From the menu, select [Test Print] > [Nozzle Check CMYK], and press @ .
Then, printing will begin.

After printing on the color side is completed, remove the printed paper and replace it with a paper for printing on the

white side.

From the menu, select [Test Print] > [Nozzle Check White], and press @ .
Then, printing will begin.
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(6) Check to see if the printed result of both sides are acceptable, and if no ink-jet droplets have been ejected, perform

a head cleaning for print heads.= "7-2-2. Head cleaning >>P.201"
<IMPORTANT>

If the print result shows an intermittent line, non-ejection has occurred. A head cleaning should be performed on the print

head that has a poor nozzle check result.

Even if the lines of the white-side printed result are light, since white ink is fired from more than one nozzle on the same

place, the quality is not affected.

>

On the color side

On the white side

Non-ejection occurred at the arrowed area.

Example:

Non-ejection occurred at the arrowed area.

Example:

X0241
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7-2-2. Head cleaning

This printer has been designed to perform the Auto Cleaning every time 24 print jobs are printed after the previous Auto
Cleaning, or before starting the printing using the white ink when one hour or more elapses after the previous printing
that used the white ink.

<TIPS>

o The frequency and start timing of Auto Cleaning can be changed. ="8-12. Auto Cleaning Setting >>P.235"

In the event that there is any faintly printed or missing portion on a printed material, head cleaning sometimes provides a
solution.

Selecting a type of head cleaning from the menu to perform the head cleaning
(1) While the printer is in standby mode press @ on the operation panel to bring the menu screen into the view.

(2) From the menu, select [Head Cleaning], and press @ .

Menu

Head Cleaning

Test Print
Print Data Load
Receiving History

Maintenance

(3) Bypressing A V¥, selectone of the options: [Normal Cleaning], [Powerful Cleaning], [Super Cleaning] or [Flash
Firingl,and press @ .

<TIPS>
3 For selecting a desired cleaning option, follow the instructions in the respective steps.="9-2-1. Recovery action to be taken
for such a nozzle that is unable to eject ink-jet droplets >>P.257".

Head Cleaning
Normal Cleaning
Powerful Cleaning

Super Cleaning

Flash Firing
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(4) Bypressing A V¥, selectthe [All Colors], [All Whites], or [All Print Heads], and press @ .

<TIPS>
. Under the condition that the nozzle which has been confirmed not ejecting ink-jet droplets, determine the color for which the
head cleaning should be performed.== "7-2-1. Print out of the nozzle check pattern (checking on the print heads) >>P.199"

Normal Cleaning
All Colors

All Whites

All Print Heads

(5) Then, the head cleaning will be performed for the specified print heads.
<TIPS>
e  The cleaning operation cannot be canceled halfway.
e  After the procedures are completed, the current screen will go back to the standby mode screen.
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7-2-3. White ink circulation

When whiteness is not enough, it may be solved by performing white ink circulation.

(1) While the printer is in standby mode, press @ on the operation panel to bring the menu screen into view.

(2) From the menu, select [Maintenance] > [White Ink Circulation], and press @ .
<IMPORTANT>
. Do not turn off the power because if you do so, the machine mail fail because necessary maintenance operations are not

performed.

<TIPS>

° Time required for completing the white ink circulation varies depending on the ambient temperature. It normally takes 7 and
a half minutes although it can take up to 15 minutes. White ink is circulated automatically every six hours and white ink
three times as much as normal is circulated every 24 hours.

3 If you are activating the printer after having had its power off for a long period, it will take up to 40 minutes.

White Ink Circulation
All Whites

[ 1Imin[30]sec

Please Wait
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7-2-4. Cleaning the CR (carriage) plate

>

Clean the carriage plate when it is contaminated with ink.
<TIPS>

(1

(2)

©)

(4)

(5)

You can use an already-used clean stick R.

Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available

for use.

<IMPORTANT>

. Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may
result in a printer malfunction.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve

the problem, then perform the cleaning.
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Follow the on-screen message and turn off the power.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

. If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select
[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink
from drying up.

Open the front cover.

Front cover

X0331

Put a proper amount of cleaning solution into the cleaning cup.
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(6)
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Moisten a clean stick R with the cleaning solution.
<IMPORTANT>

If you use an already-used clean stick R, do not use it for other purposes than cleaning the carriage plate.
Do not use other fluids (water, etc.), because they may damage the print heads.

Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.
Do not shed cleaning solution in the maintenance unit.

<NOTE>

For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick R
Cleaning cup

Cleaning cup

3
Q)

=

&

Cleaning solution

Do not drain waste ink.
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(7)

(8)

(9)

Precautions to keep good printing quality/use printer over the long term >

With the clean stick R, wipe away the accumulated ink on the carriage plate of the left-side of the print head.
<IMPORTANT>

. Be sure not to touch the nozzle surface.

<TIPS>

. Manually move the carriage to such a position that you can perform the cleaning with ease.

Clean stick R

Contaminated with ink

f

Clean the carriage plate on the left side of the other print head in the same manner.
<IMPORTANT>
. The used clean stick R should be disposed of, and should not be reused.

Close the front cover.

(10) Turn on the power.

<NOTE>

. Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.
<TIPS>

3 Then, a head cleaning will be performed to prevent any ink from drying up.

. Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.
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7-2-5. Replacing the platen sheet

When the platen sheet gets soiled, replace it with a new one.
(1) Remove the platen from the main unit of the printer.
= "6-4-1. Replacing the currently used platen with another one >>P.134"

(2) Peel the platen sheet off the platen.
<TIPS>

. When it is hard to peel the platen sheet off, warm it using a hair dryer or the like and peel it off.

Platen sheet

Platen
X0064

(3) Wipe the surface of the platen with a clean cloth moistened with a mild detergent which is diluted with water, then
wipe the platen clean with a dry and soft clean cloth.

(4) Mount the platen in the main unit of the printer.
="6-4-1. Replacing the currently used platen with another one >>P.134"

(5) Peel the release paper (small in size) off a new platen sheet.

Platen sheet

Release paper (small)

X0157
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(6) Position the platen sheet to match the platen surface, and onto the platen, stick the portion of the platen sheet

where the release paper (small) was removed.
<TIPS>
. If the 16X21 platen is used, slide it forward before working on it.

Platen sheet

Positioning

Platen

X0065

(7) Peel off the rest of the release paper, and paste the whole platen sheet onto the entire platen.

<TIPS>
. Straighten the platen sheet, and stick it properly while pressing it with hands outward from the center to avoid making

wrinkles.

Platen sheet

Release paper

Platen

X0066

(8) Asrequired, print a grid pattern onto the new platen sheet.

= "5-5-4. Print a grid pattern on the platen sheet >>P.108"

<TIPS>
. After the printing is completed, press down the printed surface lightly with a dry cloth or a sheet of paper to dry the ink.
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>

7-3. White Ink Pause Mode

7-3-1. Disabling white ink

If you do not plan to use the white ink for 1 month or longer, it is recommended to set the printer to white ink pause mode.
This eliminates the necessity to maintain the white ink, and saves its consumption.
<TIPS>

(1
()
@)

(4)

Although the white ink pause mode can be activated even when the remaining volume of maintenance solution in the
maintenance solution pouch is running short, there may be a case where the pouch needs to be replaced with a new one in the
middle of the process depending on such remaining volume. If the remaining volume is 500 g (17.6 oz) or less, prepare a new
maintenance solution pouch, follow the instructions on the screen to replace the pouch, and activate the mode again.

From the menu, select [Maintenance] > [White Ink Pause Mode] > [Enable].
Check the waste ink tank for its availability and take a necessary measure for it, if any, then press @ .

Remove the white ink cartridge from the printer.

<CAUTION>
. The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

( N\

I 4l

A

W12 W34

White Ink Cartridge
X0333

Open the cartridge's lid.

<IMPORTANT>

e  When opening the lid, be sure not to touch portion (a). Otherwise, it could be damaged.

. Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the
lid.

Lid

Cartridge

X0042
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(5) Pinch the latch at the front end of the ink pouch, and draw out the white ink pouch from the cartridge.

<CAUTION>
. Remove the accumulated ink at the tip of the cartridge with a waste cloth (non-fuzzy cloth). Clean the printer on a regular
basis.

White ink pouch

Cartridge's tip end

G

Cartridge

Latch

X0118

(6) Put the maintenance solution pouch in the cartridge.
Push the tip end of the maintenance solution pouch into the cartridge until it clicks into place.
Straighten the maintenance solution pouch in such a manner that it will be aligned with the gutter of lid of cartridge, and mount
into position by pulling it with your hand.
<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

Maintenance solution pouch
\ =
Stretch
v
C
%ﬂ \ \
Cartridge

X0049

(7) Put the maintenance solution pouch in its correct position.

<CAUTION>
e  Avoid touching portion (a) of the cartridge. Otherwise, you may cut your hand.

(a) Place the pouch in straight alignment with the cartridge

Align lines with
each other X0041
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(8) Close the lid, and put the maintenance solution cartridge in position inside the printer.

(9) Repeat the same process to replace the other white ink cartridge with the maintenance solution pouch.

(10) On the operation panel, press ® .

Then, the white ink will be replaced with the maintenance solution.
<TIPS>

After the procedures are completed, the current screen will go back to the standby mode screen.
Always keep the maintenance solution cartridge placed in its position.

As required, restart printing with the white ink.="7-3-2. Reusing White Ink >>P.212"

If the maintenance solution pouch runs out, replace the maintenance solution pouch with a new one.
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7-3-2. Reusing White Ink

Perform the following operations when you restart printing with the white ink after activating the white ink pause mode.
(1) From the menu, select [Maintenance] > [White Ink Pause Mode] > [Disable].
(2) Check the waste ink tank level and take a necessary measure for it, if any, then press @ .

(3) Remove the maintenance solution cartridge from the printer.

<CAUTION>
e  The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

( )

— 1

A

W12 W34

Maintenance solution cartridge

X0333
(4) Open the cartridge's lid.
<IMPORTANT>
e  When opening the lid, be sure not to touch portion (a). Otherwise, it could be damaged.
. Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the
lid.

Cartridge Lid

X0042
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(5) Remove the maintenance solution pouch from the cartridge, and put the white ink pouch in place.
Push the tip end of the ink pouch into the cartridge until it clicks into place.
Straighten the ink pouch in such a manner that it will be aligned with the gutter of the lid of cartridge, and mount in position by
pulling it with your hand.
<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

White ink pouch

Stretch
v
C
& N \\
) Cartridge
X0049
(6) Make sure that the white ink pouch is set in its correct position, to close the lid.
<CAUTION>
. Avoid touching portion (a) of cartridge. Otherwise, you may cut your hand.
(a) Place the pouch in straight alignment with the cartridge
, ' Align lines with
each other X0041

(7) Shake the cartridge 100 times side to side to stir the ink.

<IMPORTANT>

. The white ink cartridge should be held horizontally when shaking it.

. Holding the white ink cartridge upside down or shaking it too roughly could break the ink pouch.

<NOTE>

e  Wear the provided gloves when performing this task.

3 When the remaining ink level becomes approximately 5.9 in. (15 cm), shake the cartridge with its cover open and with the
edge of the ink pouch slightly winded, to make the ink easier to stir.

White Ink Cartridge

\ @ 2
b\ C =

S

s \/ Remaining ink volume should

be approx. 5.9 in. (15 cm)

Shake 100 times (for approx. 50 seconds)
(Swing distance should be approx. 2 in. (5 cm). X0194
Increase the swing distance when the remaining

ink level becomes low.)
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Precautions to keep good printing quality/use printer over the long term

(8) Open the lid of the cartridge and place the ink pouch in its correct position.

<IMPORTANT>

e  Always open the cartridge lid and properly rewind the ink pouch. If the pouch is placed without opening the lid, ink can flow
into the wound section of the pouch when stirred, causing improper winding of the pouch.

e  When opening the lid, place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge
downward and open the lid.

. When setting the ink pouch, avoid unevenness or wrinkles on the pouch.

. When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.

<NOTE>

. If the remaining ink level is low, hold the sagged part of the ink pouch and close the lid.

Cartridge Lid

X0182
]
]
Lid
/
| =—>
|
X0078
Ink pouch No wrinkles = \
=
. Y
Not sagged
X0142
(9) Close the lid, and put the white ink cartridge in position inside the printer.
<IMPORTANT>
3 W12 and W34 cartridges should correctly be placed at their original locations. Wrongly placed cartridges could cause
printer malfunction.

(10) Repeat the same process to replace the other maintenance solution cartridge with the white ink pouch.
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Precautions to keep good printing quality/use printer over the long term >

(11) On the operation panel, press @ .

Then, the white ink will be installed.
<TIPS>

When the white ink pouch runs low on its remaining volume of white ink, the Install Ink function can no longer get started.
Furthermore, there may be cases where the pouch needs to be replaced with a new one during the installation process of
white ink. If the remaining volume is 400 g (14.1 oz) or less, prepare a new white ink pouch, follow the instructions on the
screen to replace the pouch, and activate the mode again.

After the procedures are completed, the current screen will go back to the standby mode screen.
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7-4. Adjustment/setup

7-4-1. CR (Carriage) speed adjustment

Carriage speed should be adjusted when the error message [Adjust CR] is displayed on the operation panel. Adjustment
should always be performed when carriage shaft cleaning or print head replacement tasks are carried out, or after
completing the setup procedures.

(1) While the printer is in standby mode, press @ on the operation panel to bring the menu screen into view.
(2) From the menu, select [Printer Setting] > [CR Speed Adjustment], and press @ .

(3) Select [Start] or [Start (after cleaning/setup)] and press @

e [Start]: If you cannot clean the internal area of the printer such as carriage shaft immediately after the head
replacement or when the error message is displayed.
o [Start (after cleaning/setup)]: After cleaning the carriage shatt.

Wait until the carriage stops moving and the sound of pong is heard.

It takes about 3 minutes to adjust the carriage speed.

CR Speed Adjustment
Auto Adjusting

Please Wait
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Precautions to keep good printing quality/use printer over the long term >

7-4-2. Initial settings after head replacement

Set V-rating after replacing the print head or completing the setup procedure.
(1) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC.
(2) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" from "Brother GTX pro Tools".

(3) After the window shown below appears, select [Initial settings after head replacement] and click [Next].

@ Brother GTX pro Maintenance X

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX pro ~ Search

(O Firing Adjustment
Adjust this setfing when the sdges of the print look vague, solid aress are not even, or after a Print Head is replaced,

(O Platen-roling adjustment
Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshocting method when other #ems such as proper temperature and humidity have already been verified.
O White/Color Alignment
Adjust whan whita print doss not align with color print.

(O set an IP Adrress
Assign a static TP address to the printer.

(O Log Data Retrieval
Executs if there was a request after troubleshocting service.

(O setting of the time displayed on the nozzle check pattern
This is not y if you have ig the scheduled time for white ink circulation.

(O 5et the scheduled time for white ink circulation
Configure this setfing to s=t or cancel the scheduled time for white ink circulation,

(4) Perform the required operation by following the on-screen instructions in the dialog box.
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.
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7-4-3. Firing adjustment

Because the ejection timing varies depending on the platen's height and properties of each print head, this function is
provided to adjust the ejection timing for each print head when any print head is replaced with a new one or after the
completion of the setup procedure, for instance. If you want to make adjustments after replacing the print head,
configure the initial settings after print head replacement before you do so.

(1) Make several sheets of Ad-size or letter-size paper (black paper or transparent sheet such as OHP sheet, and
white paper) available for use.

(2) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC.

(3) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" from "Brother GTX pro Tools".

(4) After the window shown below appears, select [Firing Adjustment] and click [Next].

‘»E? Brother GTX pro Maintenance X

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX pro R Search

Select an item from the menu below and dick "Next”.

(O Initial settings after head replacement
Perform this setting when replacing the head or when ssifing up the printer only.

(O Platen-rolling adjustment
Make adjustments when horizontal stripes (banding ) occur in the printed image. Use this adjustment as a
troubleshooting method when other #=ms such as proper temperaturs and humidity have already been verified,
O White/Color Alignment
Adjust when white print does not align with color print.

(O Set an IP Adrress
Assign a static IP address o the printer.

(O Log Data Retrieval
Execute if there was a request after troubleshocting service.

() Setting of the time displayed on the nozzle check pattem
This is not necessary if you have configured the scheduled time for white ink circulation.

(O Set the scheduled time for white ink circulation
Configure this seiting to s=t or cancel the scheduled time for white ink circulation,

< Back ‘ Close

(5) Perform the required operation by following the on-screen instructions in the dialog box.
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.
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7-4-4. Platen-rolling adjustment

Platen feed adjustment should be performed after replacing the print head or completing the set up procedure.
If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement
and adjust the firing timing before you do so.

(1) Make several sheets of A4-size or letter-size white paper available for use.
(2) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC.
(3) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" from "Brother GTX pro Tools".

(4) When the window shown below is displayed, select [Platen-rolling adjustment] and click [Next].

\‘EJ’ Brother GTX pro Maintenance X

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX pro e Search

Select an item from the menu below and dick "Next™.
(O Initial settings after head replacament
Perform this setting when replacing the head or when sstting up the printer only.

(O Firing Adjustment
Adjust this setting when the edges of the print lock vague, solid areas are not even, or after a Print Head is replaced.

(®) Platen-rolling adjustment

Make adjustments when horizontal stripes (banding ) occur in the printed image. Use this adjustment as a
troubleshooting method when cther tems such 2s proper temperature and humidity have already been verified,

Adjust when white print does not align with color print.

(O Set an 1P Adrress
Assign a static [P address to the printer.

(O Log Data Retrieval
Executs if there was a request after troubleshocting service.

(O setting of the time displayed on the nozzle check pattern
This is not y if you have figured the scheduled time for white ink circulation.

(O set the scheduled time for white ink circulation
Configure this seiting to sst or cancel the scheduled time for white ink circulation.

(5) Perform the required operation by following the on-screen instructions in the dialog box.
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.
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7-4-5. White/color alignment

This is the adjustment function to align the print position on the white side with the print position on the color side. Adjust
white/color alignment after replacing a print head or completing the setup procedure.

If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement
and adjust the firing timing and platen feed before you do so.

(1) Prepare a sheet of black paper or a pretreated black or dark color T-shirt.
(2) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC.
(3) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" from "Brother GTX pro Tools".

(4) Atfter the window shown below appears, select the [White/Color Alignment] and click [Next].

@ Brother GTX pro Maintenance X

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX pro v Search

Select an item from the menu below and dick "Next™.

(O Initial settings after head replacement
Perform this setting when replacing the head or when ssifing up the printer only.

(O Firing Adjustment
Adjust this setting when the edges of the print lock vague, solid areas are not even, or after a Print Head is replaced.

(O Platen-rolling adjustment
Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
j=mpersture and humidity have already been verified.

(®) White/Color Alignment
Adjust when whits print doss not align with color print.

(O et an IP Adrress
Assign a static IP address o the printer.

(O Log Data Retrieval
Executs if there was a request after troubleshocting service.

(O setting of the time displayed on the nozzie check pattem
This is not necessary if you have configured the scheduled fime for white ink circulation.

(O set the scheduled time for white ink circulation
Configure this seifing o sst or cancel the scheduled time for white ink circulstion.

) Bad{. C|me

(5) Perform the required operation by following the on-screen instructions in the dialog box.
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.
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7-4-6. Setting of the time displayed on the nozzle check pattern

>

Set the time displayed on the nozzle check pattern.

(1) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC.

(2) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" of "Brother GTX pro Tools".

(3) Atfter the window shown below appears, select [Setting of the time displayed on the nozzle check pattern] and click

[Next].

@ Brother GTX pro Maintenance X

Confirm the printer is turned ON and connected to your PC.
Select the printer.

| Brother GTX pro v Search

Select an item from the menu below and dick "Next”.

(O Initial settings after head replacement
Perform this setting when replacing the head or when setfing up the printer only.

(O Firing Adjustment
Adjust this setfing when the sdges of the print look vague, solid aress are not even, or after a Print Head is replaced,

(O Platen-rolling adjustment
Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshooting method when other t=ms such 2s proper temperature and humidity have aiready been verified.
O White/Color Alignment
Adjust whan whits print do=s not align with coler print.

(O set an IP Adrress
Assign a static TP address io the printer.

(O Log Data Retrieval
Execute if there was a request after troubleshocting service.

() Set the scheduled time for white ink circulation
Configure this setfing to s=t or cancel the scheduled time for white ink circulation,

T T
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(4) Perform the required operation by following the on-screen instructions in the dialog box.
<CAUTION>
. Confirm that the date and time of your PC are set correctly, and continue.

&7 Brother GTX pro Maintenance X

Step 1:
Set the time displayed on the nozzle check pattern.

Current time 14:47

Confirm that the date and time of your PC is set for 2018 or later and
continue.

- Set to the above mentioned time.

<o ==

(5) After the setting is completed, the currently displayed screen will go back to the Main screen.

GTX pro Maintenance X

Time has been set.
Return to Main screen.

oK
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7-4-7. Set the scheduled time for white ink circulation

White ink circulation can be performed at a specified time. If not set, white ink circulation will be performed automatically
every four hours.

(1) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC.
(2) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" of "Brother GTX pro Tools".

(3) After the window shown below appears, select [Set the scheduled time for white ink circulation] and click [Next].

&7 Brother GTX pro Maintenance X

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Brother GTX pro e Search

Select an item from the menu below and dick "Next”.

(O Initial settings after head replacement
Perform this setting when replacing the head or when sstting up the printer only.

(O Firing Adjustment
Adjust this setting when the edges of the print lock vague, solid areas are not even, or after a Print Head is replaced.

(O Platen-rolling adjustment
Make adjustments when horizontal stripes (banding ) occur in the printed image. Use this adjustment as a
troubleshooting method when other tems such as proper temperature and humidity have aiready been verified,
) White/Color Alignment
Adjust when white print does not align with color print.

(O Set an 1P Adrress
Assign a static IP address to the printer.

(O Log Data Retrieval
Executs if there was a request after troubleshocting service.

(O setting of the time displayed on the nozzle check pattemn
This is not y if you have fi d the scheduled time for white ink cinculation.

(®) set the scheduled time for white ink circulation

Configure this seiting to sst or cancel the scheduled time for white ink circulation.

(4) After the window shown below appears, select [Set the scheduled time for white ink circulation.] and click [Next].

@ Brother GTX pro Maintenance X

Step 1:
Set or cancel the scheduled time for white ink drculation,

(O Cancel the scheduled time for white ink drculation.

- If the scheduled time of white ink circulation is not set, the white ink dreulation is automatically turned ON every 4
hours.

- Enter setting that results in a white ink drculation interval of between 1and 6 hours.
- One of the scheduled times of white ink circulation is enhanced circulation.
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(5) Set the scheduled time for white ink circulation and click [Next].
<CAUTION>

Confirm that the date and time of your PC are set correctly, and continue.
Enter at least 6 start times.

Enter setting that results in a circulation interval of between 1 and 6 hours.
Input a time range of "0:00" to 23:59".

<TIPS>

You can check on the main unit the scheduled time you set.="8-23. Check circulation schedule >>P.241".

% Brother GTX pro Maintenance

Step 2:
Set the scheduled time for white ink circulation.

Current time 10:47

Start time for white ink drculation

continue.

-Enter the start time for white ink circulation.

- Input a time range of "0:00" to “23:59".
For example, when setting the time "8:00," either "800" or "8:00" can be input.

-Enter at least 6 start times.

cu[ I ] om[ | oOm om[ |
Oow| | om[ | Om | om[ |

Confirm that the date and time of your PC is set for 2018 or later and

- Enter setting that results in 2 white ink drculation interval of between 1 and 6 hours.
- Select the time to start the enhanced white ink crculation with the corresponding radio button,

Cancel
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7-5. When Not Using for a Long Period of Time

When the printer will not be used for a prolonged period of time, take appropriate procedures before storing the printer

depending on storage period or condition.

<IMPORTANT>

. Do not turn the printer off. Otherwise, the printer may be damaged.

. If the power source to the printer cannot be sustained, please contact your dealer in advance.

<NOTE>

. If any error message is displayed on the screen, follow the instructions.

. When storing the printer for more than two weeks, cleaning of the nozzle guard, wiper and exhaust cap should be performed.
="7-1-3. Cleaning the nozzle guard, wiper, exhaust cap, and suction cap >>P.174"

7-5-1. When Not Using for a Long Period of Time: within 2 weeks

The printer can be used through normal procedure after the storage period, by performing the following maintenance
tasks.

(1) Check the amount of waste ink in the waste ink tank, and if the tank is filled with waste ink up to its one-half or
higher level, discard the ink.== "6-2-1. Confirmation and disposal of waste ink >>P.116"

(2) Check the amount of cleaning solution in the cleaning liquid tank, and refill the tank when its amount is below the
proper level.= "6-2-2. Confirmation and refilling of cleaning solution >>P.117"

(3) Stir the white ink if a white ink cartridge stirring message is displayed on the operation panel screen.= "6-2-3. Daily
agitation of the white ink >>P.118"

(4) Asrequired, print out a nozzle check pattern.== "7-2-1. Print out of the nozzle check pattern (checking on the print

heads) >>P.199"

7-5-2. When Not Using for a Long Period of Time: more than 2 weeks

Perform the following maintenance every two weeks.

(1) Check the amount of waste ink in the waste ink tank, and if the tank is filled with the waste ink up to its one-half or
higher level, discard the ink.= "6-2-1. Confirmation and disposal of waste ink >>P.116".

(2) Check the amount of cleaning solution in the cleaning liquid tank, and refill the tank when its amount is below the
proper level.= "6-2-2. Confirmation and refilling of cleaning solution >>P.117".

(3) Stir the white ink if a white ink cartridge stirring message is displayed on the operation panel screen.="6-2-3. Daily
agitation of the white ink >>P.118"

(4) Print out a nozzle check pattern and verify the result.= "7-2-1. Print out of the nozzle check pattern (checking on
the print heads) >>P.199"

(5) If a non-firing nozzle is found, perform head cleaning and run the nozzle check pattern print, and verify the result

again.s "7-2-2. Head cleaning >>P.201".
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7-5-3. When Not Using for a Long Period of Time: within 2 weeks with white ink pause mode

The printer can be used through normal procedure after the storage period, by performing the following maintenance
tasks.

1

)

@)

Check the amount of waste ink in the waste ink tank, and if the tank is filled with the waste ink up to its one-half or
higher level, discard the ink.= "6-2-1. Confirmation and disposal of waste ink >>P.116"

Check the amount of cleaning solution in the cleaning liquid tank, and refill the tank when its amount is below the
proper level.= "6-2-2. Confirmation and refilling of cleaning solution >>P.117"

As required, print out a nozzle check pattern for the color side.= "7-2-1. Print out of the nozzle check pattern

(checking on the print heads) >>P.199"
<TIPS>
. For the White ink pause mode, print the nozzle check patterns for the head only on the color side.

7-5-4. When Not Using for a Long Period of Time: more than 2 weeks with white ink pause mode

Perform the following maintenance every two weeks.

(1

(2)

©)

(4)

(5)

Check the amount of waste ink in the waste ink tank, and if the tank is filled with the waste ink up to its one-half or
higher level, discard the ink.= "6-2-1. Confirmation and disposal of waste ink >>P.116"

Check the amount of cleaning solution in the cleaning liquid tank, and refill the tank when its amount is below the
proper level.= "6-2-2. Confirmation and refilling of cleaning solution >>P.117"

Print out a nozzle check pattern on the color side and verify the result.== "7-2-1. Print out of the nozzle check

pattern (checking on the print heads) >>P.199"
<TIPS>
. For the White ink pause mode, print the nozzle check patterns for the head only on the color side.

If a non-firing nozzle is found, perform head cleaning and run the nozzle check pattern print, and verify the result
again.== "7-2-2. Head cleaning >>P.201"

Perform the normal white head cleaning.= "7-2-2. Head cleaning >>P.201"
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n What to do when needed

As required, make settings and adjustments as mentioned below.

About menu layer on the setting screen

Menu Setting screen Description

[Auto]

[Print Direction] [Always Bi-Directional]

[Always Uni-Directional]

[Light High]

[Back Light] [Light Medium]

[Light Low]

[No Auto Screen Erase]

[5 min]

[Auto Screen Erase Time] [10 min]

[15 min]

[30 min]

[1min]

[Menu TimeOut Setting] [3min]

[5min]

[Speaker Volume] Oto7

[Fahrenheit]

[Temperature] -
[Centigrade]

[display it upward]

Preview display settings
[ play settings] [display it downward]

[Priority to file name display]

[File name display setting] — 5 -
[Priority to job name display]

[Check when platen is loading]

[Printer Setting] [Platen Obstacle sensor] , —

[Check during printing as well]
[Enable]

[Platen too low sensor] -
[Disable]
[Enable(Normal)]

[Low Temperature Mode] -
[Disable]

[Auto Cleaning Setting] 1t024
Conduct before Printin

[Auto Cleaning Start Timing] [ . : I_ ing]
[Conduct after Printing]

[every 40 lines]

[normal 22 lines]

Flushing Interval Settin
[ g J [every 10 lines]

[every 6 lines]

[More]

[Flushing Volume Setting] [Standard]

[Less]

[Standard]

[Wiping frequency] [Medium-high]

[High]

[OFF]

[Auto Job Delete] ON]

[Manual setting]

[IP Address Set]

[Automatic acquisition]

227



Menu Setting screen Description
[Network filtering] [Eﬁable]
[Disable]
[Normal cleaning]
[Shortcut button setting] [Au.to cleaning]
[Printer Setting] [Print data Load] _
[White Ink Circulation]
[Cartridge Attach/Remove Check] [Check]
[No check]
[CR Speed Adjustment] [Start]
[Start (after cleaning/setup)]
[Total Print]
[CTG Attach/Remove History]
[Check circulation schedule]
[Temperature/Humidity Info]
[IP Address]
[Subnet Mask]
[Confirm network setting] [Default Gateway]
[Host name]
[MAC address]
[English]
[Espaniol]
[Francais]
[Deutsch]
[ltaliano]
[Language] (B
]
[Turkee]
[Pycckuin]
[ehH=0]
[Firm Version]
Version] [Data Info]
[Serial No.]

[Head information]
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What to do when needed

8-1. Setting the print direction

(1) From the menu, select [Printer Setting] > [Print Direction], and press @ .

(2) Select your desired print direction of the print heads, and press @ .

<TIPS>

. The print direction is displayed here in the form of either bi-directional or the uni-directional iconz.

o Note that the setting of the print direction gives priority to the printer's setting over the setting of the printer driver.

. The setting content will be kept intact until it is changed for the next printing job.

Print Direction
Auto

Always Bi-Directional

Always Uni-Directional

8-2. Screen back light adjustment

(1) From the menu, select [Printer Setting] > [Back Light], and press @ .

(2) Select your desired brightness of Liquid crystal panel, and press @ .

<TIPS>
. During this menu selection process, the screen is displayed with the selected brightness.

Back Light
Light High
Light Medium

Light Low
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What to do when needed

8-3. Setup of Auto Screen Erase Time

(1) From the menu, select [Printer Setting] > [Auto Screen Erase Time], and press @ .

(2) Select your desired time until the liquid crystal panel and print button become unlit, and press ® .
<TIPS>

. During this menu selection process, the currently selected set value is displayed.

Auto Screen Erase Time

No Auto Screen Erase

5 min
10 min
15 min
30 min

8-4. Setting the menu timeout period

(1) From the menu, select [Printer Setting] > [Menu TimeOut Setting], and press @ .

(2) Select the time before the display screen returns to the standby mode screen, and press @ .
<TIPS>

. During this menu selection process, the currently selected set value is displayed.
Menu TimeOut Setting
min

3min

Bmin
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8-5. Speaker volume adjustment

(1) From the menu, select [Printer Setting] > [Speaker Volume], and press @ .

(2) Adjust the speaker volume in eight-step scale from 0 to 7, and press @ .
<TIPS>
o You can adjust the volume while checking it.

Speaker Volume

D

Set to OK to Confirm

8-6. Setup of temperature indication

(1) From the menu, select [Printer Setting] > [Temperature], and press @ .

(2) Select your desired unit of ambient temperature to be shown on the liquid crystal panel, and press @ .
Temperature
Fahrenheit

Centigrade
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8-7. Preview display settings

Set the display direction of the preview image.

(1) From the menu, select [Printer Setting] > [Preview display settings], and press @ .

(2) Select the display direction and press @ .
<TIPS>

. During this menu selection process, the currently selected set value is displayed.
Preview display settings
display it upward

display it downward

8-8. File name display setting

Make file name display settings of print data.

The display name you set is reflected in the selection screen of standby mode or receiving history or the USB memory
loading screen.

(1) From the menu, select [Printer Setting] > [File name display setting], and press @ .

(2) Select the display method and press @ .
<TIPS>

. The job name is set automatically by the image editing application.
File name display setting
Priority to file name display 0K
Priority to job name display
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8-9. Platen Obstacle sensor

Specify the detection mode of the obstacle sensor by selecting either [Check when platen is loading] or [Check during
printing as well].

What to do when needed >

(1) From the menu, select [Printer Setting] > [Platen Obstacle sensor], and press @ .

(2) Select the obstacle sensor setting and press @ .

<TIPS>

. During this menu selection process, the currently selected set value is displayed.

. The obstacle sensor is intended to detect wrinkles of the print media or foreign object on it to prevent the print head from
contacting wrinkles or foreign matter or minimize the time during which the contact continues.

o If the print head comes into contact with wrinkles or foreign object, a failure to eject ink-jet droplets or a mechanical failure may
occur.

. If the obstacle sensor detects a foreign object, the printing process and the platen operation are immediately stopped.

° If you select [Check when platen is loading], the obstacle sensor works only while the platen is moving from the front to the rear.

o If you select [Check during printing as well], the obstacle sensor works during the period from when you press the print button to
when the printing process completes.

Obstcl sensr settng during print

Check when platen is loading

Check during printing as well

8-10. Platen too low sensor

The sensor is activated if it detects that the print medium is far because the platen is too low.
Enable or disable this function when using the printer.

(1) From the menu, select [Printer Setting] > [Platen too low sensor], and press @ .

(2) Select the Platen too low sensor function and press @ .

<TIPS>
. The platen too low sensor checks if the platen is too low when it is completely inserted.
. If the platen too low sensor is activated, the printing process and the platen operation are immediately stopped.

Platen too low sensor
Enable
Disable
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What to do when needed

8-11. Print Operation Settings Under Low Temperature

Configure the printer with automatic switching to low temperature operation mode for ensuring print quality when [Temp
Low] is displayed on the liquid crystal panel. It is set to [Enable(Normal)], by default.

If the low temperature operation mode is enabled, the printer will automatically be switched to the low temperature
operation. Although it can assure print quality, it may take longer time for printing.

If the low temperature operation mode is disabled, print speed will not slow down; however, poor ejection may occur.

(1) From the menu, select [Printer Setting] > [Low Temperature Mode], and press @ .

(2) Select the print mode under low temperature and press @ .

<TIPS>
. When [Disable] is selected, white ink injection may become unstable when trying to print a wide area.

Low Temperature Mode
Enable(Nomal)
Disable
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8-12. Auto Cleaning Setting

Setting the Number of Printed Sheets for Auto Cleaning

Specify the number of printed sheets as the frequency of Auto Cleaning; where head cleaning is automatically
performed every time a predetermined number of sheets are printed in order to protect the printer and provide stable
printing quality. If the printing quality deteriorates in continuous printing, decrease the number of printed sheets for Auto
Cleaning. The default value is 24.

(1) From the menu, select [Printer Setting] > [Auto Cleaning Setting], and press @ )

(2) Press A ./'¥ tosetup the number of sheets to be printed in the range between 1 and 24, and press @ .

<TIPS>

o The printing quality tends to deteriorate if the humidity is low.

. If the auto cleaning is performed more frequently, the Wiper cleaner and flushing foam will need to be replaced with a new one
earlier.

Auto Cleaning Setting

Y

Set to OK to Confirm

Auto Cleaning Start Timing
Specify your desired auto cleaning start timing.
(1) From the menu, select [Printer Setting] > [Auto Cleaning Start Timing], and press @ .

(2) Select your desired auto cleaning start timing, and press @ .

<TIPS>
o Even when [Conduct after Printing] is selected, Auto Cleaning may be performed before printing, depending on the state of use.

Auto Cleaning Start Timing
Conduct before Printing

Conduct after Printing
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What to do when needed

8-13. Flushing Interval Setting

Perform this if the printing quality deteriorates during printing operations.

(1) From the menu, select [Printer Setting] > [Flushing Interval Setting], and press @ .

(2) Select the desired number of scanning operations until the flushing starts, and press @ .

<TIPS>

. The printing quality tends to deteriorate during the printing operation if the humidity is low.

. Setting shorter flushing intervals improves the printing quality, however, increases the ink consumption and increases the time
required for printing.

Flushing Interval Setting

every 40 |ines

normal 22 |ines
every 10 lines
every B. |ines

8-14. Flushing Volume Setting

Perform this if the printing quality deteriorates at the startup of the printing operation.
(1) From the menu, select [Printer Setting] > [Flushing Volume Setting], and press @ .

(2) Select your desired volume of ink to be ejected from the print heads during the flushing operation before the

printing operation starts, and press @ .

<TIPS>
. The printing quality tends to deteriorate at the startup of the printing operation if the humidity is low.
. Setting larger flushing volume improves the printing quality, however, increases the ink consumption.

Flushing Volume Setting
More

Standard

Less
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8-15. Wiping frequency settings

Perform this if the white printing quality deteriorates while printing.

(1) From the menu, select [Printer Setting] > [Wiping frequency], and press @ .

(2) Select the target [Wiping frequency] while printing, and press @ .

<TIPS>

. The printing quality tends to deteriorate while printing if the temperature is low.

° Frequent wipes will improve the printing quality, which, however, will take more time to print.

Wiping frequency
Standard
Medium-high

High

8-16. Automatic deletion of print data

(1) From the menu, select [Printer Setting] > [Auto Job Delete], and press @ .
(2) Select the desired function of Auto Job Delete, and press @ .

Auto Job Delete

OFF

ON
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What to do when needed

>

8-17. Static IP address setting

In the [IP Address Set] window, select the manual setting or automatic acquisition, and set up the [IP Address], [Subnet
Mask] and [Default Gateway] when you select the manual setting.

From the menu, select [Printer Setting] > [IP Address Set], and press @ .

™
@)

@3)
(4)
(5)

|P Address Set I[P Address Set
IP Address Subnet Mask

0K to Subnet Mask Screen OK to Gateway Screen

192.168.000.00 1 255.255.255.000

Select either [Manual setting] or [Automatic acquisition] and press @ .
<TIPS>

. If you select [Automatic acquisition], the screen will go back to the standby mode screen after the settings are automatically

acquired.
IP Address Set
Automatic acquisition

Manual setting

To make manual settings, press 4 ./ P to move to and select your desired position.

To make manual settings, press A /¥ to specify your desired numeric value.

When the @ button is pressed, the selected value is accepted, and the display screen goes to the [IP

Address], [Subnet Mask] and [Default Gateway] in an orderly manner.
<TIPS>

. The display screen shown here has been taken as an example.
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What to do when needed

8-18. Network filtering settings

This function will enhance LAN security. Enable or disable this function when using the printer. Setting this function to
[Enable] will allow access only from subnet mask to which LAN-connected GTX belongs. It is set to [Disable], by default.

(1) From the menu, select [Printer Setting] > [Network filtering], and press @ .
(2) Select [Enable] or [Disable] and press @ .

Network filtering

Enable

Disable

8-19. Shortcut button setting

You can set the operation that takes place when the shortcut button on the operation panel is pressed.

(1) From the menu, select [Printer Setting] > [Shortcut button setting], and press @ .

(2) Select the function and press @ .

<TIPS>

. During this menu selection process, the currently selected set value is displayed.

o If you select [Normal Cleaning], you will be presented with the Normal Cleaning Head Selection menu.
. If you select [Auto Cleaning], Auto-Cleaning begins.

° If you select [Print Data Load], you will be presented with the screen to select the print data to load.

. If you select [White Ink Circulation], the white ink circulation begins.

Shortcut button setting
Normal cleaning

Auto cleaning

Print Data Load

White Ink Circulation
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8-20. Cartridge Attach/Remove Check

This check function prevents the agitation omission and insufficient agitation of the white ink cartridge.

Enable or disable this function when using the printer.

Agitate the white ink cartridge if the white ink cartridge stirring message is displayed.= "6-2-3. Daily agitation of the
white ink >>P.118"

<TIPS>

. It takes about 60 to 120 seconds to agitate the W12 or W34 cartridge.

. If the period in which each cartridge is removed is less than 60 seconds, you cannot move to the next screen by pressing @

while the white ink cartridge stirring message is displayed.

(1) From the menu, select [Printer Setting] > [Cartridge Attach/Remove Check], and press @ .
(2) Select either [Check] or [Uncheck] and press ® .

Cartridge Attach/Remove Check

Check

No check

8-21. Display of total printed sheets

On this display screen, the total number of printed sheets is shown.
(1) From the menu, select [Total Print], and press @ .

(2) Then, the total number of printed sheets is displayed.

<TIPS>
. Only the number of printed sheets of which printing has succeeded is counted, in which the canceled number of sheets is
not included.

. All the printed sheets involved in printing operation, including test print, are counted.
. The display screen shown here has been taken as an example.
3 The count of total number of printed sheets cannot be reset.

Total Print

530

Press OK to Return

240



8-22. Cartridge Attach/Remove Check History

This function makes it possible to display records on the state of the white ink cartridge removed for 60 seconds or more.
You can use this function to check whether the agitation of the white ink cartridge is performed regularly.

(1) From the menu, select [Cartridge Attach/Remove Check History], and press @ .

(2) The cartridge attach/remove check history is displayed, and you can use the A a4 keys to see the records on

cartridge attachment and removal.
CTG Attach/Remove History
30/09 08:19

30/09 08:19

27/09 08:35
27/09 08:35
26/09 08:25

[W12] 199 Sec
[W34] 204 Sec
[W12] 105 Sec
[W34] 90 Sec
[W12] 237 Sec

8-23. Check circulation schedule

White ink circulation can be performed at a specified time.

(1) From the menu, select [Check circulation schedule], and press @ .

(2) Display the circulation schedule.
<TIPS>

. If the scheduled time of white ink circulation is not set with the maintenance tool, the circulation schedule will not be displayed.

Check circulation schedule

Current time

17

00:30 (Long)

07:00
18:30
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8-24. Display of Temperature/Humidity Info

On this display screen, the ambient temperature and humidity are shown.

(1) From the menu, select [Temperature/Humidity Info], and press @ .

(2) Then, the ambient temperature and humidity are displayed.

<TIPS>
. Make the setting of temperature indication unit in the Temperature window.
. The display screen shown here has been taken as an example.

Temperature/Humidity Info

Temperature [ 25°C]

Humidity [ 78 %]

Press OK to Return
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8-25. Confirm network setting

In the [Confirm network setting] window, display the [IP Address], [Subnet Mask], [Default Gateway], [Host name], and
[MAC address].

(1) From the menu, select [Confirm network setting], and press @ .

(2) Select one out of the [IP Address], [Subnet Mask], [Default Gateway], [Host name], and [MAC address], and press

S

Confirm network setting
|P Address
Subnet Mask

Default Gateway
Host name
MAC address

(3) Display [IP Address], [Subnet Mask], [Default Gateway], [Host name], or [MAC address].
<TIPS>

. The display screen shown here has been taken as an example.

IP Address Subnet Mask

192.168.000.001 255.255.255.000

Press OK to Return Press OK to Return

Default Gateway Host name

000.000.000.000 GTRA-XKXXXX

Press OK to Return Press OK to Return

MAC address

00:1B:A9:FD:BC:27

Press OK to Return
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8-26. Language setting

Select your desired language to be shown on the liquid crystal panel.

(1) From the menu, select [Language], and press @ .

(2) Select your desired language in the [Language] window, and finalize your setting by pressing @ .

(3) Follow the on-screen message, and turn off the power and on again.

Language

English
Espanol
Francais
Deutsch

[tal iano
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8-27. Display of version

On this display screen, the firmware's version information, [Firm Version], as well as [Data Info] and [Serial No.], are
shown.

(1) From the menu, select [Version], and press @ .

(2) Inthe window shown below, select one of the [Firm Version], [Data Info] and [Serial No.], and press @ .

Version

Firm Version
Data Info

Serial No.

Head information

(3) Then, one of the [Firm Version], [Data Info] and [Serial No.] will appear.

<TIPS>
. Pressing the <« button causes the currently displayed window to go back to the [Version] window.
. The display screen shown here has been taken as an example.

Firm Version Data Info

Main 0.65.0000 Message 0.19.0000
MNT  0.64.0000/ 0.64.0000 Font 1.00.0000
LCD  0.57.0000 Test Print 0.00.0007
Head 0.64.0000/ 0.64.0000

BTL  0.57.0000

Serial No. Head information
White

Serial No.  ABCDEFG1 Head No:XAA0026 V.Rating:10
Color

Hardware 1D 1.0 Head No:GXDI036 V.Rating:10
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What to do when needed >

8-27-1. Updating of firmware

When a new firmware is released, please update the firmware.
<TIPS>
. To check any release information of a new firmware, please visit the website of Brother Industries, Ltd.

(1) Download the firmware's updated data from the website of Brother Industries, Ltd.
(2) On the PC, from [All Programs] in the Start menu, select the "GTX pro Firmware Update" from "Brother GTX pro
Tools".

(3) Specify the firmware's updated data (.bwf).

%' GTX pro Firmware Update X

Select the Firmware Update Data (" bwf).

s

< Back MNext > Cancel

(4) Make a connection of the USB 2.0 cable or LAN cable between your PC and the printer, and update your firmware

by performing the on-screen procedures.
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n Troubleshooting

A\CAUTION

Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand
may get caught between the platen and an object, which may result in injury.

Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and
the covers, it may be injured.

Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may
touch against moving parts and this may result in injury.

Be careful not to get your fingers caught when closing the front cover, otherwise it may result in injury to your
fingers.

When you mount or replace the head, be careful not to get your hands or fingers caught. Otherwise you may
be injured.

Do not drink liquids such as the ink, maintenance solution, cleaning solution, pretreatment, or waste. They
may cause diarrhea or vomiting.

Avoid causing your eyes or skin to make contact with the ink, maintenance solution, cleaning solution,
pretreatment or waste. It may cause inflammation. In case of contact with eyes, do not rub but immediately
rinse the eyes with water.

Keep the liquids out of the reach of children.

QObPop

Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your
eyes or onto your skin.

It can cause inflammation. Do not drink or eat the grease. It may cause diarrhea or vomiting.

Keep the liquids out of the reach of children.

When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother
will not be held responsible for any accidents or problems resulting from the use of non-genuine parts.

When replacing parts or installing optional accessories, be sure to follow the procedures described in the
Instruction Manual. Incorrect procedures could cause injuries or problems.

C1)IMPORTANT

® Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.
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Troubleshooting

9-1. Troubleshooting instructions

With reference to the descriptions below, troubleshoot your problem.

No print data can be sent from PC

Probable Cause

Remedy

Reference

Have you selected an incorrect
printer or not?

From the menu for printing, check your printer name.

Has a USB or LAN cable been
connected properly?

Ascertain that connection of the USB 2.0 cable or the
LAN cable has been made correctly.

Are you using such PC or OS that
is outside the specification?

Check your PC's operating environment.

"11-2. Software >>P.351"

Are you using such a USB 2.0
cable that is outside the
specification?

Use a 2.0 cable that is compliant with the
specification.

"1-3. Other items you
must make available for
use >>p.22"

Has any noise been produced
between the printer and your PC?

Remove the USB 2.0 cable/LAN cable first, then
make a connection of it once again in five seconds. If
the problem continues, power off the printer first, then
reactivate it in five seconds.

Does your PC function properly?

Restart the PC.

Has any other USB device been
connected to your PC?

Remove the other USB device, restart the PC, and
check to see if the printer functions properly.

Has the USB cable/LAN cable
been damaged?

Use a different USB or LAN cable.

No printing job gets started even after pressing the print button

Probable Cause

Remedy

Reference

Is the print scheduled (is the button
flashing fast)?

The print begins as soon as the printer becomes
available. Wait for a while.

Is any error message displayed?

Eliminate the cause of the error, and perform printing
once more..

"10. Error message
>>P.311"

Does the menu screen still appear
on the screen, or are you
performing the maintenance
operation from the menu?

Please exit the menu. Alternatively, please wait until
the maintenance operation will come to an end.

Is the automatic head cleaning
operation underway?

Please wait until the ongoing head cleaning
operation is completed.

Is the printer in the white ink
circulation stage?

Please wait until the ongoing white ink circulation is
completed.

Is the room temperature suited to
the usage conditions?

Check for your PC's operating environment and
adjust the room temperature.

"11-1. Apparatus >>P.350"

Does the printer receive no print
data, oris it in the state to receive
such data (the print button is not
illuminating)?

Send the print data to the printer. Alternatively, please
wait until the reception of print data is completed.

Do you find that the temperature of
print heads is

becoming high, and [Color Head
Getting Warm] or [W Head Temp
Rising] message appears?

There may be the possibility that the flat cables of
print heads have not been put in place and the
temperature of print heads has become high.

Turn off the power, make sure that the flat cable is in
place, and wait until the temperature decreases.
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The power cannot be turned on

Probable Cause Remedy Reference
Is the power cord connected to Make sure that the power cord is connected to the
the printer? printer. i
Is the front cover closed firmly? Close the front cover properly. -
An error occurs immediately after activating the printer

Probable Cause Remedy Reference
Is any error message displayed? | Check the content of the error, and restart the printer. | "10. Error message

If the error is still not eliminated, please contact your | >>P.311"
dealer or Brother.

No print data can be loaded from USB flash memory

Probable Cause Remedy Reference
Has the USB flash memory been | Insert the USB flash memory into the insertion slot
inserted into its insertion slot firmly. -
properly?
Is the applicable file ARP or AR3 | This printer cannot print out the print data of
file? GT-541/GT-782/GT-3. Recreate the print data. i
Is your USB flash memory suited | Please use a FAT32-formatted USB flash memory of
to required conditions? which storage capacity ranges from 2 GB to 32 GB.

You cannot use a USB memory with security functions i
such as password lock or beyond 32 GB.

Has your USB flash memory Check to see if it functions properly using your PC or
been broken? the like. )
Neither uni-directional printing nor bi-directional printing can be performed

Probable Cause Remedy Reference
Do the settings of printer driver Note that the setting of the printer's setting has priority | "8-1. Setting the print
and printer agree with each over the setting of printer driver. The printer driver's direction >>pP.229"

other?

setup value takes effect only if the printer's setting is
[Auto].

249



The depletion of ink in an ink pouch cannot be detected

Troubleshooting

>

Probable Cause

Remedy

Reference

Is an ink pouch in its correct
position?

If the ink pouch is in contact with the side of the ink
cartridge case, detection may not be performed
correctly.

Put a proper ink pouch in its correct position.

"7-1-1. Replacement of
ink pouch with a new one
>>P.169"

After stirring the white ink, is the
lid of the ink cartridge opened
and the pouch placed in the
correct position?

Open the lid of the white ink cartridge and
appropriately rewind the ink pouch. Ink might have
entered into the wound section of the pouch when
stirred, which could have caused improper winding of
the pouch.

"6-2-3. Daily agitation of
the white ink >>P.118"

"x" is displayed for the remaining ink level after replacing the ink pouch

Probable Cause Remedy Reference
Is a wrong color of an ink pouch Put an ink pouch in its correct position. If colors are
installed? mixed on the print result or within the ink pouch, -
please contact your dealer.
Remaining volume indication of the ink pouch does not reflect the actual status
Probable Cause Remedy Reference

Didn't you replace an ink pouch in
the way of use?

If you take out an ink pouch that still has much amount
of remaining ink in the way of use, then set a different
ink pouch or the original used ink pouch back to the
printer, it can indicate a different volume from the
actual remaining volume. If you keep on using it and
the volume is reduced to some extent, the correct
remaining volume will be displayed again.
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Troubleshooting

9-2. Solutions to print quality problems

With reference to the descriptions below, troubleshoot your problem.

Print is too light

Probable Cause

Remedy

Reference

Is the setting of an image editing
software application made
improperly, or is an image placed
in CMYK mode?

Edit the image.

"5-3. Using other
applications >>P.70"

Have the printing conditions been
applied improperly, or does your
image data have insufficient color
saturation?

Using [Color Processing], adjust saturation or contrast
as appropriate.

"5-4-9. Set up the image
quality >>P.103"

Is a sufficient amount of ink left in
a cartridge?

Replace the old ink pouch with a new one.

"7-1-1. Replacement of
ink pouch with a new one
>>P.169"

Is there any nozzle that does not
eject ink-jet droplets?

Perform [Head Cleaning] from the menu.
If no improvement is attained, follow the referenced
instructions.

"9-2-1. Recovery action to
be taken for such a nozzle
that is unable to eject
ink-jet droplets >>P.257"

Is initial settings after head

With reference to, configure the initial settings after

"7-4-2. Initial settings after

replacement configured? head replacement. head replacement
>>pP217"

Isn't the [Low Temperature Mode] | Change the setting to [Enable (Normal)]. "8-11. Print Operation

set to [Disable]? Settings Under Low

Temperature >>P.234"

Horizontal stripe (banding) is found on printed material

Probable Cause

Remedy

Reference

Is there any nozzle that does not
eject ink-jet droplets?

Perform [Head Cleaning] from the menu.
If no improvement is attained, follow the referenced
instructions.

"9-2-1. Recovery action to
be taken for such a nozzle
that is unable to eject

ink-jet droplets >>P.257"
Do you print ink dots on a highly Set the print head's print direction to [Always "8-1. Setting the print
water-absorbing print medium? Uni-Directionall]. direction >>P.229"

Also, combine the color multiple pass printing with
the printing.

"5-4-6. Specify whether or
not to perform Multiple

Pass Printing >>P.98"
Is the platen positioned at too low Adjust the height of the platen corresponding to the | "6-5. Placing print medium
level? print medium before using it. You can use the platen | in position >>P.148"

height adjustment lever to adjust the height of platen.
As a rough indication, adjust the height so that it is
lowered by one step from the limit height detected by
the obstacle sensor, and check that the platen is not
detected by the sensor.

Is the firing timing well-timed?

Adjust the ejection timing again. It is likely that the
setup value is incorrectly set after replacing a print
head or the platen with a new one, or after adjusting
the platen height.

"7-4-3. Firing adjustment
>>pP.218"
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print head or the platen with a new one.

Probable Cause Remedy Reference
Is platen feed adjusted? Perform the platen feed adjustment. It is likely that "7-4-4. Platen-rolling
the setup value is incorrectly set after replacing a adjustment >>P.219"

Is the [White High Speed Print]
check box of the print data turned
on?

Turn off the [White High Speed Print] check box to
create the print data.

"5-4-4. Set up the white
ink >>P.94"

Isn't the temperature low?

Change the wiping frequency setting.

"8-15. Wiping frequency

settings >>P.237"
Isn't the [Low Temperature Mode] Change the setting to [Enable (Normal)]. "8-11. Print Operation
set to [Disable]? Settings Under Low

Temperature >>pP.234"

Blurring is observed (when printed with [Color Ink Only])

Probable Cause

Remedy

Reference

Isn't the amount of ink excessive
against the print media?

Print the ink volume and check the blurring, and select
appropriate set value for [Ink Volume:].

"5-5-5. Adjust the ink
volume >>P.109"

"5-4-7. Set up the color ink
>>P.99"

Blurring is observed (when printed with [Color+White Ink])

Probable Cause Remedy Reference
Is the [Highlight:] of [White Ink Print the highlight check pattern to check the blurring, | "5-5-6. Print  out of
Settings:] too high? and select appropriate set value for [Highlight:]. highlight check
pattern/mask check
pattern >>P.110"

"5-4-4. Set up the white
ink >>P.94"

By turning ON the [White/Color Pause] or [Color
Multiple Pass Printing] checkbox, extend time before
the color ink settles onto the white ink, to prevent
blurring. Try this method to eliminate blurring without
weakening the highlight.

"5-4-8. Set up the white
ink >>P.100"

"5-4-6. Specify whether or
not to perform Multiple
Pass Printing >>P.98"
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Ink sticks to such an area where no print data exists (ink stain, horizontal stripe, etc.)

>

Probable Cause

Remedy

Reference

Is the area around the print heads
soiled with waste ink spilled from
the wiper cleaner or head cap?

Clean the head section and suction cap.
Furthermore, replace the wiper cleaner with a new
one.

"7-1-3. Cleaning the
nozzle guard, wiper,
exhaust cap, and suction
cap >>P.174"

"7-1-4. Replacing the
wiper cleaner >>P.186"

Is any lint attached to the nozzle
surface?

Clean the nozzle guard.

"7-1-3. Cleaning the
nozzle guard, wiper,
exhaust cap, and suction
cap >>P.174"

Is the carriage plate contaminated?

Clean the carriage plate.

"7-2-4. Cleaning the CR

(carriage) plate >>P.204"
Do the print heads rub against a Flatten the surface of T-shirt, and adjust the platen's | "6-5. Placing print medium
T-shirt? height as required. in position >>P.148"
Has the flushing foam become Replace the flushing foam with a new one. "7-1-5. Replacing the
dirty? flushing foam >>P.189"
Has the platen sheet become Replace the platen sheet with a new one. "7-2-5. Replacing the
dirty? platen sheet >>P.207"
Has any ink attached to the Perform the cleaning of the carriage plate and "7-2-4. Cleaning the CR
carriage that secures the print remove the accumulated ink. (carriage) plate >>P.204"

heads in place or is it dripping off?

The edges of the image are blurred, characters and straight lines are doubly printed and printed

result appears too granular

Probable Cause Remedy Reference
Is the platen positioned at a level | Adjust the height of the platen corresponding to the "6-5. Placing print medium
that is too low? print medium before using it. You can use the platen in position >>P.148"

height adjustment lever to adjust the height of platen.
As a rough indication, adjust the height so that it is
lowered by one step from the limit height detected by
the obstacle sensor, and check that the platen is not
detected by the sensor.

Is the firing timing correct?

Adjust the ejection timing again. It is likely that the
setup value is incorrectly set after replacing a print
head or the platen with a new one, or after adjusting
the platen height.

"7-4-3. Firing adjustment
>>p.218"

Is the image enlarged on the
printer setting screen?

When a low resolution image is enlarged on the
printer setting screen, it may blur or angle the image.
Pattern data should be enlarged on an image editing
application, and its roughness should be checked.
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Thin color cannot be printed out well gradually

Troubleshooting

>

Probable Cause Remedy Reference
Is the ambient atmosphere at a Perform the flushing more frequently. In addition, "8-13. Flushing Interval
high temperature and very dry, increase the flushing volume. Setting >>P.236"
which in turn tends to cause the "8-14. Flushing Volume
nozzle surface to dry up? Setting >>P.236"
White ink is not printed out evenly

Probable Cause Remedy Reference

Has the pretreatment been
applied unevenly?

Apply the recommended amount of pretreatment
evenly to the target area.

"6-3-3. Application of
pretreatment >>P.126"

Has the pretreatment caused any
change in hardness or
deformation of the pretreatment
roller? (This applies to the case
where the pretreatment roller is
used.)

After the pretreatment roller is used, put it in a plastic
bag or the like hermetically to prevent it from drying
up, and keep it in a flat place in an upright position.
Also, when it remains unused for two weeks or
longer, wash it well with running water, and let it dry in
a shaded area.

Is any water content attached to
the pretreatment roller after the
pretreatment is fixated?

Prevent water content from being attached to the
roller after the pretreatment is fixated.

"6-3-4. Fixation of
pretreatment >>P.132"

Is there any lint, yarn waste, dust,
etc. that are attached to the
surface of pretreatment roller?
(This applies to the case where
the pretreatment roller is used.)

Clean the surface of the pretreatment roller.

"6-3-3. Application of
pretreatment >>P.126"

Did you shake the pretreatment
after its dilution?

Shake the pretreatment sufficiently.

"6-3-2. Dilution of
pretreatment >>P.124"

Is the [Low Temperature Mode]
set to [Disable]?

Change the setting to [Enable (Normal)].

"8-11. Print Operation
Settings Under Low
Temperature >>P.234"

Has the pretreatment been fixated
insufficiently?

Check on an actual temperature of the heat press
and its pressure during the fixation stage.

Always keeping the lower iron (where media is
placed) of the heat press at heated temperature with
a heating source may solve this problem.

"6-3-4. Fixation of
pretreatment >>P.132"

Whiteness of print result is insufficient

Probable Cause

Remedy

Reference

Has the pretreatment been
applied insufficiently?

Apply a proper amount of pretreatment.

"6-3-3. Application of
pretreatment >>P.126"

Has the pretreatment been fixated
insufficiently?

Check on an actual temperature of the heat press
and its pressure during the fixation stage.

"6-3-4. Fixation of
pretreatment >>P.132"

Is there any nozzle that does not
eject ink-jet droplets?

Perform [Head Cleaning] from the menu.
If no improvement is attained, follow the referenced
instructions.

"9-2-1. Recovery action to
be taken for such a nozzle
that is unable to eject
ink-jet droplets >>P.257"

Is the white ink circulated
insufficiently?

From the menu, select [Maintenance] > [White Ink
Circulation] to circulate the white ink properly.
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>

Probable Cause

Remedy

Reference

Is the white ink stirred
insufficiently?

In the event that the white ink remains accumulated in
the bottom of the ink pouch, shake the pouch 100
times and additionally shake it until the ink is stirred
well.

Also, when the remaining ink level becomes
approximately 5.9 in. (15 cm), shake the cartridge
with its cover open and with the edge of the ink pouch
slightly winded.

Is the [Low Temperature Mode]
set to [Disable]?

Change the setting to [Enable (Normal)].

"8-11. Print Operation
Settings Under Low
Temperature >>P.234"

Is the dilution rate of the
pretreatment correct?

Dilute the pretreatment appropriately.

"6-3-2. Dilution of
pretreatment >>P.124"

Is the [Highlight:] of [White Ink
Settings:] too low?

Print the highlight check pattern to check the blurring,
and select appropriate set value for [Highlight:].

"5-5-6. Print out of
highlight check
pattern/mask check
pattern >>P.110"
"5-4-4. Set up the white
ink >>P.94"

Too much luster

Probable Cause Remedy Reference
Are you using Teflon-treated Use a silicon coated peel off sheet when curing the
peel-off sheet for fixation? ink to reduce the gloss.
Too fuzzy

Probable Cause Remedy Reference

Did you touch the print media
(T-shirt) just before printing?

Excessively touching the media (T-shirt) on the
platen by trying to flatten the media before printing
could cause fuzziness. Make sure not to touch the
media surface too much after the pretreatment is
fixated.

Does it take a long time before
printing, after the pretreatment
fixation?

Leaving the print media (T-shirt) after fixing the
pretreatment may cause fuzziness, because the
media would absorb water. Print the pretreatment
fixated media as soon as possible.

Is the upper iron on the heat press

contaminated during the
pretreatment fixation process?

If the upper iron is contaminated, it could roughen the
print media (T-shirt) surface by a heat press process,
to cause fuzziness. Clean the upper iron of the heat
press with a cloth.

If the condition persists, try using a peel-off sheet
during the pretreatment fixation process, to probably
improve the condition.

Unevenly dried during the fixation
process?

It may be solved by inserting a silicone foam
between the heat press lower iron and a print media
(T-shirt) during ink fixation.
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Background white ink spreads out when printed with [Color+White Ink]

Probable Cause

Remedy

Reference

[White/Color Alignment]
misaligned?

Misalignment of white and color inks can occur when
the media thickness or the platen height is changed.
Adjust the platen height first for the actual media to be
printed, and align the white and color inks positions.

"7-4-5. White/color
alignment >>P.220"

Is the media easy to stretch when
wet?

Print misalignment may occur between white and
color inks when the media stretches when wet with
white ink. Increasing [Choke Width:] can prohibit
spreading of the background white ink.

"5-4-8. Set up the white
ink >>P.100".

Printed surface cracks after fixation

Probable Cause Remedy Reference
Isn't the print surface folded before | Try not to touch the print surface until the fixation
fixation is completed? process is completed. i
The lower left side area of the printer's main unit is soiled with ink

Probable Cause Remedy Reference
Is the waste ink tube dismounted For help, please contact your dealer.
from the maintenance unit? )
Is the waste ink tube clogged Straighten the waste ink tube to remove the clog.
causing the waste ink to flow -
reversely?
The cleaning solution is leaked from the cleaning liquid tank

Probable Cause Remedy Reference

Is the main body of printer put
aslant?

Place the printer horizontally.
If the problem is still not remedied, please contact your
dealer.

"4-1. Installation of printer
>>P.38"

Takes longer print time than before

Probable Cause Remedy Reference
Is the ambient temperature under Adjust the room temperature to 18°C (64.4°F) or "8-11. Print Operation
18°C (64 .4°F)? more. Settings Under Low

If it is difficult to adjust the room temperature, set the
operational configuration under low temperature to
[Disable].

Temperature >>P.234"

Is your printing under
high-temperature and low humidity
environment?

Lower your room temperature below 30°C (86°F).
Raise your room humidity over 35%.

Is the wiping frequency set to
[Medium-high] or [High]?

Change the wiping frequency to [Standard].
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Recovery action to be taken for such a nozzle that is unable to eject ink-jet droplets

Please verify the followings when any nozzle is not ejecting ink droplets.

Items to be checked

Description

Remedy

Document

Is the cap contaminated?

When the cap is contaminated, it cannot fully
contact the head, which would lead to
suction failure.

Clean the cap

Refer to "7-1-3. Cleaning
the nozzle guard, wiper,
exhaust cap, and suction
cap >>P.174".

Is there any deposit of ink
around the nozzle
surface?

When the surrounding area of nozzle
surface is contaminated, it could lead to
ejection failure since the wiper cannot clean
the nozzle surface properly. Or, it could
reduce the adhesion between the nozzle
and cap, thereby causing ink suction failure.

Cleaning the
surrounding area
of nozzle surface

Refer to "9-2-4. Cleaning
the surrounding area of
nozzle surface >>P.271"

Is the wiper contaminated?

When the wiper tip is contaminated, it could
lead to ejection failure since the wiper
cannot clean the nozzle surface properly.

Clean the wiper

Refer to "7-1-3. Cleaning
the nozzle guard, wiper,
exhaust cap, and suction
cap >>P.174".

Is there any indication of

When the wiper has any scar or

, deformation, it could lead to ejection failure | Replace the Refer to "9-2-7. Replacing
scar or deformation on the | | . , , .
Wiper? since the wiper cannot clean the nozzle wiper the Wiper >>P.303".
' surface.

If the wiper cleaner is contaminated, residual , ,

Is the wiper cleaner ) P i o i Replacing the Refer to "7-1-4. Replacing

, dirt on the wiper may prohibit the wipers ) )

contaminated? ) ) wiper cleaner the wiper cleaner >>P.186".
cleaning function.
If the wiper cleaner is dry, it may prohibit the | Replacing the Refer to "7-1-4. Replacin

Is the wiper cleaner dried? | . P . i , yP , piacing , P g"
wiper's proper function to wipe clean. wiper cleaner the wiper cleaner >>P.186".
If the flushing foam is not placed

Is the flushing foam 9 P Replace the Refer to "7-1-5. Replacing

floated?

appropriately, it may touch the nozzle
surface to stop ejection from the nozzle.

flushing foam

the flushing foam >>P.189".

Is the ink accumulated on
the flushing foam?

If an ink accumulates on the flushing foam,
the ink may touch the nozzle surface to
prevent ink from ejecting.

Replace the
flushing foam

Refer to "7-1-5. Replacing
the flushing foam >>P.189".

If they are loosely mated, it may allow air to

Verify connection

Refer to "9-2-6.

Is the tube correctly enter into the head section during the head | between the )
. ) L Replacement of print head
connected to the head? cleaning operation, to cause non-ejection head and the S>P 277"
condition of the nozzle. tube B
If the ink pouch is not properly installed, the , Refer to "7-1-1.
Is the ink pouch properly i P p. p. y , Install an ink )
i cartridge cannot fully wind it, and fails to Replacement of ink pouch
attached to the cartridge? pouch

supply enough ink to the head.

with a new one >>P.169".

Is the tube filled with ink?

If a large amount of air exists in the tube, that
air will go into the head to cause
non-ejection condition of the nozzle.

Re-install the ink

Refer to "9-2-8. Re-install
the ink >>P.308".

After carrying out appropriate remedial measures listed above, make sure the non-firing nozzle has been recovered. If it
has not, perform the steps 1 to 5 to recover the non-firing nozzle.
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Step 1: Print out a nozzle check pattern

(1) Print out a nozzle check pattern (1st time).== "7-2-1. Print out of the nozzle check pattern (checking on the print
heads) >>P.199"

(2) Check the result of the printed nozzle check pattern (1st time), and carry out the following procedures.= "7-2-1.

Print out of the nozzle check pattern (checking on the print heads) >>P.199"

<TIPS>

. Even if the white print result is weak, since the white ink is ejected on one same spot through multiple nozzles, a relatively
large amount of ink volume will be used, and the firing problem of a single nozzle will not affect the print quality so much.
Even in a condition with weak lines, the print is performed without a problem.

Existence or nonexistence of a
nozzle that does not eject any Recovery action
ink-jet droplets
Such a nozzle does not exist that | If a number of non-firing of white head is observed in printing although such
does not eject any ink-jet droplets | non-firing problems do not occur in nozzle check pattern printing, please
contact your dealer.
If a number of non-firing of white head is observed in printing although such
non-firing problems do not occur in nozzle check pattern printing, replace
the filter. ="9-2-5. Replacing the color filter >>P.274" If non-firing cannot be
resolved after replacing the filter, please contact your dealer.
Such a nozzle exists that does not | Proceed to Step 2.
eject any ink-jet droplets
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Step 2: Perform the head cleaning

(1) Perform a normal cleaning.= "7-2-2. Head cleaning >>P.201"
(2) Print out a nozzle check pattern (2nd time).

(3) Check the result of the printed nozzle check pattern (2nd time), and carry out the following procedures.
Existence or nonexistence of a
nozzle that does not eject any Recovery action

ink-jet droplets

Such a nozzle does not exist that | Exit

does not eject any ink-jet droplets

Ten-or-less nozzles exist that do Perform the normal cleaning once again. Subsequently, proceed to (4).

not eject any ink-jet droplets

Ten-or-more nozzles existthatdo | Perform the powerful cleaning. Subsequently, proceed to (4).
not eject any ink-jet droplets
More than half of the nozzles of Re-install the ink. ="9-2-8. Re-install the ink >>P.308"
the color heads have a problem Subsequently, proceed to (4).

concerning firing of the print
heads.

More than half of the nozzles of Clean the white heads. ="9-2-2. White head cleaning >>P.262"
the white heads have a problem Subsequently, proceed to (4).

concerning firing of the print
heads.

(4) Print out a nozzle check pattern (3rd time).

(5) Check the result of the printed nozzle check pattern (3rd time), and carry out the following procedures.
Existence or nonexistence of a
nozzle that does not eject any Recovery action

ink-jet droplets

Such a nozzle does not exist that | Exit

does not eject any ink-jet droplets

Such a nozzle exists that does not | Proceed to Step 3.

eject any ink-jet droplets
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Step 3: Check that no ink-jet droplets are ejected from the applicable nozzle

(1) Check locations of the non-ejecting nozzles on the result of the printed nozzle check pattern (1st to 3rd time), and

@)

carry out the following procedures.

Comparison of non-ejection nozzle
positions

Recovery action

The same nozzle always does not
eject ink-jet droplets

Perform the super cleaning -> print out of nozzle check pattern for the third
time in a row.

A different nozzle does not eject
ink-jet droplets

Leave the printer as it is for about 30 minutes, and perform the normal
cleaning -> print out of nozzle check pattern for the third time in a row.

Check a result of the resultant nozzle

check patterns, and carry out the following procedures.

Existence or nonexistence of a
nozzle that does not eject any
ink-jet droplets

Recovery action

eject any ink-jet droplets

Such a nozzle does not exist that | Exit
does not eject any ink-jet droplets
Such a nozzle exists that does not | Proceed to Step 4.

Step 4: Clean the nozzle surface

(1) Clean the nozzle surface of the print heads.= "9-2-3. Cleaning of head nozzle >>P.268"

)

Print out a nozzle check pattern.

(3) Check aresult of the resultant nozzle check patterns, and carry out the following procedures.

Existence or nonexistence of a
nozzle that does not eject any
ink-jet droplets

Recovery action

eject any ink-jet droplets

Such a nozzle does not exist that Exit
does not eject any ink-jet droplets
Such a nozzle exists that does not | Proceed to Step 5.

<IMPORTANT>

. Even if the nozzles on the white side have a bit of problem concerning firing, since the white ink is ejected on one same
spot through multiple nozzles, relatively large amount of ink volume will be used, and firing problem of a single nozzle will
not affect the print quality so much. Even in a condition with a problem concerning firing as shown in (a), print is performed

without a problem as shown in (b).

(@)

(b)
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Step 5: Head Replacement

(1) Replace the print head with a new one.= "9-2-6. Replacement of print head >>P.277"
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9-2-2. White head cleaning

If a problem concerning firing of the white head side is not cleared even after performing the head cleaning, perform the
white head cleaning.

After the white head cleaning is completed, conduct the Install White Ink After Cleaning.

<TIPS>

Although the white head cleaning can begin even when the remaining volume of maintenance solution in the maintenance
solution pouch is running short, there may be cases where the pouch needs to be replaced with a new one during the cleaning
depending on such remaining volume. If the remaining volume is 500 g (17.6 oz) or less, prepare a new maintenance solution
pouch.

When the white ink pouch runs low on its remaining volume of white ink, the Install White Ink After Cleaning function can no
longer get started. Furthermore, there may be cases where the pouch needs to be replaced with a new one during the installation
process of white ink. If the remaining volume is 400 g (14.1 oz) or less, prepare a new white ink pouch.

White Head Cleaning

(1

)
©)

From the menu, select [Maintenance] > [White Head Cleaning], and press @ .

<TIPS>

. Perform the work operation by following the on-screen instructions.

After making sure that the waste ink tank is filled one-half or less full with waste ink, and press @ .

Take out the white ink cartridge from the printer.
<CAUTION>
. The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

4 N\

‘ ‘
i ik ]

W12 W34
1 \

White Ink Cartridge

X0333
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(4) Open the cartridge's lid.
<IMPORTANT>
. When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.
3 Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the
lid.

Cartridge Lid

X0042

(5) Pinch the latch at the front end of ink pouch, and draw out the white ink pouch from the cartridge.
<CAUTION>
. Remove the accumulated ink at the tip of the cartridge with a waste cloth (non-fuzzy cloth). Clean the printer on a regular
basis.

White ink pouch

Cartridge's tip end

Cartridge

Latch

X0119

(6) Put the maintenance solution pouch in the cartridge.
Push the tip end of the maintenance solution pouch into the cartridge until it clicks into place.
Straighten the maintenance solution pouch in such a manner that it will be aligned with the gutter of the lid of the cartridge, and

mount in position by pulling it with your hand.
<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

Maintenance solution pouch
\ =
Stretch
C
%\ \ \
) Cartridge

X0049
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(7) Put the maintenance solution pouch in its correct position.
<CAUTION>
. Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand.

(a)

5
|

(8) Close the lid, and put the maintenance solution cartridge in position inside the printer.

Place the pouch in a straight alignment with the cartridge

—_—

Align lines with

X0041
each other

(9) Repeat the same process to replace the other white ink cartridge with the maintenance solution pouch.

(10) On the operation panel, press ® .

Then, the white head cleaning will be performed.

<TIPS>

. White head cleaning will take approximately 25 minutes. Perform the "Install White Ink After Cleaning" operation by
following the on-screen instructions.
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Install White Ink After Cleaning

™

()

@)

Make sure the message [Install White Ink After Cleaning] is displayed on the liquid crystal panel.

<TIPS>
. Perform the work operation by following the on-screen instructions.

Take out the maintenance solution cartridge from the printer.
<CAUTION>
3 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

N

N

W12 W34

T

I\

Maintenance solution cartridge

Open the cartridge's lid.

<IMPORTANT>

3 When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.

. Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the
lid.

Lid

Cartridge

4 )

Troubleshooting >

X0333
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(4) Take out the maintenance solution pouch from the cartridge, and put the white ink pouch in place.
Push the tip end of ink pouch into the cartridge until it clicks into place.
Straighten the ink pouch in such a manner that it will be aligned with the gutter of the lid of the cartridge, and mount in position by
pulling it with your hand.
<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

White ink pouch

Stretch

& < \\

Cartridge

X0049

(5) Put the white ink pouch in its correct position.
<CAUTION>
. Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand.

Place the pouch in a straight alignment with the cartridge

J

)

l \ Align lines with
] each other

—_—

X0041

(6) Shake the cartridge 100 times side to side to stir the ink.

<IMPORTANT>

3 The white ink cartridge should be held horizontally when shaking it.

. Holding the white ink cartridge upside down or shaking it too roughly could break the ink pouch.

<NOTE>

. Wear the provided gloves when performing this task.

e  When the remaining ink level becomes approximately 5.9 in. (15 cm), shake the cartridge with its cover open and with the
edge of the ink pouch slightly winded, to make the ink easier to stir.

Edge of the rib ~

Ink pouch /

White Ink Cartridge

Remaining ink volume should

. be approx. 5.9 in. (15 cm)
Shake 100 times (for approx. 50 seconds)

(Swing distance should be approx. 2 in. (5 cm).
Increase the swing distance when the remaining
ink level becomes low.)

X0194
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(7) Open the lid of the cartridge and place the ink pouch in its correct position.

<IMPORTANT>

e  Always open the cartridge lid and properly rewind the ink pouch. If the pouch is placed without opening the lid, ink can flow
into the wound section of the pouch when stirred, which can cause improper winding of the pouch.

. When opening the lid, place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge
downward and open the lid.

. When setting the ink pouch, avoid unevenness or wrinkles on the pouch.

. When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.

<NOTE>

. If the remaining ink level is low, hold the sagged part of the ink pouch and close the lid.

Cartridge Lid

X0182
Latch Q Lid
/
| ] —>
X0078
No wrinkles
Ink pouch i
X0142

(8) Close the lid, and put the white ink cartridge in position inside the printer.

<IMPORTANT>
. W12 and W34 cartridges should correctly be placed in their original locations. Wrongly placed cartridges could cause a
printer malfunction.

(9) Repeat the same process to replace the other maintenance solution cartridge with the white ink pouch.
(10) Check the waste ink tank level and take any necessary measure for it, if any, then press @ on the operation panel.

After the cleaning is completed, the Install White Ink After Cleaning function will get started.

<TIPS>

. The "Install White Ink After Cleaning" operation will take approximately 15 minutes. After the procedures are completed, the
current screen will go back to the standby mode screen.
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9-2-3. Cleaning of head nozzle

If a problem of non-ejection of ink-jet droplets is not cleared even after performing the head cleaning, perform the head
nozzle cleaning.
<IMPORTANT>

™

2

@)

(4)

Clean the nozzle guard first, then clean the head nozzle. = "7-1-3. Cleaning the nozzle guard, wiper, exhaust cap, and suction
cap >>P.174"

Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available

for use.

<IMPORTANT>

. Use a new clean stick R when you start cleaning.

. Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may
result in the printer malfunction.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

<IMPORTANT>

3 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Follow the on-screen message and turn off the power.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

. If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select
[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink
from drying up.

Open the front cover.

Front cover

X0331
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Put a proper amount of cleaning solution into the cleaning cup.

Moisten a clean stick R with the cleaning solution.

<IMPORTANT>

. Be sure to use a different clean stick R separately for the color head and the white head. Use a new clean stick R when you
start cleaning.

3 Do not use other fluids (water, etc.), because they may damage the print heads.

. Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.

. Do not shed cleaning solution in the maintenance unit.

<NOTE>

. For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick R

Cleaning cup

Cleaning cup

[Q
S

Cleaning solution

Do not drain waste ink.

X0320
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(7) With a clean stick R, clean the nozzle surface of print head.
Manually move the carriage to such a position that you can perform the cleaning with ease.
<IMPORTANT>
3 Be sure not to bring corner edges of the clean stick R into contact with the nozzle surface.
. Avoid roughly rubbing the nozzle surface.
. The used clean stick R should be disposed of, and should not be reused.

Clean stick R

Print head

Nozzle surface

X0251

(8) Close the front cover, turn on the power.

(9) From the menu, select [Head Cleaning] > [Powerful Cleaning] > [All Print Heads], and press @ .
<NOTE>
. Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.
<TIPS>
. Then, the head cleaning will be performed to prevent any ink from drying up.
3 Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.

270



Troubleshooting >

9-2-4. Cleaning the surrounding area of nozzle surface

™

@)

@)

(4)

Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available

for use.

<IMPORTANT>

. Use a new clean stick R when you start cleaning.

. Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may
result in the printer malfunction.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .
<IMPORTANT>
. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve

the problem, then perform the cleaning.
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Follow the on-screen message and turn off the power.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

° If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select
[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink
from drying up.

Open the front cover.

Front cover

X0331
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Put a proper amount of cleaning solution into the cleaning cup.

Moisten a clean stick R with the cleaning solution.

<IMPORTANT>

. Be sure to use a different clean stick R separately for the color head and the white head. Use a new clean stick R when you
start cleaning.

3 Do not use other fluids (water, etc.), because they may damage the print heads.

. Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.

. Do not shed cleaning solution in the maintenance unit.

<NOTE>

. For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick R

Cleaning cup

Cleaning cup

Cleaning solution

Do not drain waste ink.

X0320
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(7) With a clean stick R, clean the surrounding area of nozzle surface of print head.
Manually move the carriage to such a position that you can perform the cleaning with ease.
<IMPORTANT>
3 Be sure not to bring the clean stick R into contact with the nozzle surface.
. The used clean stick R should be disposed of, and should not be reused.

=1l SO
Cleaning | TL> \F& N—

; _ —
prohibited i *ﬁ(/‘.% N Cleanstick R

area ?»/ V
| N

-y -
: \|

Surrounding area of nozzle \(

surface Nozzle surface

| | =T

X0293

(8) Close the front cover, turn on the power.
(9) From the menu, select [Head Cleaning] > [Powerful Cleaning] > [All Print Heads], and press @ .

<NOTE>

. Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.

<TIPS>

e  Then, the head cleaning will be performed to prevent any ink from drying up.

. Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.
Cleaning conditions

Pre-cleaning state Post-cleaning state
X0253
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9-2-5. Replacing the color filter

If a number of non-firing color head nozzles is observed after printing, the filter should be replaced.

<IMPORTANT>

° When replacing multiple filters, filters for individual colors should be replaced one by one. Replace the filter for the first color and
install ink, then replace the next filter. Removing multiple filters at the same time might damage the print head.

<TIPS>

. Ink installation should be performed after replacing the filters. If the ink level is low, make a new ink pouch available for use.

(1) Prepare the supplied gloves and optional filter.
(2) From the menu, select [Maintenance] > [Exchange Filter], and press @ .

(3) From [Black], [Yellow], [Cyan], and [Magenta] select non-firing color and press @ .
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

(4) Follow the on-screen message and turn off the power.

(5) Open the front cover.

Front cover

X0331
(6) Lay a waste cloth under the filter to be replaced.
<TIPS>
. Non-fuzzy, clean cloth should be used.
N
Filter
Color print head
J
Waste cloth
X0396
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Filter

\\ X0397

Head side tube

Nut
Filter
X0437
(9) Place a new filter on the head side tube and fasten the nut.
<IMPORTANT>
. Install the filter with no stamp facing the tube. Pay attention to this installation orientation.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.
Nut ( )
’“ Without stamp
New filter
N J X0334
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(10) Rotate the nut of the tube on the cartridge side to remove the old filter.

New filter \ / Old filter
Il"’

(S
=P
Cartridge side tube

Nut X0438

(11) Attach the cartridge side tube to a new filter and fasten the nut.
<IMPORTANT>
. Make sure to install the filter with the stamped side facing the cartridge side tube.

4 N\

New filter @

Stamped side

Nut
J  X0335

(12) Remove the waste cloth from under the filter.

(13) Close the front cover, turn on the power.
<NOTE>
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.

(14) Perform the [Filter exchange after ink Load] operation by following the on-screen instructions.
<TIPS>
. When replacing multiple filters, go back to the beginning of the procedure to start replacing the next filter.
. After the procedures are completed, the current screen will go back to the standby mode screen.
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9-2-6. Replacement of print head

If a problem of non-ejection of ink-jet droplets is not cleared even after cleaning the head nozzle, replace a print head
with a new one.
The replacement procedures vary from the color heads to the white heads. According to each of the replacement
procedures, replace each print head with a new one separately.
<TIPS>
o Do not confuse the color side print head with the white side print head.

Check the case color (red for the color side, white for the white side) and replace the case.

. Ink needs to be re-installed after replacing the print head. If the ink level is low, make a new ink pouch available for use.

Replacement procedures for print head on the color side

(1) From the menu, select [Maintenance] > [Head Replacement] > [Color], and press @ .
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

(2) Follow the on-screen message and turn off the power.
<IMPORTANT>
. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

(3) Open the front cover.

Front cover

X0331
(4) Remove the upper case of a new print head.
(5) Remove four caps from the new print head.
Upper case
Cap
Print head @/
X0068

277



(6)

(7)

Troubleshooting >

Remove each tube from the print head to be replaced with a new one, then attach each of the new caps which are

removed from a new print head to each tube, while exercising care to prevent any ink from being spilled.

<IMPORTANT>

. Care is needed in preventing any ink from being spilled from each tube. If the ink is dripping, wipe off the dripping ink.

. Be careful not to confuse it with the tube for the print head on the white side.

. When you replace the print head, be sure to move the carriage manually to the position of platen at the center of the printer
before starting the replacement. If you perform the mounting of the head when the carriage is directly above the
maintenance unit, it may damage the maintenance unit or the heads.

<NOTE>

. For a proper work operation, be sure to wear the printer-provided gloves.

Tube

el

S -»(E=
- (E=
HEH-»(E—

X0398
Remove the core claw using the supplied screwdriver.
<IMPORTANT>
. Hold the core center by hand to make it easy to insert the screwdriver into the claw.
Core
X0399
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(8) Remove the resin cover which is placed on the top of the carriage board and remove the flat cable.

Resin cover

Flat cable

X0400

(9) Unlock the print head, and remove the print head.
<IMPORTANT>
. When removing the print head in position, be careful not to drip the ink on the carriage plate. If the ink is dripping, wipe off
the dripping ink.

( N

Lock

Print head

X0401

(10) Release the lock by pulling (a) part toward yourself, and take out the new print head from its case.
<IMPORTANT>
. When removing the print head, be careful not to touch the nozzle surface at the bottom of the head. Otherwise it may cause
poor printing.
<TIPS>
. Sometimes, you may find it hard to remove the print head when you try to open the lock of (a) part. If it is hard, use both
hands to remove it.

Print head

(a) part

X0068
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Troubleshooting
(11) By following the procedures mentioned below, mount a new print head on the carriage.

@ Insert the rearward end of the print head into the carriage.

(@ Push with force in direction 2) so that the illustrated part (a) makes contact with the side of the metal plate of the print head.

(® Lock the print head in place.

<IMPORTANT>

. Make sure the illustrated (a) part is in contact with the side of the metal plate.

3 When placing the print head in position, be careful not to move the carriage as much as possible. Your hand may be caught
in the carriage and injured. In addition, the tubes may be rolled together possibly damaging them.

. When you mount 3, push it down from the top. Otherwise, you may get your finger caught in it and get injured.

<TIPS>

. If the print head is not inserted sufficiently, the part as illustrated in (b) could come into contact with its bottom surface, which
in turn may result in poor printing. Please insert the print head as far as it can go.

( N\

Print head

(D¢
/= ==

Carriage

X0402

X0403
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Troubleshooting >

(12) Insert the flat cable into the core and connect it to the carriage board.
(13) Fit the claw by pushing the core until it clicks into place.

Leave a slack to avoid interference between the flat cable and the resin cover.

Core

Flat cable

Latch
X0404
(14) Place the resin cover back onto the carriage board, and engage the two latches properly.
Tuck the extra flat cable as shown in the illustration.
Resin cover
X0405

(15) Remove the cap you connected in step (6) from the tube, and connect the tubes to the print head.
<IMPORTANT>
. To prevent the tubes from being entangled with each other, connect the innermost tube to the print head first, and make a
connection of the rest of the tubes.
. Be sure to connect each tube with its correct position.
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(16) Tighten the nut firmly until it stops so that each tube is fixed to the print head.

N
*Remove the ink clot.,

/

M4~ oerE= M
G owE= C
Y2 O+(EB= Y )
Bkl Oo+={EB= K

Print head
/
A\ J

X0406

(17) Close the front cover, turn on the power.
(18) From the menu, select [Maintenance] > [Install Ink after Replacing Head] > [Color], and press @ .

Perform the work operation by following the on-screen instructions.
<TIPS>
. After the procedures are completed, the current screen will go back to the standby mode screen.

(19) Adjust the carriage speed.= "7-4-1. CR (Carriage) speed adjustment >>P.216"

(20) Print the nozzle check patterns. = "7-2-1. Print out of the nozzle check pattern (checking on the print heads)
>>P.199"

(21) Perform the initial settings after head replacement configuration.= "7-4-2. Initial settings after head replacement
>>P217".

(22) Adjust the ejection timing of print head.= "7-4-3. Firing adjustment >>P.218".

(23) Perform the platen feed adjustment.= "7-4-4. Platen-rolling adjustment >>P.219"

(24) Make the position adjustment between the white head and the color head.= "7-4-5. White/color alignment

>>P.261
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Replacement procedures for print head on the white side (if you use a capping pouch)
<IMPORTANT>

™
@)

@)

(4)

When you replace a print head on the white side, you can minimize ink consumption by installing a capping pouch (optionally
available) in addition to a print head. Instead of the capping pouch, a white ink pouch at its ink depletion level before its expiry
date can also be used.

From the menu, select [Maintenance] > [Head Replacement] > [White], and press @ .

Make available a capping pouch and select [Yes] in response to the instructions on screen.
<IMPORTANT>

. Instead of the capping pouch, a white ink pouch at its ink depletion level before its expiry date can also be used.
<TIPS>

. Perform the work operation by following the on-screen instructions.

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Remove the white ink cartridge from the printer.
<CAUTION>
. The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

(" N\

L
P 1

W12 W34

White Ink Cartridge

X0333

Open the cartridge's lid.

<IMPORTANT>

3 When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.

. Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the
lid.

Lid

Cartridge

X0042
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Troubleshooting >

(5) Pinch the latch at the front end of ink pouch, and draw out the white ink pouch from the cartridge.
<CAUTION>
. Remove the accumulated ink at the tip of the cartridge with a waste cloth (non-fuzzy cloth). Clean the printer on a regular
basis.

White ink pouch

Cartridge's tip end

™~

Cartridge
Latch
X0119
(6) Putthe capping pouch in the cartridge.
<TIPS>
. You can use a capping pouch of either the old or new shape.
< New capping pouch>
Push the tip end of capping pouch into the cartridge until it clicks into place.
New capping pouch
Cartridge X0294

< Old capping pouch>
Push the tip end of capping pouch into the cartridge until it clicks into place.
Straighten the capping pouch in such a manner that it will be aligned with the gutter of lid of cartridge, and mount in position by

pulling it with your hand.

<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

Old capping pouch ,
\ —
Stretch
&
¢
&5 {
\ Cartridge

X0049
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Put the capping pouch in its correct position.

< New capping pouch>

<CAUTION>

e  Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand.

<NOTE>

e  After closing the lid, the winding is complete when the latch of the cartridge side is raised.

(a)

X0295

Cartridge

X0296
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< Old capping pouch>

<CAUTION>

. Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand.

<NOTE>

3 Close the lid while holding the slack of the capping pouch by hand.

e After closing the lid, confirm that the capping pouch has been taken up to the end. When the latch of the cartridge side is
raised, the winding is complete.

(a)

Place the pouch in a straight alignment with the cartridge

Align lines with
each other

i

—
F I> Latch , \

X0041

Cartridge

X0201

(8) Close the lid, and put the capping cartridge in position inside the printer.

(9) Repeat the same process to replace the other white ink cartridge with the capping pouch.

(10) Follow the on-screen message and turn off the power.
<IMPORTANT>
. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

(11) Open the front cover.

Front cover

X0331

(12) Remove the upper case of a new print head.
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(13) Remove four caps from the new print head.

Upper case

Cap
Print head @/

’

//

- ~

X0068

(14) Remove each tube from the print head to be replaced with a new one, then attach each of the new caps which are

removed from a new print head to each tube, while exercising care to prevent any ink from being spilled.
<IMPORTANT>

Care is needed in preventing any ink from being spilled from each tube. If the ink is dripping, wipe off the dripping ink.
Be careful not to confuse it with the tube for the print head on the color side.

Be sure not to tighten the nut for part (a) by mistake. It could remove the tube and leak the contained ink.

When you replace the print head, be sure to move the carriage manually to the position of the platen at the center of the
printer before starting the replacement. If you perform the mounting of the head when the carriage is directly above the
maintenance unit, it may damage the maintenance unit or the heads.

<NOTE>

For a proper work operation, be sure to wear the printer-provided gloves.

Tube

el

&~ (=
=
B~ (5=

Tube

X0407
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(15) Remove the core claw using the supplied screwdriver.
<TIPS>
. Hold the core center by hand to make it easy to insert the screwdriver into the claw.

Driver

Core
(16) Remove the resin cover which is placed on the top of the carriage board and remove the flat cable.
Flat cable
Resin cover
X0409
(17) Unlock the print head, and remove the print head.
<IMPORTANT>
. When removing the print head, be careful not to drip the ink on the carriage plate. If the ink is dripping, wipe off the dripping
ink.
4 7\
Lock
Print head
(. J
X0410
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Troubleshooting
(18) Release the lock by pulling (a) part toward yourself, and take out the new print head from its case.

<IMPORTANT>

¢  When removing the print head, be careful not to touch the nozzle surface at the bottom of the head. Otherwise it may cause
poor printing.

<TIPS>

. Sometimes, you may find it hard to remove the print head when you try to open the lock of (a) part. If it is hard, use both
hands to remove it.

Print head

(a) part

X0069
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Troubleshooting
(19) By following the procedures mentioned below, mount a new print head on the carriage.

@ Insert the rearward end of print head into the carriage.

(@ Push with force in direction 2) so that the illustrated part (a) makes contact with the side of the metal plate of the print head.

(® Lock the print head in place.

<IMPORTANT>

. Make sure the illustrated (a) part is in contact with the side of the metal plate.

3 When placing the print head in position, be careful not to move the carriage as much as possible. Your hand may be caught
in the carriage and injured. In addition, the tubes may be rolled together possibly damaging them.

. When you mount 3, push it down from the top. Otherwise, you may get your finger caught in it and get injured.

<TIPS>

. If the print head is not inserted sufficiently, the part as illustrated in (b) could come into contact with its bottom surface, which
in turn may result in poor printing. Please insert the print head as far as it can go.

( N\

Print head

R <.

Carriage

X0411

Print head

X0412
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(20) Insert the flat cable into the core and connect it to the carriage board.
(21) Fit the claw by pushing the core until it clicks into place.

Leave a slack to avoid interference between the flat cable and the resin cover.

Flat cable

Latch

X0413

(22) Place the resin cover back onto the carriage board, and engage the two latches properly.

Tuck the extra flat cable as shown in the illustration.

Resin cover

X0414
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Troubleshooting
(23) Remove every cap from each tube, and connect the tubes to the print head.
<IMPORTANT>
. To prevent the tubes from being entangled with each other, connect the innermost tube to the print head first, and make the
connection of the rest of the tubes.
. Check the stamp on the print head and connect them taking care not to confuse their positions. Incorrectly connecting them
may cause the ink to leak during the circulation.

(24) Tighten the nut firmly until it stops so that each tube is fixed to the print head.
<IMPORTANT>
. Be sure not to tighten the nut for part (a) by mistake.

N
( M4~ QerE= 4 | *Remove the ink clot.
c3 %«Cﬁ: 3
Y2 O+(E= 2 =
Bk1 O+{E= 1
J
\Print head
. J
X0415

(25) Close the front cover, turn on the power.
(26) From the menu, select [Maintenance] > [Install Ink after Replacing Head] > [White], and press @ .
Perform the work operation by following the on-screen instructions.
<TIPS>
. When the white ink pouch runs low on its remaining volume of white ink, the Install Ink after Replacing Head function can
no longer get started. Furthermore, there may be cases where the pouch needs to be replaced with a new one during the
installation process of white ink. If the remaining volume is 400 g (14.1 oz) or less, prepare a new white ink pouch, follow
the instructions on the screen to replace the pouch, and activate the mode again.

(27) Take out the capping cartridge from the printer.
<CAUTION>
3 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

( N\

W12 W34
S

Capping cartridge

X0333
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(28) Open the cartridge's lid.
<IMPORTANT>
. When opening the lid, be sure not to touch portion (a). Otherwise, it could be damaged.
3 Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the
lid.

Cartridge Lid”

X0042

(29) Take out the capping pouch from the cartridge, and put the white ink pouch in place.
Push the tip end of the ink pouch into the cartridge until it clicks into place.
Straighten the ink pouch in such a manner that it will be aligned with the gutter of the lid of cartridge, and mount in position by

pulling it with your hand.

<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

White ink pouch :
( \ =
/ N
Stretch
(=
C
Cartridge J

X0049

(30) Put the white ink pouch in its correct position and close the lid.
<CAUTION>
. Avoid touching portion (a) of the cartridge. Otherwise, you may cut your hand.

Place the pouch in straight alignment with the cartridge

L

Align lines with
each other X0041

—_—
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(31) Shake the cartridge 100 times side to side to stir the ink.
<IMPORTANT>
. The white ink cartridge should be held horizontally when shaking it.

3 Holding the white ink cartridge upside down or shaking it too roughly could break the ink pouch.
<NOTE>

. Wear the provided gloves when performing this task.

3 When the remaining ink level becomes approximately 5.9 in. (15 cm), shake the cartridge with its cover open and with the
edge of the ink pouch slightly winded, to make the ink easier to stir.

Edge of the rib
White Ink Cartridge geoftherib~_ =

Ink pouch

Remaining ink volume should

be approx. 5.9 in. (15 cm)
Shake 100 times (for approx. 50 seconds)

(Swing distance should be approx. 2 in. (5 cm).
Increase the swing distance when the remaining
ink level becomes low.)

X0194
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(32) Open the lid of the cartridge and place the ink pouch in its correct position.

<IMPORTANT>

e  Always open the cartridge lid and properly rewind the ink pouch. If the pouch is placed without opening the lid, ink can flow
into the wound section of the pouch when stirred, and cause improper winding of the pouch.

e  When opening the lid, place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge
downward and open the lid.

. When setting the ink pouch, avoid unevenness or wrinkles on the pouch.

. When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.

<NOTE>

. If the remaining ink level is low, hold the sagged part of the ink pouch and close the lid.

Cartridge Lid

X0182

|

]

Lid

/
H -
X0078
Ink pouch No wrinkles

Not sagged e
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(33) Close the lid, and put the white ink cartridge in position inside the printer.

<IMPORTANT>
. W12 and W34 cartridges should correctly be placed at their original locations. Wrongly placed cartridges could cause a
printer malfunction.

(34) Repeat the same process to replace the other capping cartridge with the white ink pouch.

(35) On the operation panel, press @ .

Then, the white ink will be installed after the head is replaced with a new one.

<TIPS>
3 After the procedures are completed, the current screen will go back to the standby mode screen.

(36) Adjust the carriage speed.= "7-4-1. CR (Carriage) speed adjustment >>P.216"

(37) Print the nozzle check patterns. = "7-2-1. Print out of the nozzle check pattern (checking on the print heads)
>>P.199"

(38) Perform the initial settings after head replacement configuration.= "7-4-2. Initial settings after head replacement
>>pP217"

(39) Adjust the ejection timing of the print head. ="7-4-3. Firing adjustment >>P.218".

(40) Perform the platen feed adjustment.= "7-4-4. Platen-rolling adjustment >>P.219".

(41) Make the position adjustment between the white head and the color head.= "7-4-5. White/color alignment

>>P.220"
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Replacement procedures for print head on the white side (if you do not use a capping pouch)
<IMPORTANT>

™
)

@)

(4)

(5)
(6)

When you replace a print head on the white side, you can minimize ink consumption by installing a capping pouch (optionally
available) in addition to a print head. Instead of the capping pouch, a white ink pouch at its ink depletion level before its expiry
date can also be used.

From the menu, select [Maintenance] > [Head Replacement] > [White], and press @ .

Select [No] in response to the instructions on screen.

<TIPS>
. Perform the work operation by following the on-screen instructions.

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Follow the on-screen message and turn off the power.
<IMPORTANT>
. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

Open the front cover.

Front cover

X0331
Remove the upper case of a new print head.
Remove four caps from the new print head.
Upper case
Cap
Print head @/
X0068
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(7) Remove each tube from the print head to be replaced with a new one, then attach each of the new caps which are

removed from a new print head to each tube, while exercising care to prevent any ink from being spilled.

<IMPORTANT>

. Care is needed in preventing any ink from being spilled from each tube. If the ink is dripping, wipe off the dripping ink.

. Be careful not to confuse it with the tube for the print head on the color side.

3 Be sure not to tighten the nut for part (a) by mistake. It could remove the tube and leak the contained ink.

. When you replace the print head, be sure to move the carriage manually to the position of the platen at the center of the
printer before starting the replacement. If you perform the mounting of the head when the carriage is directly above the
maintenance unit, it may damage the maintenance unit or the heads.

<NOTE>

3 For a proper work operation, be sure to wear the printer-provided gloves.

Tube

Cap
g: Elé: ——

=
-~ (5=

Tube

X0407
(8) Remove the core claw using the supplied screwdriver.
<TIPS>
. Hold the core center by hand to make it easy to insert the screwdriver into the claw.
Driver
Core
X0408
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(9) Remove the resin cover which is placed on the top of the carriage board and remove the flat cable.

Flat cable

Resin cover

X0409
(10) Unlock the print head, and remove the print head.
<IMPORTANT>
. When removing the print head, be careful not to drip the ink on the carriage plate. If the ink is dripping, wipe off the dripping
ink.
( N\
Lock
Print head
A J
X0410

(11) Release the lock by pulling (a) part toward yourself, and take out the new print head from its case.
<IMPORTANT>
. When removing the print head, be careful not to touch the nozzle surface at the bottom of the head. Otherwise it may cause
poor printing.
<TIPS>
. Sometimes, you may find it hard to remove the print head when you try to open the lock of (a) part. If it is hard, use both
hands to remove it.

Print head

(a) part

X0068
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(12) By following the procedures mentioned below, mount a new print head on the carriage.

@ Insert the rearward end of print head into the carriage.

(@ Push with force in direction 2) so that the illustrated part (a) makes contact with the side of the metal plate of the print head.

(® Lock the print head in place.

<IMPORTANT>

. Make sure the illustrated (a) part is in contact with the side of the metal plate.

3 When placing the print head in position, be careful not to move the carriage as much as possible. Your hand may be caught
in the carriage and injured. In addition, the tubes may be rolled together possibly damaging them.

. When you mount 3, push it down from the top. Otherwise, you may get your finger caught in it and get injured.

<TIPS>

. If the print head is not inserted sufficiently, the part as illustrated in (b) could come into contact with its bottom surface, which
in turn may result in poor printing. Please insert the print head as far as it can go.

( N\

Print head

R <.

Carriage

X0411

Print head

X0412
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(13) Insert the flat cable into the core and connect it to the carriage board.
(14) Fit the claw by pushing the core until it clicks into place.

Leave a slack to avoid interference between the flat cable and the resin cover.

Flat cable

X0413

(15) Place the resin cover back onto the carriage board, and engage the two latches properly.

Tuck the extra flat cable as shown in the illustration.

Resin cover

X0414

(16) Remove every cap from each tube, and connect the tubes to the print head.
<IMPORTANT>

. To prevent the tubes from being entangled with each other, connect the innermost tube to the print head first, and make the
connection of the rest of the tubes.

. Check the stamp on the print head and connect them taking care not to confuse their positions. Incorrectly connecting them
may cause the ink to leak during the circulation.
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(17) Tighten the nut firmly until it stops so that each tube is fixed to the print head.
<IMPORTANT>
. Be sure not to tighten the nut for part (a) by mistake.

( M4~ QerE= 4 | *Remove the ink clot.
a3 %‘QE 3
Y2 O+(E= 2 =
Bk1 O+(E= 1
J
\Printhead
A J
X0415

(18) Close the front cover, turn on the power.
(19) From the menu, select [Maintenance] > [Install Ink after Replacing Head] > [White], and press @ .

Perform the work operation by following the on-screen instructions.

<TIPS>

. When the white ink pouch runs low on its remaining volume of white ink, the Install Ink after Replacing Head function can
no longer get started. Furthermore, there may be cases where the pouch needs to be replaced with a new one during the
installation process of white ink. If the remaining volume is 400 g (14.1 oz) or less, prepare a new white ink pouch, follow
the instructions on the screen to replace the pouch, and activate the mode again.

(20) On the operation panel, press @ .

Then, the white ink will be installed after the head is replaced with a new one.

<TIPS>
3 After the procedures are completed, the current screen will go back to the standby mode screen.

(21) Adjust the carriage speed.="7-4-1. CR (Carriage) speed adjustment >>P.216"

(22) Print the nozzle check patterns. = "7-2-1. Print out of the nozzle check pattern (checking on the print heads)
>>P.199"

(23) Perform the initial settings after head replacement configuration.= "7-4-2. Initial settings after head replacement
>>pP217"

(24) Adjust the ejection timing of the print head.= "7-4-3. Firing adjustment >>P.218"

(25) Perform the platen feed adjustment.= "7-4-4. Platen-rolling adjustment >>P.219"

(26) Make the position adjustment between the white head and the color head.= "7-4-5. White/color alignment

>>P.220"
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9-2-7. Replacing the Wiper

Replace the wiper with a new one if it is damaged or deformed.

(1) Have the supplied gloves and wiper ready.

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .
<IMPORTANT>
3 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve

the problem, then perform the cleaning.
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

(3) Follow the on-screen message and turn off the power.
<IMPORTANT>
. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.
. If the task takes more than 15 minutes to complete, after attaching the flushing receiver, wiper cleaner, and wiper, close the
front cover and turn on the power, and then select [Maintenance Part Clean/Replace] again to restart the task. Then, the

head cleaning will be performed to prevent any ink from drying up.
(4) Open the front cover.

(5) Raise the wiper cleaner and move it to its upright position, and remove it by moving it upward.
<IMPORTANT>
3 Removed wiper cleaner should be placed with the cleaner side facing up.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

Wiper cleaner Front cover

X0325
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(6) Remove the flushing receiver from the maintenance unit.
<IMPORTANT>
. Ink droplets will drop off from the hole on the bottom of flushing receiver. Press a waste cloth against the bottom surface,
and lift the flushing receiver vertically to remove it.

( N\

Flushing receiver Waste cloth Front cover
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Troubleshooting >

(8) Remove the wiper from the maintenance unit.

<IMPORTANT>

There are two protruded parts underneath. Thoroughly remove the wiper not to damage these parts.
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(9) Insert a new wiper into the printer from above.



(11) Insert a wiper cleaner into the printer from above, tip it leftward and put it in place.
<TIPS>
. During this process, it is recommended to also replace the wiper cleaner with a new one.
. First, insert the shaft from above. Then fold it to the left, press the area with the PUSH indication until a clicking sound is
heard, and get the latch into position.

X0326
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Troubleshooting

(12) Mount the flushing receiver back to its original place in the maintenance unit.
<TIPS>
3 Direct its orientation with a hole on the bottom to the front.

(13) Close the front cover.

(14) Turn on the power.
<NOTE>
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
<TIPS>
. Then, the head cleaning will be performed to prevent any ink from drying up.
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9-2-8. Re-install the ink

Ink should be re-installed when an entrance of air into the print head or tube prevents proper ink-jet operation and
remedial measure cannot improve the condition.

(1) While the printer is in standby mode, press @ on the operation panel to bring the menu screen into view.
(2) Press A / 'V, select [Maintenance] > [Initial Ink Installation], and press @ .

(3) Press A / V¥ toselectone of the options; [All Colors], [All Whites], or [All Print Heads], and press @ .

Initial Ink Installation
All Colors
All Whites

All Print Heads

(4) According to the message displayed on the operation panel, press @ .
Initial ink installation will be operated.
<TIPS>
° Estimated time to finish is 30 minutes for [All Whites] and 15 minutes for [All Colors], which, however, may fluctuate
depending on the temperature environment and printer status. After the procedures are completed, the current screen will
go back to the standby mode screen.
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Troubleshooting

9-3. Acquisition of log file

In cases where the printer malfunctions, you may be required by our service personnel to obtain your printer's log file.
For this reason, please save your printer's log file to a file.
<TIPS>

o To the resultant file, such filename (.log) that automatically identifies your printer will be given.

Fetch a log file from USB flash memory

(1) Insert a USB flash memory into the insertion slot of the printer.

(2) Press @ on the operation panel located on the left side of printer to go to the menu.

(3) Press A /¥, select [Maintenance] > [Log copy to USB], and press @ )

Log copy to USB

Set USB flash drive

Press OK to Start

(4) Then, the print button stops blinking, and the log file writing operation will be completed when you hear the sound of

pong.

<IMPORTANT>

. Never remove the USB flash memory from the printer when the print button is blinking. Otherwise, the USB flash memory
may be damaged, rendering its internal data to be unreadable.

(5) Obtain the log file saved to the USB flash memory, and send such file to our service personnel.
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Troubleshooting >

Fetch a log file via USB/LAN connection

(1) On the PC, from [All Programs] in the Start menu, select the "GTX pro Maintenance" from "Brother GTX pro Tools".

(2) After the window shown below appears, select the [Log Data Retrieval] and click [Next].

@ Brother GTX pre Maintenance X

Confirm the printer is turned OM and connected to your PC.
Select the printer.

|Br0'lherGT)(pro ~ Search

Select an item from the menu below and didk "Next”.

(O Initial settings after head replacement
Perform this setting when replacing the head or when setfing up the printer only,

(O Firing Adjustment
Adjust this setfing when the adges of the print look vague, solid areas are not even, or after a Print Head is replaced,

O Platen-rolling adjustment
Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshooting method when other ftems such 2= proper temperature and humidity have already been verified.
O White/Color Alignment
Adjust whan white print doas not align with color print.

(O setan IP Adrress
Assign a static IP address to the printer.

(O 5etting of the time displayed on the nozzle check pattern
This i not necessary if you have configured the scheduled time for white ink circulation.

(O Set the scheduled time for white ink drculation
Configure this setfing to set or cancel the scheduled time for white ink circulation.

(3) Perform the required operation by following the on-screen instructions in the dialog box.
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m Error message

Error message

What is shown below is the error message list of the GTX pro printer. Any error message is displayed on the liquid

crystal panel.

Please try to solve any error according to the resolution strategy.

Error code Error message Description Remedy Reference
The printer is currently "11-1. Apparatus >>P.350"
under
high-temperature and | Adjust the surrounding
low-humidity temperature and humidity of the

[Temperature & environment, thereby | printer so that both of the
Humidity Warning] prolonging the time temperature and humidity may be
required for automatic | within the print warranty coverage
maintenance with room left for the coverage.
operation after
completion of printing.
The panel board -
cannot communicate
[ERROR: 0001 with the main board at | If the problem still persists even
0001 |l failed in initialization. |all after restarting the printer, please
Turn off and on] (Displayed in English | contact your dealer.
regardless of the
selected language.)
. ) The remaining "6-2-2. Confirmation and
[Cleaning Solution . . : . . .
1000 cleaning solution is Refill cleaning solution. refilling of cleaning
Low - Add More] . , "
running low. solution >>P.117
"6-2-2. Confirmation and
[Cleaning Solution The cleaning solution , i i ! i I
1001 Refill cleaning solution. refilling of cleaning
Out - Add More] has been depleted. ,
solution >>P.117"
) , Please wait until the temperature | -
i It is the warning about
[Color Head Getting , decreases.
1030 temperature increase . )
Warm] , If the problem still persists, please
in the color heads.
contact your dealer.
) ) Please wait until the temperature | -
It is the warning about
[W Head Temp ) decreases.
1031 Rising] temperature InCrease. | e problem stil persists, please
9 in the white heads. P PEISISIS, P
contact your dealer.
The ambient "11-1. Apparatus >>P.350"
temperature
decreases below the ,
1060 |[Temp Low] ) Raise your room temperature.
scope covered by its
warranty for the best
print result.
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Error code Error message Description Remedy Reference
The ambient "11-1. Apparatus >>P.350"
temperature rises
above the scope
1061 emp High Lower your room temperature.
[Temp Highl covered by its Y P
warranty for the best
print result.
The humidity "11-1. Apparatus >>P.350"
decreases below the
1064 | [Humidity too Low] scope covered by its | Raise your room humidity.
warranty for the best
print result.
The humidity level is "11-1. Apparatus >>P.350"
higher than the scope
1065 | [Humidity too High] covered by its Lower your room humidity.
warranty for the best
print result.
Make note of their error code and | -
[Battery To Be Battery needs to be ! )
1070 error message, and please notify
Replaced] replaced. ,
it to your dealer.
Make note of their error code and | -
The built-in clock has
1080 |[RTC Not Adjusted] u error message, and please notify
not been set up. ,
it to your dealer.
Make note of their error code and | -
The built-in clock has
1085 |[RTC Not Adjusted] u error message, and please notify
not been set up. ,
it to your dealer.
"7-1-3. Cleaning the
i ) Cap and wiper need ) nozzle guard, wiper,
1090 |[Cap/Wiper Cleanin Clean the cap and wiper.
[Cap/Wip 9l to be cleaned. P P exhaust cap, and suction
cap >>P.174"
"7-1-3. Cleaning the
i , Cap and wiper need ) nozzle guard, wiper,
1091 Cap/Wiper Cleanin Clean the cap and wiper.
[Cap/Wip 9l to be cleaned. P P exhaust cap, and suction
cap >>P.174"
The wiper cleaner on "7-1-4. Replacing the
1092 [Wiper Cleaner the white side needs | Replace the wiper cleaner with a | wiper cleaner >>P.186"
Replacing White] to be replaced witha | new one.
new one.
The wiper cleaner on "7-1-4. Replacing the
1093 [Wiper Cleaner the white side needs | Replace the wiper cleaner with a | wiper cleaner >>P.186"
Replacing White] to be replaced witha |new one.
new one.
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Error code Error message Description Remedy Reference
The wiper cleaner on "7-1-4. Replacing the
1095 [Wiper Cleaner the color side needs | Replace the wiper cleaner with a | wiper cleaner >>P.186"
Replacing Color] to be replaced with a | new one.
new one.
The wiper cleaner on "7-1-4. Replacing the
1096 [Wiper Cleaner the color side needs | Replace the wiper cleaner with a | wiper cleaner >>P.186"
Replacing Color] to be replaced witha | new one.
new one.
Make note of the error code and | -
[Pump Tube To Be Pump tube needs to )
1100 error message, and please notify
Replaced] be replaced. ,
it to your dealer.
. . - "6-2-3. Daily agitation of
Remove the White Pressin after the stirrin
[Remove " | The white ink needs s @ 9| the white ink >>P.118"
1202 |Ink Cartridge and . . .
shake if to be stirred. causes the White Ink Refilling
function to be put into execution.
The exhaust fan is not Make note of the error code and | -
1210 |[Exhaust Fan Stop] workin error message, and please notify
g it to your dealer.
) The fan filter needs to , "7-1-7. Replacing the fan
Fan Filter To B Replace the fan filt th
1501 [Fan Filter To Be be replaced with a epiace fhe fan fierwiih a new filter >>P.197"
Replaced] one.
new one.
The flushing foam on "7-1-5. Replacing the
1601 [Flushing Foam the white side needs | Replace the flushing foam with a | flushing foam >>P.189"
Replacing White] to be replaced witha |new one.
new one.
The flushing foam on "7-1-5. Replacing the
1602 [Flushing Foam the white side needs | Replace the flushing foam with a | flushing foam >>P.189"
Replacing White] to be replaced witha | new one.
new one.
The flushing foam on "7-1-5. Replacing the
1605 [Flushing Foam the color side needs | Replace the flushing foam with a | flushing foam >>P.189"
Replacing Color] to be replaced witha |new one.
new one.
The flushing foam on "7-1-5. Replacing the
1606 [Flushing Foam the color side needs | Replace the flushing foam with a | flushing foam >>P.189"
Replacing Color] to be replaced witha | new one.
new one.
"7-1-3. Cleaning the
[Nozzle Guard The nozzle guard nozzle guard, wiper,
1700 Clean the nozzle guard.
Cleaning Timing] needs to be cleaned. g exhaust cap, and suction
cap >>P.174"
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Error code Error message Description Remedy Reference
"7-1-3. Cleaning the
[Nozzle Guard The nozzle guard nozzle guard, wiper,
1701 Clean the nozzle guard.
Cleaning Timing] needs to be cleaned. g exhaust cap, and suction
cap >>P.174"
Because the white "9-2-6. Replacement of
head repl ti int head >>P.277"
cadreplacement s Conduct the Install Ink after print.hea
[None after head made, the Install Ink ) .
1801 ) Replacing Head for the white
change (W)] after Replacing Head head
function needs to be '
put into execution.
Because the color "9-2-6. Replacement of
head repl ti int head >>P.277"
cad repacementIs Conduct the Install Ink after printhea
1802 [None after head made, the Install Ink Replacing Head for the color
change (KYCM)] after Replacing Head he:d g
function needs to be '
put into execution.
[Perform Initial Ink The ink installation "9-2-8. Re-install the ink
1901 , has not been Perform initial ink installation. >>P.308"
Installation]
performed yet.
An operation to "7-3-1. Disabling white ink
1905 [Exit Disable White temporarily stop the | Completely perform one of the >>P.209"
Ink] use of white ink is referenced procedures. "7-3-2. Reusing White Ink
stopped in the middle. >>p212"
2000 [Cartridge Not Set No black ink cartridge | Place the black ink cartridge in -
Black] exists. position.
2001 [Cartridge Not Set No magenta ink Place the magenta ink cartridge in | -
Magenta] cartridge exists. position.
2002 [Cartridge Not Set No cyan ink cartridge |Place the cyan ink cartridge in -
Cyan] exists. position.
2003 [Cartridge Not Set No yellow ink Place the yellow ink cartridge in -
Yellow] cartridge exists. position.
2004 [Cartridge Not Set No white 12 ink Place the white ink cartridge in -
White-12] cartridge exists. position.
2005 [Cartridge Not Set No white 34 ink Place the white ink cartridge in -
White-34] cartridge exists. position.
2020 |[No Ink Black] The black ink pouch is Rfaplace the old black ink pouch | -
empty. with a new one.
The magenta ink Replace the old magenta ink -
2021 [[No Ink Magenta] , 9 ! P ) 9 !
pouch is empty. pouch with a new one.
The cyan ink pouch is | Replace the old cyan ink pouch -
2022 |[No Ink Cyan] yan ik pouch is | Rep yan Ink pou
empty. with a new one.
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I

Error code Error message Description Remedy Reference
2023 | [No Ink Yellow] The yellow ink pouch Rfaplace the old yellow ink pouch
is empty. with a new one.
The white 12 ink Replace the old white ink pouch
2024 | [No Ink White-12] white 11 ep White Ink pou
pouch is empty. with a new one.
2025 | [No Ink White-34] The white 34 ink Rfaplace the old white ink pouch
pouch is empty. with a new one.
Put a proper ink pouch in its
t position.
The black ink pouch corree .pOSI .|on . .
[Ink Pouch Error , , Put an identifiable ink pouch in
2030 cannot be identified e ,
Black] roperl position inside the printer.
propery- If the problem still persists, please
contact your dealer.
Put a proper ink pouch in its
) correct position.
Th ta ink
[Ink Pouch Error © magema in Put an identifiable ink pouch in
2031 pouch cannot be L .
Magenta] . ) position inside the printer.
identified properly. . .
If the problem still persists, please
contact your dealer.
Put a proper ink pouch in its
. correct position.
Th k h
[Ink Pouch Error © cyan Ib poluc Put an identifiable ink pouch in
2032 cannot be identified L ,
Cyan] position inside the printer.
properly. . .
If the problem still persists, please
contact your dealer.
Put a proper ink pouch in its
. correct position.
The yellow ink pouch
[Ink Pouch Error Y W_I p ! Put an identifiable ink pouch in
2033 cannot be identified e )
Yellow] roperl position inside the printer.
property. If the problem still persists, please
contact your dealer.
Put a proper ink pouch in its
t position.
Thewhite 12ink | o oo Poot oM .
[Ink Pouch Error Put an identifiable ink pouch in
2034 . pouch cannot be L ]
White 12] , e position inside the printer.
identified properly. . .
If the problem still persists, please
contact your dealer.
Put a proper ink pouch in its
t position.
Thewhite 34ink | o oo Pooron .
[Ink Pouch Error Put an identifiable ink pouch in
2035 , pouch cannot be L .
White 34] . . position inside the printer.
identified properly. . :
If the problem still persists, please
contact your dealer.
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Error code Error message Description Remedy Reference
Itis th d-out -
trcljjbI: ::2” ;Lll( Make note of their error code and

2036 |[Machine Error] error message, and please notify
pouch on the color ,
) it to your dealer.
side.
It is the read-out -
! , ! Make note of their error code and
. trouble of an ink )
2037 | [Machine Error] ) error message, and please notify
pouch on the white )
. it to your dealer.
side.
i There is no wiper . . " -
[No Wiper Cleaner Place a wiper cleaner in position
2041 cleaner on the color ,
(CMYK)] . on the color side.
side.
) There is no wiper ) , " -
[No Wiper Cleaner ) Place a wiper cleaner in position
2042 , cleaner on the white .
(White)] . on the white side.
side.
The ambient "11-1. Apparatus >>P.350"
temperature
decreases below the i
2050 |[Temp Low] i Raise your room temperature.
operation assurance
range for the best
print result.
The ambient "11-1. Apparatus >>P.350"
temperature rises
2051 |[Temp High] above the operation | Lower your room temperature.
assurance range for
the best print result.
The obstacle sensor | Remove such obstacle fromthe | -
2070 [Obstacle on the has detected some platen, flatten its surface, and
Platen] obstacle on the platen
i ) press @ to clear the error.
or print medium.
Perform test printing and check -
the ejection from the head fi
Obstacle detected on © ejec |(.)r.1 rom fhe head for any
[Obstacle detected ) abnormalities.
2071 i L the Platen during o
during printing] intin If the ejection is abnormal,
P g immediately perform head
cleaning to rectify the abnormality.
The platen was The gap between the medium’s -
2072 [Platen is too low. detected to be too low | print surface and the print head is
Adjust it] when attempting to too large. Make adjustments by
start printing. raising the platen.
[Black -
2080 Check the remaining | (K) Pouch winding Check that the pouch is wound
volume of the ink failure correctly.
pouch and winding]
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Error code Error message Description Remedy Reference
[Magenta
2081 Check the remaining | (M) Pouch winding Check that the pouch is wound
volume of the ink failure correctly.
pouch and winding]
[Cyan
2082 Check the remaining | (C) Pouch winding Check that the pouch is wound
volume of the ink failure correctly.
pouch and winding]
[Yellow
2083 Check the remaining | (Y) Pouch winding Check that the pouch is wound
volume of the ink failure correctly.
pouch and winding]
Take out the white 12 cartridge,
open the cover, and have the ink
[White 12 Check The The white 12 ink pouch winded.properly. Close the
2084 Cartridge] pouch may not be cover, set the ink pouch back to
inded properly.
W properly the printer, and press @ to
clear the error.
Take out the white 34 cartridge,
open the cover, and have the ink
The white 34 ink ouch winded properly. Close the
[White 34 Check The white S 1 pouch winded properly
2085 Cartridge] pouch may not be cover, set the ink pouch back to
inded ly.
winded properly. the printer, and press @ to
clear the error.
An error has been
2090 [Ink Pouch Error detected in the black !n that case, replace with a new
Black] , ink pouch set.
ink pouch.
Al has b
[Ink Pouch Error n error ,aS een In that case, replace with a new
2091 detected in the ,
Magenta] ) ink pouch set.
magenta ink pouch.
An error has been
[Ink Pouch Error , In that case, replace with a new
2092 Cyan] detected in the cyan ink pouch set
Y ink pouch. P '
An error has been
[Ink Pouch Error , In that case, replace with a new
2093 detected in the yellow |,
Yellow] , ink pouch set.
ink pouch.
An error has been
[Ink Pouch Error ) . In that case, replace with a new
2094 White 12] detected in the white ink pouch set
12 ink pouch. P '
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Error code Error message Description Remedy Reference
An error has been -
[Ink Pouch Error , , In that case, replace with a new
2095 , detected in the white |,
White 34] ) ink pouch set.
34 ink pouch.
Insert a USB flash memory into "9-1. Troubleshooting
the slot, wait for a couple of instructions >>P.248"
seconds, and perform the
No USB flash memory | operation.
[USB flash drive Not _ memory op _
2100 Ready] been inserted into its | Insert a USB flash memory into
y insertion slot. the slot again.
If the problem still persists, check
on the format and type of the USB
flash memory.
At the writing stage to | Use your PC to check free space | -
the USB flash on the USB flash memory.
2101 |[Not Enough Area] memory there is not | Insert the USB flash memory that
enough free space to | has enough free space into the
store the data. insertion slot.
Connect the USB flash memory to | "9-1. Troubleshooting
your PC for checking the instructions >>P.248"
No valid file exists in a | information stored in it.
2105 |[No Files
[ les] USB flash memory. If an ARXP or ARX4 file has been
saved to it, check its content by
means of the file viewer.
After the power is -
[Receiving History turned on, itis found
210 Press to clear the error.
W/O Error1] that there is no print @
data received.
Because the Print -
Data Auto Delete Press @ to clear the error.
Print Data Auto Enable function
2120 [Pr . , ! i I When you use the receiving
Delete Enable] remains active, no , ,
. ) ) history, disable the Auto Job
receiving history is ,
. Delete option.
available.
Because the White -
Press to clear the error.
[White Ink Pause Ink Pause Mode @
2130 |Mode... remains active, no When you use the white ink, do
Non-performable] white ink can be not make the White Ink Pause
installed. Mode active.
Although an ink pouch -
is needed, a .
[Maintenance Pouch , , Set an ink pouch to the black
2200 maintenance solution ,
Set Black] , cartridge.
pouch is set to the
black cartridge.
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Error code Error message Description Remedy Reference
Although an ink pouch
is needed, a ,
[Maintenance Pouch , , Set an ink pouch to the magenta
2201 maintenance solution ,
Set Magenta] , cartridge.
pouch is set to the
magenta cartridge.
Although an ink pouch
is needed, a ,
[Maintenance Pouch ) ) Set an ink pouch to the cyan
2202 maintenance solution ,
Set Cyan] , cartridge.
pouch is set to the
cyan cartridge.
Although an ink pouch
is needed, a .
[Maintenance Pouch ) ) Set an ink pouch to the yellow
2203 maintenance solution ,
Set Yellow] , cartridge.
pouch is set to the
yellow cartridge.
Although an ink pouch
is needed, a . .
[Maintenance Pouch ! ) i Set the ink pouch to the white 12
2204 , maintenance solution ,
Set White12] , cartridge.
pouch is set to the
white 12 cartridge.
Although an ink pouch
is needed, a . .
[Maintenance Pouch ! ) i Set the ink pouch to the white 34
2205 ) maintenance solution )
Set White34] , cartridge.
pouch is set to the
white 34 cartridge.
Although a
int luti
[Ink Pouch Set main ehance solution Set the maintenance solution
2214 i pouch is needed, an ) ,
White12] . ) pouch to the white 12 cartridge.
ink pouch is set to the
white 12 cartridge.
Although a
maintenance solution
[Ink Pouch Set , Set the maintenance solution
2215 i pouch is needed, an ) ,
White34] . ) pouch to the white 34 cartridge.
ink pouch is set to the
white 34 cartridge.
If the problem still persists even
[Special operation Under the operation P i P ) ! v
2300 . after restarting the printer, please
mode] by the service man
contact your dealer.
Since the parts have
[Perform test printing | been replaced, you
2310 and check the have to perform test | Perform test printing following the
ejection from the printing and check the | on-screen instructions.
head] ejection from the
head.
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Error code Error message Description Remedy Reference
Since 18 or more

[Perform test printing | hours have passed,

2320 and check the you have to perform | Perform test printing following the
gjection from the test printing and on-screen instructions.

head] check the ejection

from the head.
Make sure that your PC is
connected to the printer, and
resend the print data. If you have
trouble in sending the data, restart
3000 [PC Communication | Data reception from | your PC and the printer.

Error] PC has suspended. | This error will also occur "when
the cable is removed during data
reception" or "when the ongoing
operation is canceled on the PC
during data reception".

Make sure that your PC is
connected to the printer, and start
operating the PC tool over from
the beginning. If you have trouble

[PC Communication | Data transmission to in sending theldata, restart your

3001 PC and the printer.

Error] PC has suspended. i
This error may also occur "when
the cable is removed during data
transmission" or "when the PC
tool is caused to stop running on
the PC during data transmission".
Make sure that your PC is

) connected to the printer, and
3002 |[PC Data Error] The GT has received resend the print data. If you have
an unsupported data. ) )
trouble in sending the data, restart
your PC and the printer.
The version of printer | Update the firmware of the PC's
3003 |[PC Data Error] driver disagrees with | printer driver as well as firmware
the firmware's version. | of the printer to the latest version.
Ascertain whether the updated
data of firmware you try to send is
correct or not.
) Make sure that your PC is
Itis the )
communication error connected to the printer, and start
3004 |[PC Data Error] communication between your PC
between your PC and , ,
the printer. and the Pnnt(.ar once aga|.n. If the
problem is still not remedied,
restart your PC and the printer.
If the problem still persists, please
contact your dealer.
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Make sure that your PC is
connected to the printer, and start

Itis the communication between your PC
communication error | and the printer once again. If the
3005 |[PC Data Error] prims gar
between your PC and | problem is still not remedied,
the printer. restart your PC and the printer.
If the problem still persists, please
contact your dealer.
Make sure that your PC is
connected to the printer, and start
Itis the communication between your PC
communication error | and the printer once again. If the
3010 |[PC Data Error] prims gar
between your PC and | problem is still not remedied,
the printer. restart your PC and the printer.
If the problem still persists, please
contact your dealer.
Make sure that your PC is
connected to the printer, and start
Itis the communication between your PC
communication error | and the printer once again. If the
3013 |[PC Data Error] p ) g )
between your PC and | problem is still not remedied,
the printer. restart your PC and the printer.
If the problem still persists, please
contact your dealer.
Make sure that your PC is
connected to the printer, and start
Itis the communication between your PC
communication error | and the printer once again. If the
3014 |[PC Data Error] dnicat p ! , 9 I_
between your PC and | problem is still not remedied,
the printer. restart your PC and the printer.
If the problem still persists, please
contact your dealer.
Too many print data
ypr Number of the print data should
3015 [Can no longer has been sent from be b to 99 during anv orint
receive data] the PC during the print P ) ganyp
. operation.
operation.
On the setting screen of printer
Such print data that , . g . P .
o driver, verify that the ink selection
uses the white ink )
. ) is set to [Color Ink Only].
[PC Data Error (with | was sent to the printer ) L
3100 ) L ) While the white ink pause mode
White)] which is placed in the i . ) .
white ink pause remains active, any print data in
P which the white ink is included
mode. .
cannot be received.
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In the orint data. some Check on the ARXP file by means | -
comman in inc70rrect of "GTX pro File Viewer"

3400 |[PC Data Error] ) Create the print data once again.
command length is ) )
. If the problem still persists, please
included.
contact your dealer.
Check on the ARXP file by means | -
In the print data, some | of "GTX pro File Viewer"
3401 |[PC Data Error] undefined command | Create the print data once again.
is included. If the problem still persists, please
contact your dealer.
Check on the ARXP file by means | -
Itis the sequence of "GTX pro File Viewer"
3402 |[PC Data Error] ) & i Create the print data once again.
error in the print data. . .
If the problem still persists, please
contact your dealer.
- The print data for -
blank page is received
from PC.
- When performing
the printing, you have
selected a totally Check on the ARXP file by means
white image pattern | of "GTX pro File Viewer"
portion as a printing | For example, please confirm the
3407 |[Blank Data] range in your software | print range and paper size for your
application, and sent it | software application through the
to the printer. Print Preview function, etc. of
- You have created a | Photoshop.
larger image than the
specified paper size,
and tried to print out a
part of it in the printer,
among others.
Make note of their error code and | -
[PC Data Error (ftoo | The print data ! )
3408 L error message, and please notify
large)] capacity is too large. |,
it to your dealer.
Check on the ARXP file by means | -
of "GTX pro File Viewer"
) Make sure that your PC is
Itis the i
communication error connected to the printer, and start
3410 |[PC Data Error] communication between your PC
between your PC and , )
) and the printer once again.
the printer. )
Restart your PC and the printer.
If the problem still persists, please
contact your dealer.

322



Error message

I

Error code

Error message

Description

Remedy

Reference

3411

[PC Data Error]

Itis the
communication error
between your PC and
the printer.

Check on the ARXP file by means
of "GTX pro File Viewer"

Make sure that your PC is
connected to the printer, and start
communication between your PC
and the printer once again.
Restart your PC and the printer.

If the problem still persists, please
contact your dealer.

3412

[PC Data Error]

Itis the
communication error
between your PC and
the printer.

Check on the ARXP file by means
of "GTX pro File Viewer"

Make sure that your PC is
connected to the printer, and start
communication between your PC
and the printer once again.
Restart your PC and the printer.

If the problem still persists, please
contact your dealer.

4100

[USB flash drive
Access Error]

No file can be
opened.

Check on the content of USB
flash memory.

Insert a USB flash memory into
the slot again, and perform the
required operation once more.

If the problem is still not remedied,
restart the printer and try to
operate it once again.

"9-1. Troubleshooting
instructions >>P.248"

4101

[USB flash drive
Access Error]

No file can be created.

Check on the content of USB
flash memory.

Insert a USB flash memory into
the slot again, and perform the
required operation once more.

If the problem is still not remedied,
restart the printer and try to
operate it once again.

"9-1. Troubleshooting
instructions >>P.248"

4103

[USB flash drive
Access Error]

File search has ended
up in failure.

Check on the content of USB
flash memory.

Insert a USB flash memory into
the slot again, and perform the
required operation once more.

If the problem is still not remedied,
restart the printer and try to
operate it once again.

"9-1. Troubleshooting
instructions >>P.248"
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4104

[USB flash drive
Access Error]

The system has failed
to read the file.

Check on the content of USB
flash memory.

Insert a USB flash memory into
the slot again, and perform the
required operation once more.

If the problem is still not remedied,
restart the printer and try to
operate it once again.

"9-1. Troubleshooting
instructions >>P.248"

4105

[USB flash drive
Access Error]

The system has failed
to write the file.

Check on the content of USB
flash memory.

Insert a USB flash memory into
the slot again, and perform the
required operation once more.

If the problem is still not remedied,
restart the printer and try to
operate it once again.

"9-1. Troubleshooting
instructions >>P.248"

4106

[llegal Format]

There is something
wrong with the file's
data.

Check on the content of USB
flash memory.

Insert a USB flash memory into
the slot again, and perform the
required operation once more.

If the problem is still not remedied,
restart the printer and try to
operate it once again.

"9-1. Troubleshooting
instructions >>P.248"

4108

[USB flash drive
Access Error]

The system has failed
to obtain the file size.

Check on the content of USB
flash memory.

Insert a USB flash memory into
the slot again, and perform the
required operation once more.

If the problem is still not remedied,
restart the printer and try to
operate it once again.

"9-1. Troubleshooting
instructions >>P.248"

4200

[Machine Error]

Abnormal indication is
found in the language
data on the LCD
screen.

In the event that this error is
displayed after suspending the
updating of firmware, please start
the updating operation over from
the beginning.

If the problem still persists, please
contact your dealer.

4201

[Machine Error]

Abnormal indication is
found in the language
data on the LCD
screen.

In the event that this error is
displayed after suspending the
updating of firmware, please start
the updating operation over from
the beginning.

If the problem still persists, please

contact your dealer.
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In the event that this error is
Abnormal indication is displalyed after suspending the
) updating of firmware, please start
4202 |[Machine Error] found in the language the updating operation over from
data on the LCD o
Screen. the beginning.
If the problem still persists, please
contact your dealer.
In the event that this error is
displayed after suspending the
An error is detected in | updating of firmware, please start
4400 |[Test print data Error] |the print data for test | the updating operation over from
print menu. the beginning.
If the problem still persists, please
contact your dealer.
In the event that this error is
displayed after suspending the
An error is detected in | updating of firmware, please start
4401 |[Test print data Error] |the print data for test | the updating operation over from
print menu. the beginning.
If the problem still persists, please
contact your dealer.
In the event that this error is
displayed after suspending the
An error is detected in | updating of firmware, please start
4402 |[Test print data Error] |the print data for test | the updating operation over from
print menu. the beginning.
If the problem still persists, please
contact your dealer.
Press @ to clear the error.
The network interface | Contact your network setup
4500 |[Network error] was unable to be manager and network
activated. administrator.
If the problem still persists, please
contact your dealer.
An error has been Press @ to clear the error.
4501 |[Network error] detected in the.statlc Use the maintenance tool to set
IP address setting and ,
subnet mask value. up a correct static IP address. and
subnet mask value once again.
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Press @ to clear the error.
The network interface | Contact your network setup
4502 |[Network error] setting has ended up | manager and network
in failure. administrator.
If the problem still persists, please
contact your dealer.
Press to clear the error.
An error was found in @
4503 |[Network error] the static IP address | Use the maintenance tool to set
of the default gateway. | up a correct static IP address of
default gateway once again.
Press to clear the error.
It is the error of static @
4504 | [Network error] IP address setup Use the maintenance tool to set
value. up a correct static IP address and
subnet mask value once again.
No data can be
) Make note of the error code and
[No Enable Restore | restored because its )
4506 error message, and please notify
Data] backup copy was not |,
it to your dealer.
made.
, , Press @ to clear the error.
Error in configuring
4510 |[Network error] the network for the Check the network settings.
printer Contact your network setup
manager if you have a question.
Atimeout has Make note of the error code and
5001 |[Machine Error] occurred at the time of | error message, and please notify
initialization. it to your dealer.
Press to clear the error.
An error is detected in @
5010 |[PC Data Error] the current print data | Create the print data again on the
being run. PC to load it to the printer, and try
the print operation again.
The carriage If the problem still persists even
5020 |[Machine Error] movement was not after restarting the printer, please
completed. contact your dealer.
L If the problem still persists even
. Head operation is i .
5021 |[Machine Error] ) after restarting the printer, please
incomplete.
contact your dealer.
L If the problem still persists even
. Head operation is i .
5022 |[Machine Error] ) after restarting the printer, please
incomplete.
contact your dealer.
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Maintenance unit If the problem still persists even
5080 |[Machine Error] operation is after restarting the printer, please
incomplete. contact your dealer.
Maintenance unit If the problem still persists even
5081 |[Machine Error] operation is after restarting the printer, please
incomplete. contact your dealer.
The platen cannot be | Make note of the error code and
5094 |[Machine Error] moved toward the error message, and please notify
rear of the printer. it to your dealer.
The platen cannot be | Make note of the error code and
5095 |[Machine Error] moved toward the error message, and please notify
front of the printer. it to your dealer.
The platen cannot be Make note of the error code and
5096 |[Machine Error] roIIec:) error message, and please notify
' it to your dealer.
) Check to see if there is any
Itis the .
L source near the printer that
communication error roduces a loud noise
5200 |[Machine Error] between the main P ) )
If the problem still persists even
board and the , )
i ) after restarting the printer, please
maintenance unit.
contact your dealer.
) Check to see if there is any
Itis the .
L source near the printer that
communication error roduces a loud noise
5201 |[Machine Error] between the main  |© foise.
If the problem still persists even
board and the , )
i ) after restarting the printer, please
maintenance unit.
contact your dealer.
) Check to see if there is any
Itis the ,
L source near the printer that
communication error roduces a loud noise
5230 |[Machine Error] between the main P ) )
If the problem still persists even
board and the , )
. . after restarting the printer, please
maintenance unit.
contact your dealer.
. Check to see if there is any
Itis the i
L source near the printer that
communication error roduces a loud noise
5231 |[Machine Error] between the main P ) )
If the problem still persists even
board and the , )
i ) after restarting the printer, please
maintenance unit.
contact your dealer.
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Check to see if there is an -
Itis the . y
o source near the printer that
communication error roduces a loud noise
5232 |[Machine Error] between the main P ) )
If the problem still persists even
board and the . .
i ) after restarting the printer, please
maintenance unit.
contact your dealer.
) Check to see if there is any -
Itis the .
L source near the printer that
communication error roduces a loud noise
5233 |[Machine Error] between the main P ) )
If the problem still persists even
board and the , )
i ) after restarting the printer, please
maintenance unit.
contact your dealer.
) Check to see if there is any -
Itis the .
o source near the printer that
communication error roduces a loud noise
5240 |[Machine Error] between the main |- noise.
If the problem still persists even
board and the , )
i ) after restarting the printer, please
maintenance unit.
contact your dealer.
) Check to see if there is any -
Itis the i
L source near the printer that
communication error roduces a loud noise
5241 | [Machine Error] between the main P . )
If the problem still persists even
board and the , ,
. . after restarting the printer, please
maintenance unit.
contact your dealer.
As itis likely that the firmware's file | -
The program data of | is corrupted, obtain a proper file of
the firmware of the firmware which is not
maintenance unit, corrupted.
5250 |[Machine Error] ) P . .
which you try to If the problem still persists even
update, has been after restarting the printer and
found to be defective. |your PC, please contact your
dealer.
In the event that this error is -
displayed aft ding th
Aversion of the isp aye after suspending the
frmware of updating of firmware, please start
5260 |[Machine Error] , . the updating operation over from
maintenance unit is .
. . the beginning.
incompatible. . .
If the problem still persists, please
contact your dealer.
Restart the printer and update the | -
The printer is firmware again. Check if the
connected to a firmware update file is for the
5261 |[Machine Error] , P i
maintenance board model of your printer.
for a different model. | If the problem still persists, please
contact your dealer.
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Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5301 |[Machine Error] P ) i
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the color side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5302 |[Machine Error] P ) i
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the color side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5303 |[Machine Error] P ) ,
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the color side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5304 |[Machine Error] P . .
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the color side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5305 |[Machine Error] P ) i
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the color side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5306 | [Machine Error] P foise.
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the color side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5307 |[Machine Error] P ) i
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the color side). contact your dealer.
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Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5311 |[Machine Error] P ) i
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the color side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.
5312 |[Machine Error] P ) i
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the color side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.
5313 |[Machine Error] P . .
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the color side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.
5314 | [Machine Error] P . .
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the color side). contact your dealer.
The cam of the ) i
maintenance unit (on If the problem still persists even
5320 |[Machine Error] , after restarting the printer, please
the color side)
. contact your dealer.
malfunctions.
The cam of the
maintenance unit (on If the problem still persists even
5321 |[Machine Error] ) after restarting the printer, please
the color side)
) contact your dealer.
malfunctions.
The cam of the , ,
maintenance unit (on If the problem still persists even
5322 |[Machine Error] , after restarting the printer, please
the color side)
. contact your dealer.
malfunctions.
The cam of the . .
maintenance unit (on If the problem still persists even
5323 |[Machine Error] ) after restarting the printer, please
the color side)
) contact your dealer.
malfunctions.
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Check to see if the wiper is
. properly installed and there is no
The wiper of the
mainteﬁance unit (on obstacle around the wiper or
5330 |[Machine Error] ) wiper cleaner.
the color side) . .
malfunctions If the problem still persists even
' after restarting the printer, please
contact your dealer.
Check to see if the wiper is
The wiber of the properly installed and there is no
mainteFr)]ance unit (on obstacle around the wiper or
5331 |[Machine Error] ) wiper cleaner.
the color side) ) i
malfunctions If the problem still persists even
' after restarting the printer, please
contact your dealer.
Check to see if the wiper is
. properly installed and there is no
The wiper of the
mainteﬁance unit (on obstacle around the wiper or
5332 |[Machine Error] ) wiper cleaner.
the color side) . .
malfunctions If the problem still persists even
) after restarting the printer, please
contact your dealer.
Check to see if the wiper is
The wioer of the properly installed and there is no
mainteFr)]ance unit (on obstacle around the wiper or
5333 |[Machine Error] , wiper cleaner.
the color side) ) .
malfunctions If the problem still persists even
' after restarting the printer, please
contact your dealer.
Check to see if the wiper is
The wiper of the properly installed and there is no
mainteaance unit (on obstacle around the wiper or
5340 |[Machine Error] ) wiper cleaner.
the color side) . .
malfunctions If the problem still persists even
) after restarting the printer, please
contact your dealer.
Check to see if the wiper is
The wioer of the properly installed and there is no
mainte::ance unit (on obstacle around the wiper or
5341 |[Machine Error] ) wiper cleaner.
the color side) . .
malfunctions If the problem still persists even
' after restarting the printer, please
contact your dealer.
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Check to see if the wiper is
roperly installed and there is no
The wiper of the property .
maintenance unit (on obstacle around the wiper or
5342 |[Machine Error] ) wiper cleaner.
the color side) ) ,
) If the problem still persists even
malfunctions. , .
after restarting the printer, please
contact your dealer.
Check to see if the wiper is
roperly installed and there is no
The wiper of the properly )
maintenance unit (on obstacle around the wiper or
5343 |[Machine Error] ) wiper cleaner.
the color side) , ,
) If the problem still persists even
malfunctions. i X
after restarting the printer, please
contact your dealer.
, . Check to see if there is any
It is an internal error of )
, .. | source near the printer that
the maintenance unit .
(on the color side) produces a loud noise.
5350 |[Machine Error] L S Restart the printer and update the
which is associated :
) i firmware again.
with updating of , ,
If the problem still persists, please
firmware.
contact your dealer.
, ) Check to see if there is any
It is an internal error of i
. .. | source near the printer that
the maintenance unit }
(on the color side) produces a loud noise.
5351 |[Machine Error] L D Restart the printer and update the
which is associated ,
. . firmware again.
with updating of ) ,
If the problem still persists, please
firmware.
contact your dealer.
, , Check to see if there is any
It is an internal error of ,
, .. | source near the printer that
the maintenance unit )
(on the color side) produces a loud noise.
5352 |[Machine Error] o e Restart the printer and update the
which is associated :
. . firmware again.
with updating of , ,
If the problem still persists, please
firmware.
contact your dealer.
, . Check to see if there is any
It is an internal error of i
. .. | source near the printer that
the maintenance unit .
(on the color side) produces a loud noise.
5353 |[Machine Error] . s Restart the printer and update the
which is associated ,
) , firmware again.
with updating of , ,
If the problem still persists, please
firmware.
contact your dealer.
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Itis the
L Check to see if there is any
communication error i
) source near the printer that
between the main )
board and the produces a loud noise.
5354 |[Machine Error] i ) Restart the printer and update the
maintenance unit (on ,
, ) firmware again.
the color side), which . )
, i ) If the problem still persists, please
is associated with the
. contact your dealer.
updating of firmware.
Itis the
o Check to see if there is any
communication error i
) source near the printer that
between the main ]
board and the produces a loud noise.
5355 |[Machine Error] . . Restart the printer and update the
maintenance unit (on ,
, , firmware again.
the color side), which . )
, i ) If the problem still persists, please
is associated with the
. contact your dealer.
updating of firmware.
Itis the
o Check to see if there is any
communication error i
, source near the printer that
between the main ,
board and the produces a loud noise.
5356 |[Machine Error] i ) Restart the printer and update the
maintenance unit (on .
, , firmware again.
the color side), which . )
, i ) If the problem still persists, please
is associated with the
. contact your dealer.
updating of firmware.
Itis the
o Check to see if there is any
communication error .
) source near the printer that
between the main ,
produces a loud noise.
. board and the .
5357 |[Machine Error] i ) Restart the printer and update the
maintenance unit (on .
, , firmware again.
the color side), which ) ,
, i ) If the problem still persists, please
is associated with the
. contact your dealer.
updating of firmware.
It is an internal error of
the maintenance unit | Restart the printer and update the
on the color side), firmware again.
5358 |[Machine Error] ( L . ) 9 . .
which is associated If the problem still persists, please
with updating of contact your dealer.
firmware.
It is an internal error of
the maintenance unit | Restart the printer and update the
on the color side), firmware again.
5359 |[Machine Error] ( L . ) g . :
which is associated If the problem still persists, please
with updating of contact your dealer.
firmware.
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When the solenoid is
in operation, there is a | Restart the printer and update the
mismatch between firmware again.
5361 |[Machine Error] ) g ) ,
the main board and If the problem still persists, please
the maintenance unit | contact your dealer.
(on the color side).
L Check to see if there is any
Communication error )
: i source that produces a loud noise
during the ink sensor ,
. . near the printer.
5371 |[Machine Error] reading of the ) i
) ) If the problem still persists even
maintenance unit . .
(color) after reactivating the printer,
please contact your dealer.
. Check to see if there is any
Communication error ,
i i source that produces a loud noise
during the ink sensor near the orinter
5372 |[Machine Error] reading of the P " .
) ) If the problem still persists even
maintenance unit . .
(color) after reactivating the printer,
please contact your dealer.
o Check to see if there is any
Communication error )
, i source that produces a loud noise
during the ink sensor near the orinter
5373 |[Machine Error] reading of the P y .
, ) If the problem still persists even
maintenance unit L ,
(color) after reactivating the printer,
please contact your dealer.
. Check to see if there is any
Communication error ,
, , source that produces a loud noise
during the ink sensor near the brinter
5374 | [Machine Error] reading of the P y .
, , If the problem still persists even
maintenance unit L ,
(color) after reactivating the printer,
please contact your dealer.
. Check to see if there is any
Communication error ,
i i source that produces a loud noise
during the ink sensor near the brinter
5375 |[Machine Error] reading of the P y i
, ) If the problem still persists even
maintenance unit - .
(color) after reactivating the printer,
please contact your dealer.
L Check to see if there is any
Communication error )
i : source that produces a loud noise
during the ink sensor near the printer.
5376 |[Machine Error] reading of the P y i
, ) If the problem still persists even
maintenance unit I~ .
(color) after reactivating the printer,
please contact your dealer.
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L Check to see if there is any
Communication error )
i : source that produces a loud noise
during the ink sensor .
. . near the printer.
5377 |[Machine Error] reading of the ) i
, ) If the problem still persists even
maintenance unit - .
(color) after reactivating the printer,
please contact your dealer.
L Check to see if there is any
Communication error )
: i source that produces a loud noise
during the ink sensor near the orinter
5378 |[Machine Error] reading of the P y i
) ) If the problem still persists even
maintenance unit . .
(color) after reactivating the printer,
please contact your dealer.
It is the internal error | Restart the printer and update the
of the maintenance firmware again.
5391 |[Machine Error] _ gam.
unit (on the color If the problem still persists, please
side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.
5401 |[Machine Error] P fnoise.
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the white side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.
5402 | [Machine Error] P fnoise.
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the white side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.
5403 |[Machine Error] P ) i
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the white side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.
5404 |[Machine Error] P . .
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the white side). contact your dealer.
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Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5405 | [Machine Error] P fnoise.
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the white side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5406 |[Machine Error] P ) i
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the white side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5407 |[Machine Error] P . .
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the white side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5411 |[Machine Error] P noise.
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the white side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5412 |[Machine Error] P . ;
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the white side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5413 | [Machine Error] P foise.
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the white side). contact your dealer.
Itis the Check to see if there is any
communication error | source near the printer that
between the main roduces a loud noise.

5414 |[Machine Error] P . .
board and the If the problem still persists even
maintenance unit (on | after restarting the printer, please
the white side). contact your dealer.
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The cam of the
maintenance unit (on If the problem still persists even
5420 |[Machine Error] o after restarting the printer, please
the white side)
i contact your dealer.
malfunctions.
The cam of the , ,
i . If the problem still persists even
) maintenance unit (on , )
5421 |[Machine Error] L after restarting the printer, please
the white side)
. contact your dealer.
malfunctions.
The cam of the . .
i ) If the problem still persists even
, maintenance unit (on ) )
5422 |[Machine Error] W after restarting the printer, please
the white side)
i contact your dealer.
malfunctions.
The cam of the , ,
maintenance unit (on If the problem still persists even
5423 | [Machine Error] L after restarting the printer, please
the white side)
. contact your dealer.
malfunctions.
Check to see if the wiper cleaner
is properly installed and there is
The wiper cleaner of property .
the maintenance unit no obstacle around the wiper or
5430 |[Machine Error] o wiper cleaner.
(on the white side) ) i
) If the problem still persists even
malfunctions. . .
after restarting the printer, please
contact your dealer.
Check to see if the wiper cleaner
is properly installed and there is
The wiper cleaner of properly :
i .| no obstacle around the wiper or
, the maintenance unit ,
5431 | [Machine Error] L wiper cleaner.
(on the white side) . ;
) If the problem still persists even
malfunctions. , X
after restarting the printer, please
contact your dealer.
Check to see if the wiper cleaner
is properly installed and there is
The wiper cleaner of property .
i .. | no obstacle around the wiper or
, the maintenance unit ,
5432 |[Machine Error] o wiper cleaner.
(on the white side) ) i
) If the problem still persists even
malfunctions. . .
after restarting the printer, please
contact your dealer.
Check to see if the wiper cleaner
is properly installed and there is
The wiper cleaner of properly )
i .| no obstacle around the wiper or
, the maintenance unit )
5433 |[Machine Error] L wiper cleaner.
(on the white side) . ;
) If the problem still persists even
malfunctions. , )
after restarting the printer, please
contact your dealer.
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Check to see if the wiper is
The wiper of the properly installed and ’Fhere is no
maintenance unit (on obstacle around the wiper or
5440 |[Machine Error] o wiper cleaner.
the white side) . .
i If the problem still persists even
malfunctions. , )
after restarting the printer, please
contact your dealer.
Check to see if the wiper is
roperly installed and there is no
The wiper of the properly )
maintenance unit (on obstacle around the wiper or
5441 |[Machine Error] L wiper cleaner.
the white side) , ,
i If the problem still persists even
malfunctions. . .
after restarting the printer, please
contact your dealer.
Check to see if the wiper is
roperly installed and there is no
The wiper of the properly . |
maintenance unit (on obstacle around the wiper or
5442 | [Machine Error] L wiper cleaner.
the white side) . .
i If the problem still persists even
malfunctions. , ,
after restarting the printer, please
contact your dealer.
Check to see if the wiper is
roperly installed and there is no
The wiper of the properly .
maintenance unit (on obstacle around the wiper or
5443 |[Machine Error] o wiper cleaner.
the white side) ) i
i If the problem still persists even
malfunctions. . .
after restarting the printer, please
contact your dealer.
, , Check to see if there is any
It is an internal error of ,
, .. | source near the printer that
the maintenance unit )
(on the white side) produces a loud noise.
5450 |[Machine Error] o 7 Restart the printer and update the
which is associated :
, , firmware again.
with updating of , ,
If the problem still persists, please
firmware.
contact your dealer.
, . Check to see if there is any
It is an internal error of i
. .. | source near the printer that
the maintenance unit .
(on the white side) produces a loud noise.
5451 | [Machine Error] L e Restart the printer and update the
which is associated ,
) , firmware again.
with updating of . .
If the problem still persists, please
firmware.
contact your dealer.
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, . Check to see if there is any
It is an internal error of )
, .. | source near the printer that
the maintenance unit .
(on the white side) produces a loud noise.
5452 |[Machine Error] L 7 Restart the printer and update the
which is associated :
) i firmware again.
with updating of ) ,
If the problem still persists, please
firmware.
contact your dealer.
, ) Check to see if there is any
It is an internal error of i
. .. | source near the printer that
the maintenance unit ,
(on the white side) produces a loud noise.
5453 |[Machine Error] o 7 Restart the printer and update the
which is associated )
. . firmware again.
with updating of ) ,
If the problem still persists, please
firmware.
contact your dealer.
Itis the
L Check to see if there is any
communication error i
) source near the printer that
between the main )
board and the produces a loud noise.
5454 | [Machine Error] , , Restart the printer and update the
maintenance unit (on frmware aqain
the white side), which 9 . .
, , ) If the problem still persists, please
is associated with the
. contact your dealer.
updating of firmware.
Itis the
L Check to see if there is any
communication error i
) source near the printer that
between the main )
board and the produces a loud noise.
5455 |[Machine Error] i ) Restart the printer and update the
maintenance unit (on frmware aqain
the white side), which gam.
, , ) If the problem still persists, please
is associated with the
. contact your dealer.
updating of firmware.
Itis the
o Check to see if there is any
communication error i
) source near the printer that
between the main )
board and the produces a loud noise.
5456 |[Machine Error] i ) Restart the printer and update the
maintenance unit (on frmware again
the white side), which gam.
, , ) If the problem still persists, please
is associated with the
, contact your dealer.
updating of firmware.
Itis the
o Check to see if there is any
communication error i
. source near the printer that
between the main ,
board and the produces a loud noise.
5457 | [Machine Error] i , Restart the printer and update the
maintenance unit (on frmware again
the white side), which gam.
, , ) If the problem still persists, please
is associated with the
, contact your dealer.
updating of firmware.

339



Error message

I

Error code Error message Description Remedy Reference
It is an internal error of
the maintenance unit | Restart the printer and update the
on the white side), firmware again.

5458 |[Machine Error] ( L . ) 9 . .
which is associated If the problem still persists, please
with updating of contact your dealer.
firmware.

It is an internal error of
the maintenance unit | Restart the printer and update the
on the white side), firmware again.

5459 |[Machine Error] ( . . : 9 . .
which is associated If the problem still persists, please
with updating of contact your dealer.
firmware.

When the solenoid is
in operation, there is a ,

i P Restart the printer and update the
mismatch between frmware aqain

5461 |[Machine Error] the state of the main If the roblgm s.tiII ersists. please
board and that of the P P P

i ) contact your dealer.
maintenance unit (on
the white side).
Itis the Check to see if there is any
communication error | source near the printer that
between the roduces a loud noise.

5471 |[Machine Error] . , P . .
maintenance unit (on | If the problem still persists even
the white side) and after restarting the printer, please
the cartridge sensor. | contact your dealer.

Itis the Check to see if there is any
communication error | source near the printer that
, between the produces a loud noise.

5472 |[Machine Error] . , . .
maintenance unit (on | If the problem still persists even
the white side) and after restarting the printer, please
the cartridge sensor. | contact your dealer.

Itis the Check to see if there is any
communication error | source near the printer that
, between the produces a loud noise.

5473 |[Machine Error] ) , . .
maintenance unit (on | If the problem still persists even
the white side) and after restarting the printer, please
the cartridge sensor. | contact your dealer.

Itis the Check to see if there is any
communication error | source near the printer that
between the roduces a loud noise.

5474 | [Machine Error] , , P . .
maintenance unit (on | If the problem still persists even
the white side) and after restarting the printer, please
the cartridge sensor. | contact your dealer.
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Itis the Check to see if there is any
communication error | source near the printer that
between the roduces a loud noise.

5475 |[Machine Error] . , procu y . | .
maintenance unit (on | If the problem still persists even
the white side) and after restarting the printer, please
the cartridge sensor. | contact your dealer.

Itis the Check to see if there is any
communication error | source near the printer that
, between the produces a loud noise.

5476 |[Machine Error] . , . .
maintenance unit (on | If the problem still persists even
the white side) and after restarting the printer, please
the cartridge sensor. | contact your dealer.

Itis the Check to see if there is any
communication error | source near the printer that

5477 | Machine Error] between the . produces a Ioud.noise..
maintenance unit (on | If the problem still persists even
the white side) and after restarting the printer, please
the cartridge sensor. | contact your dealer.

Itis the Check to see if there is any
communication error | source near the printer that
between the roduces a loud noise.

5478 | [Machine Error] . . P . .
maintenance unit (on | If the problem still persists even
the white side) and after restarting the printer, please
the cartridge sensor. | contact your dealer.

Check to see if there is any
It is the internal error | source near the printer that
of the maintenance roduces a loud noise.

5491 | [Machine Error] . ! . produ ! . ! .
unit (on the white If the problem still persists even
side). after restarting the printer, please

contact your dealer.
The sub tank of black
Check the ink pouch (black) for
5501 |[Machine Eror] ink i not filled with ink pouch (black)
. any abnormalities.
black ink.
The sub tank of

5502 | [Machine Error] magen.ta ink is not Check the ink poy?h (magenta)
filled with magenta for any abnormalities.
ink.

The sub tank of cyan
Check the ink pouch (cyan) for
5503 | [Machine Error] ink is not filled with fpouch (cyan)
, any abnormalities.
cyan ink.
The sub tank of yellow
Check the ink pouch (yellow) for
5504 | [Machine Error] ink is not filled with fpouch (yellow)
) any abnormalities.
yellow ink.
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Remove the ink cartridge, check
winding, and then install the

5520 | [Machine Error] Féile.d to calibrate the | cartridge correct.ly. .
winding sensor If the problem still persists even
after restarting the printer, please
contact your dealer.
:gznﬁ;il:;hv\v,;ltis If the problem still persists even
5600 |[Machine Error] . after restarting the printer, please
abnormal timing at the
. e contact your dealer.
time of initialization.
Check if the ink pouch is seated
on the ink cartridge correctly.
An abnormality was | Ensure that the ink cartridge is
5601 |[Machine Error] detected when tried to | correctly placed on the printer.
check the ink pouch. | If the problem still persists even
after restarting the printer, please
contact your dealer.
Check if the ink pouch is seated
on the ink cartridge correctly.
An abnormality was | Ensure that the ink cartridge is
5602 |[Machine Error] detected when tried to | correctly placed on the printer.
check the ink pouch. | If the problem still persists even
after restarting the printer, please
contact your dealer.
Check if the ink pouch is seated
on the ink cartridge correctly.
An abnormality was | Ensure that the ink cartridge is
5603 |[Machine Error] detected when tried to | correctly placed on the printer.
check the ink pouch. | If the problem still persists even
after restarting the printer, please
contact your dealer.
Check to see if there is any
source near the printer that
Itis the produces a loud noise.
communication error | If a USB flash memory is inserted
5801 | [Machine Error] between the main into the printer, remove the
board and the panel | memory first, and then restart the
board or the head printer.
board. If the problem still persists even
after restarting the printer, please
contact your dealer.
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Check to see if there is any
source near the printer that

Itis the produces a loud noise.
communication error | If a USB flash memory is inserted
between the main into the printer, remove the
5802 | [Machine Error] ' ! pr v
board and the panel | memory first, and then restart the
board or the head printer.
board. If the problem still persists even
after restarting the printer, please
contact your dealer.
Check to see if there is any
source near the printer that
Itis the produces a loud noise.
communication error | If a USB flash memory is inserted
between the main into the printer, remove the
5803 |[Machine Error] P
board and the panel | memory first, and then restart the
board or the head printer.
board. If the problem still persists even
after restarting the printer, please
contact your dealer.
Check to see if there is any
source near the printer that
Itis the produces a loud noise.
communication error | If a USB flash memory is inserted
between the main into the printer, remove the
5804 |[Machine Error] ! ! P v
board and the panel | memory first, and then restart the
board or the head printer.
board. If the problem still persists even
after restarting the printer, please
contact your dealer.
Check to see if the obstacle
sensor is covered with something.
[Obstacle on the It indicates some error i i g
6004 , If the problem still persists even
Platen] in the obstacle sensor. i )
after restarting the printer, please
contact your dealer.
The system failed to | Make note of their error code and
6010 |[PC Data Error] write the EEPROM of | error message, and please notify
the main board. it to your dealer.
The system failed to
erase};he FLASH Make note of the error code and
6011 Machine Error’ error message, and please noti
[ ] ROM of the main it to vour de:Ier P ty
board. y ’
The system failed to | Make note of the error code and
6012 |[Machine Error] write the FLASH ROM | error message, and please notify
of the main board. it to your dealer.
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The battery of the Make note of the error code and
6021 |[No Battery] real-time clock is fully | error message, and please notify
exhausted. it to your dealer.
Ascertain whether or not
i something is placed on the
) Platen button is out of )
6031 |[Machine Error] , operation panel.
working order.
For help, please contact your
dealer.
Ascertain whether or not
something is placed on the
) Print button is out of ) gisp
6032 |[Machine Error] , operation panel.
working order.
For help, please contact your
dealer.
Ascertain whether or not
, something is placed on the
. Stop button is out of )
6033 | [Machine Error] i operation panel.
working order.
For help, please contact your
dealer.
Ascertain whether or not
, something is placed on the
, Back button is out of )
6034 | [Machine Error] ) operation panel.
working order.
For help, please contact your
dealer.
Ascertain whether or not
, ) something is placed on the
, Right button is out of )
6035 |[Machine Error] , operation panel.
working order.
For help, please contact your
dealer.
Ascertain whether or not
thing is placed on th
, Down button is out of some ) ng s pracedon e
6036 |[Machine Error] , operation panel.
working order.
For help, please contact your
dealer.
Ascertain whether or not
something is placed on the
) Up button is out of ) grep
6037 |[Machine Error] , operation panel.
working order.
For help, please contact your
dealer.
Ascertain whether or not
Head cleaning button | something is placed on the
6038 | [Machine Error] is out of working operation panel.
order. For help, please contact your
dealer.
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Ascertain whether or not -
. MENU/OK button is something is placed on the
6039 |[Machine Error] , operation panel.
out of working order.
For help, please contact your
dealer.
Restart the printer and update the | -
The printer is firmware again. Check if the
connected to a firmware update file is for the
6045 | [Machine Error] , mware Upcaie tie |
maintenance board model of your printer.
for a different model. | If the problem still persists, please
contact your dealer.
Restart the printer and update the | -
The LCD panel p. , P
o firmware again. Check if the
firmware version is firmware update file is for the
6046 |[Machine Error] not compatible with P )
, model of your printer.
the main firmware ) )
) If the problem still persists, please
version.
contact your dealer.
Remove the ink cartridge, check | -
inding, and then install the
The winding sensor \c/:vellrtrild ge correctl |
6050 |[Machine Error] was detected to be 9 .y. i
fault If the problem still persists even
Y after restarting the printer, please
contact your dealer.
An Ethernet related , , -
If the problem still persists even
) hardware error was , )
6060 |[Machine Error] ) after restarting the printer, please
detected during
contact your dealer.
startup
The main board was | If the problem still persists even -
6090 |[Machine Error] not initialized after restarting the printer, please
sufficiently contact your dealer.
It indicates the If the problem still persists even -
6101 | [Machine Error] carriage's after reactivating the printer,
malfunction. please contact your dealer.
Check to see if something gets "7-1-6. Cleaning the
caught in the carriage or any internal area of printer
The carriage stops at | foreign object exists inside the >>p.192"
6102 | [Machine Error] > camage stop reign ODject exIsts Insl
an incorrect position. | printer.
If the problem still persists, please
contact your dealer.
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Check to see if something gets "7-1-6. Cleaning the
caught in the carriage or any internal area of printer

No cap can be locked | foreign object exists inside the >>P.192"
6103 |[Machine Error] , P , '9n ob) XSS Ins!
in place. printer.
If the problem still persists, please
contact your dealer.
Check to see if something gets "7-1-6. Cleaning the
caught in the carriage or any internal area of printer
Carriage does not foreign object exists inside the >>P.192"
6104 |[Machine Error] 9 , an ob)
move. printer.
If the problem still persists, please
contact your dealer.
Check to see if something gets "7-1-6. Cleaning the
The carriage's home | caught in the carriage or any internal area of printer
6105 |[Machine Error] .pt.)§iti.on return foreign object exists inside the >>p.192"
initialization has printer.
ended up in failure. If the problem still persists, please
contact your dealer.
Check to see if something gets "7-1-6. Cleaning the
caught in the carriage or an internal area of printer
The carriage has for:? n Iob'ect exi;tsg inside t}rlme I>>P 192" i
6106 |[Machine Error] bumped against the printgr ) '
frame. '
If the problem still persists, please
contact your dealer.
Check to see if something gets "7-1-6. Cleaning the
o caught in the carriage or any internal area of printer
The carriage’s reverse foreign object exists inside the >>p.192"
6107 |[Machine Error] rotation has been rintgr ) '
detected. P ' _ ,
If the problem still persists, please
contact your dealer.
Check to see if something gets "7-1-6. Cleaning the
caught in the carriage or an internal area of printer
Abnormal decrease in fore?J n object existsg inside t{]e >>p.192" "
6108 | [Machine Error] the speed of carriage rintgr ) '
has been detected.  |F ' . .
If the problem still persists, please
contact your dealer.
Check to see if something gets "7-1-6. Cleaning the
caught in the carriage or an internal area of printer
The carriage has fore?J n object existsg inside tﬁe >>P.192" "
6109 |[Machine Error] stopped abnormally rintgr ) '
within the print range. P ' _ ,
If the problem still persists, please
contact your dealer.
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Check to see if something gets "7-1-6. Cleaning the
mocamsgocana | IS ST o | e et
6110 |[Machine Error] move out of its locked orinter. '
position. . .
If the problem still persists, please
contact your dealer.
Check to see if something gets "7-1-6. Cleaning the
caught in the carriage or any internal area of printer
6111 | [Machine Error] Carriage canr.10t foreign object exists inside the >>P.192"
perform capping. printer.
If the problem still persists, please
contact your dealer.
The carriage If the problem still persists even -
6119 | [Machine Error] movement does not | after restarting the printer, please
come to a full stop. contact your dealer.
[Machine Error Adjust Itindicates an .| Clean the carriage. tl7_1_6' Cleaning the
6130 abnormal decrease in i ) internal area of printer
CR] ) Then, adjust the carriage speed.
the speed of carriage. >>P.192"
"7-1-6. Cleaning the
It indicates an internal area of printer
6131 [Machine Error Adjust excessive increase in Clean the carriage. >>P.192"
CR] ) Then, adjust the carriage speed. | "7-4-1. CR (Carriage)
the speed of carriage. ,
speed adjustment
>>pP.216"
"7-1-6. Cleaning the
internal area of printer
6132 [Machine Error Adjust | The carriage stops at | Clean the carriage. >>P.192"

CR] an incorrect position. | Then, adjust the carriage speed. | "7-4-1. CR (Carriage)
speed adjustment
>>pP.216"

It indicates an error in "7-1-6. Cleaning the
, the carriage speed Clean the carriage. internal area of printer
6133 |[Machine Error] i . .
adjustment (reverse | Then, adjust the carriage speed. | >>P.192"
motion).
It indicates an error in "7-1-6. Cleaning the
) the carriage speed Clean the carriage. internal area of printer
6134 | [Machine Error] i ) i
adjustment (forward | Then, adjust the carriage speed. | >>P.192"
motion).
Ascertain whether or not the cable | -
The color heads' for the heads is disconnected.
6220 |[Machine Error] temperature level is | If the problem still persists even
abnormal. after restarting the printer, please
contact your dealer.
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Ascertain whether or not the cable
The white heads' for the heads is disconnected.
6221 |[Machine Error] temperature level is | If the problem still persists even
abnormal. after restarting the printer, please
contact your dealer.
Ascertain whether or not the cable
It refers to abnormal o
) ) for the heads is disconnected.
6230 |[Machine Error] voltage in the color ) ,
heads If the problem still persists, please
' contact your dealer.
Ascertain whether or not the cable
It refers to abnormal o
, , , for the heads is disconnected.
6231 |[Machine Error] voltage in the white ) )
heads If the problem still persists, please
' contact your dealer.
Ascertain whether or not the cable
for the h is di ted.
_ It refers to FFC failure | O ¢ Neads is disconnected
6240 |[Machine Error] i If the problem still persists even
in the color heads. . .
after restarting the printer, please
contact your dealer.
Ascertain whether or not the cable
for the heads is disconnected.
, It refers to FFC failure ! ) I ,
6241 |[Machine Error] . ) If the problem still persists even
in the white heads. o .
after reactivating the printer,
please contact your dealer.
ltis the svstem call Make note of the error code and
7000 |[Machine Error] orror y error message, and please notify
’ it to your dealer.
If the problem still persists even
) ) after restarting the printer, please
) Firmware internal )
7012 | [Machine Error] contact your dealer after noting
error occurred.
the error code and message
displayed.
Itis the qeneral Make note of the error code and
7013 |[Machine Error] g error message, and please notify
program error. ,
it to your dealer.
Because the ongoing
print operation Send any print data to the printer
7015 | [Machine Error] remains unfinished, | while the printer is not performing
the next print data the printing operation.
cannot be printed out.
If the problem still persists even
ft tarting the printer, pl
) Internal error related anerresiarting fne prinier, p faase
7020 |[Machine Error] o ) contact your dealer after noting
to white ink circulation
the error code and message
displayed.
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If the problem still persists even -
after restarting the printer, please
contact your dealer after noting
the error code and message
displayed.

Internal error related

7021 Machine Error
[ ! ] to white ink agitation

In the event that other error codes than those that are mentioned above are displayed or that any of the
above-mentioned errors cannot be remedied even by following the troubleshooting procedures, please contact your

dealer for help.
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11-1. Apparatus

Printing method

Direct cloth printing by color ink jet printing

Head Quantity 2-piece set
Resolution Maximum 1200dpix1200dpi
Ink Type Water-based ink
Number of colors | 5 colors of CMYKW
Material supply method Platen transportation method
Supported Size 14 in. (355.6 mm) x 16 in. (406.4 mm) (standard platen)
media Thickness Upto 1.1 in. (30 mm)
(size/thickness)
Printable area Maximum 16 in. (406.4 mm) x 21 in. (533.4 mm)
Interface USB 2.0, LAN (10BASE-T, 100BASE-TX, 1000BASE-T), USB memory
External dimensions 55.1 in. (width) x 51.1 in. (depth) x 21.6 in. (height) (1400 mm (width) x 1300
mm (depth) x 550 mm (height))
Weight 128 kg (282 Ib) (including platen)
Power Single phase, 100 V-240 V, 50/60 Hz
Power When active: 80 W max.
Consumptions
Recomm | Temperature: 18 to
ended 30°C (64.4 to 86°F) | Printing-guarantegd range
Print | Humidity: 35to 85% | Humidity (%) e your e
environ | (No condensation gg:
Installation Tempe | ment should occur.)
conditions rature Temperature: 10 to 704
Working and Working | 35°C (50 to 95°F) 60 =
environment humidit | environ Humidity: 20 to 85% 50
y ment (No condensation 4o
Enviro should occur.) 312
nment Temperature: 0 to 30+
Storage | 40°C (32 to 104°F) 20 -
. L " Temperature
environ Humidity: 20 to 85% I T T—TT I — c)
ment (No condensation 10 15 1820 25 2930 35 40
should occur.) (50 59 68 77 86 95 104 (F) xo304

Print direction

Bidirectional, unidirectional

Fixation conditions

Conveyor oven (recommended): 160°C (320°F) for 3.5 minutes, or heat press:
180°C (356°F) for 35 seconds
* The time taken for fixation differs depending on the fixation device.

Pretreatment

Pretreatment is required when you print using white ink.
Apply pretreatment with a roller or pretreatment device and dry it up with a heat
press.
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11-2. Software

macOS 10.14 Mojave. macOS 10.15 Catalina.

oS Windows 8.1 (64bit) . Windows 10 (64bit)
Min. operating environment CPU Wi_t h2 GHz or above

RAM with 4 GB or above
Display resolution XGA (1024 x 768) or higher

Output

Printer driver, GTX Graphics Lab

Recommended application software
for high-level image editing

Adobe® Photoshop CC2020/CC2019. Adobe ® lllustrator CC2020/CC2019.
CorelDRAW © 2018/2019 (for Windows)
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11-3. Ink, maintenance solution, cleaning solution, pretreatment
11-31. Ink
Name Black / Magenta / Cyan / Yellow ink pouch
Use expiration date Expiration date on the pouch pack (supposing storage at normal temperature)
Storage temperature 0 to 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.
Cautions for storage - Keep them out of the reach of children.

- Store them away from fire, heat and oxidized substance.
Content 350 ml, 500 ml, 700 ml
External 1-piece set 20.3 in. (width) x 5.2 in. (depth) x 1.8 in. (height) (518 mm (width) x 133 mm
dimensions in (depth) x 48 mm (height)) (common to 350 ml, 500 ml and 700 ml)
transport 12-piece set 21.1 in. (width) x 11.4 in. (depth) x 14.8 in. (height) (538 mm (width) x 290 mm
condition (depth) x 378 mm (height)) (common to 350 ml, 500 ml and 700 ml)
Name White ink pouch
Use expiration date Expiration date on the pouch pack (supposing storage at normal temperature)
Storage temperature 0 to 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.
Cautions for storage - Keep them out of the reach of children.

- Store them away from fire, heat and oxidized substance.
Content 500 ml, 700 ml
External 2-piece set 20.3 in. (width) x 5.2 in. (depth) x 3.4 in. (height) (518 mm (width) x 133 mm
dimensions in (depth) x 87 mm (height))
transport 12-piece set 21.1in. (width) x 11.4 in. (depth) x 11.6 in. (height) (538 mm (width) x 290 mm
condition (depth) x295 mm (height))

11-3-2. Maintenance solution

Name Maintenance solution pouch
Use expiration date Expiration date on the pouch pack (supposing storage at normal temperature)
Storage temperature 0 to 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.
Cautions for storage - Keep them out of the reach of children.

- Store them away from fire, heat and oxidized substance.
Content 700 mi
External 1-piece set 20.3 in. (width) x 5.2 in. (depth) x 1.8 in. (height) (518 mm (width) x 133 mm
dimensions in (depth) x 48 mm (height))
transport 12-piece set 21.1 in. (width) x 11.4 in. (depth) x 14.8 in. (height) (538 mm (width) x 290 mm
condition (depth) x 378 mm (height))
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11-3-3. Cleaning solution

Name Cleaning solution
Use expiration date Expiration date on the container (supposing storage at normal temperature)
Storage temperature 0 to 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.
- Keep them out of the reach of children.

Cautions for storage - Store them away from fire, heat and oxidized substance.

- Cap the container tightly, and keep it in a cool, dark place with good ventilation.
Content 18L,5L
External 1.8L 19.2 in. (width) x 13.7 in. (depth) x 14.2 in. (height) (486 mm (width) x 346 mm

dimensions in (6-piece set) (depth) x 360 mm (height))

transport 16.0 in. (width) x 16.0 in. (depth) x 16.1 in. (height) (406 mm (width) x 406 mm

condition 5 L(4-piece set) (depth) x 407 mm (height))

11-3-4. Pretreatment

Name Pretreatment
Use expiration date Expiration date on the outer case (supposing storage at normal temperature)
Storage temperature 0 to 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.
- Keep them out of the reach of children.

Cautions for storage - Store them away from fire, heat and oxidized substance.

- Cap the container tightly, and keep it in a cool, dark place with good ventilation.
Content 20 kg (44 Ib), 5 kg (11 Ib)
External 1-piece set 10.5 in. (width) x 10.5 in. (depth) x 15.8 in. (height) (265 mm (width) x 265 mm
dimensions in (depth) x 400 mm (height)), (20 kg (44 Ib))
transport 4-piece set 17.9in. (width) x 12.6 in. (depth) x 12.5 in. (height) (456 mm (width) x 320 mm
condition (depth) x 318 mm (height)), (5 kg (11 Ib))
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11-4. About consumable supplies, optional items and replacement parts

About consumable supplies, optional items and replacement parts

e  Consumable supplies: Components required for the printing operation

o  Optional items: Available items through purchase order according to customers' usage status

o  Replacement parts: Components for which periodic maintenance needs to be performed for you to optimize the

printer's operation
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Consumable supplies Code No Optional items Code No.
Black ink pouch 350ml | GCX-4K35-1 Over size platen X SB6992
500 ml | GCX-4K50-1 (16"x21" / 406 x 533mm)
700 ml | GCX-4K70-1 Platen sheet 16X21 SB7242
Magenta ink pouch 350 ml | GCX-4M35-1 Large platen X SB6994
500 ml | GCX-4M50-1 (16"x18" / 406 x 457mm)
700 ml | GCX-4M70-1 Platen sheet 16X18 SB6995
Cyan ink pouch 350ml | GCX-4C35-1 Adult platen X SB6996
500 ml | GCX-4C50-1 (14"x16" / 356 x 406mm)
700 ml | GCX-4C70-1 Platen sheet 14X16 SB6667
Yellow ink pouch 350ml | GCX-4Y35-1 Youth platen X SB699S
500 ml | GCX-4Y50-1 (10"x12" / 254 x 305mm)
700 ml | GCX-4Y70-1 Platen sheet 10X12 SB6999
White ink pouch 500 ml | GCX-4W50 Baby platen X SB7001
700ml | GCX-4W70 (7"x8" /178 x 203mm)
Cleaning solution 1.8L | GCX-4E02 Platen sheet 7X8 SB7002
5L| GCX-4E05 Pretreatment roller SB1290
Pretreatment 5kg(111lb) | GCX-4P05 Bottle ASSY (waste ink tank) SB2582
20kg (44 1b) | GCX-4P20 Capping pouch SB5696
Maintenance solution pouch 700 ml | GCX-4S70 Replacement parts Code No.
Full maintenance kit Print head (for color printing) SC0764
<Printer-supplied items> Print head (for white) SB8571
Clean stick R 16 pcs. SC0934 D.river SC1681
Cleanstick T 16 pcs. Filter SB7093
Flushing foam 2 pcs. Wiper SB7870
Fan filter 4 pcs. Grease SB3229
Wiper cleaner 2-piece set SB6673 Cartridge (for white ink) SB5495
Flushing foam 2-piece set SC0935 Cartridge C (for colored ink) SB6875
Fan filter 2-piece set SB7007 Cleaning cup SB6925
Clean stick R 50-piece set SB7008 Tweezers 117466100
Clean stick T 50-piece set SC0032
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*Please note that the contents of this manual may differ slightly from the actual product purchased as a result of product
improvements.

1-5, Kitajizoyama, Noda-cho, Kariya 448-0803, Japan.

© 2020, 2021 Brother Industries, Ltd. All Rights Reserved. GTX423

. L . 11021525F E
This is the original instructions. 2021.02.F(1)



	GARMENT PRINTER Instruction Manual
	SAFETY INSTRUCTIONS
	1. Safety indications and their meanings
	2. Notes on safety
	3. Warning labels

	Table of contents
	1 Before Using Your Printer for the First Time
	1-1.  Be sure to read the following notes before using the printer
	1-2.  Components included with printer
	1-3.  Other items you must make available for use

	2 Name and function of each component
	2-1.  Front part
	2-2.  Right side view
	2-3.  Left side view/Rear side view
	2-4.  Inner-side view of front cover
	2-5.  Bottom view of platen
	2-6.  Operation panel
	2-6-1.  Liquid crystal panel


	3 Menu list
	4 Installation and preparation
	4-1.  Installation of printer
	4-1-1.  Installation of waste ink tank

	4-2.  Power supply of printer
	4-2-1.  Turning on the power
	4-2-2.  Turning off the power
	4-2-3.  When there is no prospect of electric power recovery for a while due to power outage

	4-3.  Connection between Printer and PC (for Windows)
	4-3-1.  Installing printer driver onto your PC
	4-3-2.  Connect with USB2.0 cable: Adding the printer to the PC
	4-3-3.  When connecting via LAN: Static IP address setting
	4-3-4.  When connecting via LAN: Adding a printer to PC

	4-4.  Connection between Printer and PC (for Macintosh)
	4-4-1.  Installing printer driver onto your PC
	4-4-2.  Connecting the printer to your PC via a USB 2.0 cable
	4-4-3.  Connecting the printer to your PC via a LAN cable

	4-5.  Moving the printer

	5 Creating print data
	5-1.  Types of applications
	5-2.  Sending print data using Brother GTX pro FileOutput (for Macintosh only)
	5-3.  Using other applications
	5-3-1.  When using CorelDRAW
	5-3-2.  When using Adobe Photoshop
	5-3-3.  When using Adobe Illustrator

	5-4.  Set up the printer driver
	5-4-1.  Select the platen size
	5-4-2.  Select the ink type
	5-4-3.  Select the mode
	5-4-4.  Set up the white ink
	5-4-5.  Specify whether or not to use the background black color
	5-4-6.  Specify whether or not to perform Multiple Pass Printing
	5-4-7.  Set up the color ink
	5-4-8.  Set up the white ink
	5-4-9.  Set up the image quality
	5-4-10.  Set up the color balance
	5-4-11.  Specify the print direction

	5-5.  Using Useful Tools
	5-5-1.  Use the color palette
	5-5-2.  Replace RGB=255 with RGB=254 (for Photoshop only)
	5-5-3.  Check the color sample
	5-5-4.  Print a grid pattern on the platen sheet
	5-5-5.  Adjust the ink volume
	5-5-6.  Print out of highlight check pattern/mask check pattern
	5-5-7.  Check the ejection timing
	5-5-8.  Check the platen feed setting
	5-5-9.  Check the print position


	6 Basic printing procedures
	6-1.  Basic printing process flow
	6-2.  Tasks to be performed before starting print operation
	6-2-1.  Confirmation and disposal of waste ink
	6-2-2.  Confirmation and refilling of cleaning solution
	6-2-3.  Daily agitation of the white ink

	6-3.  Pretreating process for print medium
	6-3-1.  Provisions for pretreatment
	6-3-2.  Dilution of pretreatment
	6-3-3.  Application of pretreatment
	6-3-4.  Fixation of pretreatment

	6-4.  Platen adjustment
	6-4-1.  Replacing the currently used platen with another one
	6-4-2.  Platen height adjustment
	6-4-3.  Using the 16X21 platen

	6-5.  Placing print medium in position
	6-6.  Sending/Loading Print Data
	6-6-1.  Sending print data from ARXP file preview
	6-6-2.  Sending print data from applications
	6-6-3.  Loading print data (ARXP file) from USB flash memory

	6-7.  Executing a printing job
	6-7-1.  Executing a print job once for a single print medium
	6-7-2.  Executing a print job several times for multiple print media
	6-7-3.  Performing the printing from receiving history

	6-8. Scheduling a print
	6-8-1. When you can schedule printing
	6-8-2. When a scheduled print begins
	6-8-3. When printing does not begin
	6-8-4. Cancelling scheduled printing

	6-9.  Removing printed matter from platen
	6-10.  Fixation of ink

	7 Precautions to keep good printing quality/use printer over the long term
	7-1.  Tasks to be performed regularly
	7-1-1.  Replacement of ink pouch with a new one
	7-1-2.  Cleaning and replacement of maintenance parts
	7-1-3.  Cleaning the nozzle guard, wiper, exhaust cap, and suction cap
	7-1-4.  Replacing the wiper cleaner
	7-1-5.  Replacing the flushing foam
	7-1-6.  Cleaning the internal area of printer
	7-1-7.  Replacing the fan filter

	7-2.  Tasks to be performed when needed
	7-2-1.  Print out of the nozzle check pattern (checking on the print heads)
	7-2-2.  Head cleaning
	7-2-3.  White ink circulation
	7-2-4.  Cleaning the CR (carriage) plate
	7-2-5.  Replacing the platen sheet

	7-3.  White Ink Pause Mode
	7-3-1.  Disabling white ink
	7-3-2.  Reusing White Ink

	7-4.  Adjustment/setup
	7-4-1.  CR (Carriage) speed adjustment
	7-4-2.  Initial settings after head replacement
	7-4-3.  Firing adjustment
	7-4-4.  Platen-rolling adjustment
	7-4-5.  White/color alignment
	7-4-6.  Setting of the time displayed on the nozzle check pattern
	7-4-7.  Set the scheduled time for white ink circulation

	7-5.  When Not Using for a Long Period of Time
	7-5-1.  When Not Using for a Long Period of Time: within 2 weeks
	7-5-2.  When Not Using for a Long Period of Time: more than 2 weeks
	7-5-3.  When Not Using for a Long Period of Time: within 2 weeks with white ink pause mode
	7-5-4.  When Not Using for a Long Period of Time: more than 2 weeks with white ink pause mode


	8 What to do when needed
	8-1.  Setting the print direction
	8-2.  Screen back light adjustment
	8-3.  Setup of Auto Screen Erase Time
	8-4.  Setting the menu timeout period
	8-5.  Speaker volume adjustment
	8-6.  Setup of temperature indication
	8-7.  Preview display settings
	8-8.  File name display setting
	8-9. Platen Obstacle sensor
	8-10. Platen too low sensor
	8-11.  Print Operation Settings Under Low Temperature
	8-12.  Auto Cleaning Setting
	8-13.  Flushing Interval Setting
	8-14.  Flushing Volume Setting
	8-15.  Wiping frequency settings
	8-16.  Automatic deletion of print data
	8-17.  Static IP address setting
	8-18.  Network filtering settings
	8-19.  Shortcut button setting
	8-20.  Cartridge Attach/Remove Check
	8-21.  Display of total printed sheets
	8-22.  Cartridge Attach/Remove Check History
	8-23.  Check circulation schedule
	8-24.  Display of Temperature/Humidity Info
	8-25.  Confirm network setting
	8-26.  Language setting
	8-27.  Display of version
	8-27-1.  Updating of firmware


	9 Troubleshooting
	9-1.  Troubleshooting instructions
	9-2.  Solutions to print quality problems
	9-2-1.  Recovery action to be taken for such a nozzle that is unable to eject ink-jet droplets
	9-2-2.  White head cleaning
	9-2-3.  Cleaning of head nozzle
	9-2-4.  Cleaning the surrounding area of nozzle surface
	9-2-5.  Replacing the color filter
	9-2-6.  Replacement of print head
	9-2-7.  Replacing the Wiper
	9-2-8.  Re-install the ink

	9-3.  Acquisition of log file

	10 Error message
	11 Specifications
	11-1.  Apparatus
	11-2.  Software
	11-3.  Ink, maintenance solution, cleaning solution, pretreatment
	11-3-1.  Ink
	11-3-2.  Maintenance solution
	11-3-3.  Cleaning solution
	11-3-4.  Pretreatment

	11-4.  About consumable supplies, optional items and replacement parts





